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CHAPTER 1 Introduction

Welcome
Welcome to PaperVision Enterprise. This powerful product provides:
A way to effectively and securely manage, retrieve, and store information.
Robust searching features for document retrieval.
The ability to print and save documents, and send them via email.
Document security features.
Version control for documents.
Multiple options for document viewing.
Flexibility in architecture and integration options.
Many other options not listed here.
See "Key Product Features" below for more information about product features and their benefits. You
can also see "Get Product Support" on page 16 for resources where you can learn more about our
products.
Before you begin working in PaperVision Enterprise, reviewing the content under "Terms You Should
Know" on page 14 will help you use the product and its documentation more effectively. When you are
ready to begin, go to "Log In" on page 18 for step-by-step instructions.

Key Product Features
As the amount of recorded information increases, businesses struggle to manage content. Digitech
Systems enables businesses of any size to more effectively and securely manage, retrieve, and store
information of any kind, including electronic files, paper documents, images, print streams, and email.
Through our Enterprise Content Management (ECM) systems, PaperVision Enterprise and ImageSilo®,
Digitech Systems enables businesses to reduce document-management costs, enhance information
security and compliance with regulations, and improve process efficiency. With software and services
that deliver any document, anywhere, anytime, organizations create a sustainable competitive
advantage.
We take pride in offering software that is easy to use, feature rich, and exceptionally flexible in
architecture and integration options. All Digitech Systems' products easily scale to meet the needs of
very large organizations and single desktop installations. Integration with Microsoft® Office products is
included, and additional integrations are available for virtually any Windows® application.
You can store information on premises and access it internally with PaperVision Enterprise, or you can
outsource your ECM system and access information anywhere, anytime over the Internet with
ImageSilo, the on-demand system from Digitech Systems. Alternatively, ImageSilo and PaperVision
Enterprise can work together seamlessly as a hybrid system to meet a variety of business needs.
ImageSilo offers 24/7 online data access without requiring additional investments in hardware,
software, or IT personnel. This massive on-demand service securely delivers data to any Internetaccessible computer, anywhere in the world, at any time. ImageSilo is powered by PaperVision
Enterprise, so it inherits all the same security, collaboration, efficiency, and reporting tools. As an
outsourced ECM system, ImageSilo automatically scales to meet growing data-storage needs, and
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provides extensive physical and electronic safeguards to protect the system from interruption. Digitech
Systems' engineers maintain, monitor, and manage all the software, servers, and storage. Multiple
redundant systems mitigate the potential for hardware failures affecting information availability.
PaperVision Enterprise lets your organization securely protect and access information of any kind, and
supports the storage of more than 250 file types in their native formats.(See "Supported File Types in
the PaperVision Viewer" on page 112 for a list of supported file formats.) Extensive security
configurations, optional encryption, audit tracking, powerful version controls, and reporting keep
administrators informed of system activity and assure that information is safely protected. Intelligent
search options let you locate documents by index value, and keyword or phrase in full-text documents.
Architectural flexibility allows the system to scale to meet the demands of any size business. You can
design a system that fits your environment and needs.
See "Get Product Support" on page 16 for resources where you can learn more about our products.

System Requirements
The following table shows the minimum system requirements for PaperVision Enterprise.

Component

Requirement
Internet Explorer® 11
(PaperVision Viewer and Browser-Based Viewer)

Internet Browser

Mozilla Firefox® latest version
(PaperVisionViewer and Browser-Based Viewer)
Google Chrome™ latest version
(PaperVision Viewer and Browser-Based Viewer)
Safari® on iPad devices and Macs latest version
(Browser-Based Viewer)

Screen Resolution

SVGA Monitor (1024 x 768 or higher recommended)

PaperVision Enterprise User Guide 13
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Terms You Should Know
This content contains definitions for terms that are used throughout the documentation and online help.
Knowing this terminology will help you use the product and its documentation more effectively.
See "Entity" below for a definition of this term.
See "Entity ID" below for a definition of this term.
See "Project" below for a definition of this term.
See "Data Group" on the facing page for a definition of this term.
See "Index Values" on the facing page for a definition of this term.
See "Detail Sets" on the facing page for a definition of this term.
See "Documents" on the facing page for a definition of this term.

Entity
An entity is a body such as a company, corporation, or organization. Each entity is autonomous and
administers its own projects, users, groups, workflows, security policies, and so on. An entity never
shares elements with other entities, and you cannot switch between entities after you log in. A system
administrator can limit access to specific projects, functionality, and documents within an entity.
Depending on your configuration, you might be required to log in to your entity from the same computer
or network each time.
In general, most users (including those at large enterprise installations) use only a single entity. Only a
few special circumstances require more than one entity. For example, in a hosting environment where
an application service provider (ASP) is hosting data for multiple companies and each company wants
to administrate itself and its users. Digitech Systems’ ImageSilo is a good example of an ASP that
hosts multiple entities. You might also see more than one entity in a large enterprise consisting of
different departments that require the ability to administrate themselves separately from other
departments without involving a central IT organization.

Entity ID
An entity ID is a unique number that identifies each entity. Each entity is autonomous. You cannot
change your entity ID after you log in and you cannot work across entities.

Project
A project is a logical grouping of documents based on a common indexing schema. For example, ABC
Company has three projects: Human Resources, Accounts Receivable, and Sales.
The Human Resources project contains employee records and health insurance information.
The Accounts Receivable project contains billing, purchase order, and invoice information.
The Sales project contains prospect and client information.
Each of these projects is a separate logical grouping within the ABC Company entity. Projects support
up to 200 named index fields. Project names must be unique within an entity, but an administrator can
create an unlimited number of projects.
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Data Group
A data group is a set of documents and their index values. A data group can contain one document or
thousands of documents, and those documents can be grouped into one or many projects. A data group
holds information for only a single entity, but it can contain an unlimited number of projects. Typically, a
data group contains only documents for one project, as this makes organization easier.

Index Values
Document index fields contain values that let you identify key elements of documents within a project
during the capture process. You then use these index field values to search for and retrieve documents
in PaperVision Enterprise. When you enter an index value to perform a search for a document, the
application compares the value you entered against your database tables and retrieves documents that
meet your specific criteria.
N O T E

When index field values are saved in PaperVision Enterprise, the following characters
are automatically removed from them: % ^ & * | <

Detail Sets
Detail sets (also referred to as “duplicate documents”) define a collection of index values that allow
multiple sets of field data to reference a single document. If documents with detail sets appear in a
search results screen in PaperVision Enterprise, they display with a down arrow that allows you to
expand all documents contained in the detail set. Detail sets can be created in PaperFlow™,
PaperVision Capture, PaperVision Message Manager, and PaperVision Enterprise Report
Management.
The example below shows a search results screen with expanded detail sets to show the documents'
related Company Name, and Check Date. The Invoice Number and Document ID detail sets vary
across documents.

Documents
Documents contain the individual pages or images for a given set of index values. If document grouping
is enabled, documents are grouped per page results. By default, 100 documents appear per page of
search results in PaperVision Enterprise.

PaperVision Enterprise User Guide 15
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Get Product Support
Digitech Systems takes great pride in providing software that is simple to use, feature-rich, and flexible
in architecture and integration capabilities. If you experience any difficulty, please contact us toll free at
(877) 374-3569 or direct at (402) 484-7777 to experience our legendary customer service. Additionally,
you may contact us at support@digitechsystems.com. Our technical support staff is available to serve
you between the hours of 8:00 AM and 6:00 PM Central Time.
Digitech Systems’ product features and enhancements are driven by you, our customer. If you have an
idea for a future product feature or enhancement, please send an e-mail to dev@digitechsystems.com.
In addition to our legendary technical support staff, we also offer the following resources to help you
answer questions and resolve issues.
MyDSI - MyDSI is an interactive tool for all Digitech Systems customers. Log in to MyDSI at
http://mydsi.digitechsystems.com to download product updates, license purchased software,
view support contract renewals, and check the status of your software support cases and
requests.
User Forums - Log in to the User Forums at http://forums.digitechsystems.com to exchange
answers and ideas with other users in our moderated community.
Knowledge Base - Log in to search our extensive Knowledge Base at http://kb.digitechsystems.com for articles on all Digitech Systems products.
Documentation - For documentation describing the use and features of PaperVision Enterprise,
refer to the PaperVision Enterprise product guides. To access the online help and manuals from
the PaperVision Enterprise software, click the Help menu.
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Log In
When you log in to PaperVision Enterprise, the system authenticates your access based on the user
name and password you provide. If your site uses multiple entities, you will also need to provide the
correct entity ID.
Before you can log in to PaperVision Enterprise, you must get the following items from your
administrator:
The URL to access PaperVision
Your user name and password
Your entity ID (if required)

To log in
1. Start your web browser.
2. In the Address bar, type the URL provided by your administrator to access PaperVision Enterprise.
The format of the address is http://serverurl/PVE.aspx.
3. In the Welcome to PaperVision Enterprise dialog box, in the User Name box, type your user
name.
4. (Optional) On some devices, you have the option to use either a touch screen, or a mouse (or
track pad). Click the option that describes how you will interact with the device.
5. In the Entity ID box, type your entity ID.
6. In the User Name box, type your user name.
7. In the Password box, type your password.
8. From the Language list, select the appropriate language.
9. (Optional) If you do not remember your password, click Forgot your password to open the
Request Password Reset dialog box. In the User Name box, type your user name, and then
click Continue. If your user name is associated with a valid account, you will receive an email
message with instructions and a link to reset your password. The link expires in one hour. Click
Return to the Login Page to return to the Welcome to PaperVision Enterprise dialog box.
10. Click Login.
By clicking Login, you acknowledge that you accept the terms of the Digitech Systems acceptable use policy.

N O T E

If your session times out and you log in again, the application retains the most recent
page you accessed. The amount of time before your session times out depends on the
setting the administrator assigned.
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Optional Pre-Login Parameters
The following optional parameters are available for you to specify before you log in to the PaperVision
Enterprise web application.

To go to a specific project ID when you log in
1. Start your web browser.
2. In the Address bar, type the URL provided by your system administrator, followed by a question
mark ( ? ), and then ProjID= followed by the project ID.
For example: http://serverurl/PVE.aspx?ProjID=1
3. When the Welcome to PaperVision Enterprise dialog box appears, log in.

To log in to a specific entity when you log in
1. Start your web browser.
2. In the Address bar, type the URL provided by your system administrator, followed by a question
mark ( ? ), and then EntID= followed by the entity ID.
For example: http://serverurl/PVE.aspx?EntID=1
3. When the Welcome to PaperVision Enterprise dialog box appears, log in.

To automatically log in from the Address bar
1. Start your web browser.
2. In the Address bar, type the URL provided by your system administrator, followed by a question
mark ( ? ), and then hRemote=true, and then &txtEntityID= followed by the entity ID, and then
&txtUser= followed by your user name, and then &txtPassword= followed by your password.
The example below is based on the default login parameters using the System Admin account
where the user name and password are both Admin.
For example: http://serverurl/PVE.aspx?hRemote=true&txtEntityID=1&txtUser=admin
&txtPassword=ADMIN&ProjID=1

T I P

The automatic log in parameters can be used with a form, and then posted to
PaperVision Enterprise so you can create your own form that contains these values.

Log Out
We recommend that you log off from PaperVision Enterprise each time you are finished with your
session.

To log out
On the title bar, click the down arrow by your user name, and then click Logout. Click Yes on the
confirmation message.
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Main Window Overview
After you have logged in to PaperVision Enterprise you will see the main window. The main window is
comprised of the following:
Menu bar - On the menu bar you can perform global searches (see "Global Search Tasks" on
page 154 for more information). Click the down arrow next to your user name to access the following options.
User Options - Contains settings that define: parameters for search results, the method
used to view documents, display settings, and options for electronic signatures. (See "User
Options" on page 160 for information about specifying these settings.)
Destruction Lists - Contains destruction lists and options for working with them. ( See
"Destruction List Tasks" on page 168 for more information).
E-Forms - Select this option to maximize and display only the E-Forms pane in the main window.
Global Search - Contains global search filters and options for working with them. ( See
"Global Search Tasks" on page 154 for more information.)
Migration Jobs - Contains migration jobs and options for working with them. (See "Migration
Job Tasks" on page 172 for more information.)
Notifications - Contains system messages and options for working with them. (See "Notifications" on page 163 for more information.)
Projects - Select this option to maximize and display only the Projects pane in the main window.
Recycle Bin - Contains all recycled documents and options for working with them. (See
"Recycle Bin Tasks" on page 178 for more information.)
Worksteps - Select this option to maximize and display only the Worksteps pane in the main
window.
Administration - Launches the PaperVision Enterprise Administration Console. You must
have the proper permissions to open the console. You can return to the PaperVision Enterprise User Console by clicking Home on the breadcrumb trail.
Downloads - Select this option to open the Downloads window. (See "Downloads" on
page 164 for more information.)
Reset page Layout - Select this option to return the main window to its default layout.
Breadcrumbs - You can navigate back to any previous window by clicking the appropriate breadcrumb.
Panes - In the default view, the left side contains components to which you have access. The
components on the right side display any recently viewed documents, and your favorites.
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The following table describes all of the possible components. Some of the listed components may not
be available to you either because your site doesn’t use that feature, or your administrator has not given
you access to it.

Component
Projects

Description
This pane displays all projects to which you have access. See
"Available Projects" on page 24 for more information.

This pane displays the worksteps within workflow definitions, to which
Worksteps Waiting/Owned you are assigned See "Worksteps Waiting/Owned Overview" on
page 146 for more information.
E-Forms

This pane displays all the E-Forms your administrator has assigned
you permission to access. See "Add E-Form Content" on page 158 for
more information.

Destruction Lists

This pane displays all destruction lists to which you have access. See
"Destruction List Tasks" on page 168 for more information.

Recent Documents

This pane displays all pinned documents, and the last 20 documents
that you have viewed.

Favorites

This pane displays any projects, E-Forms, and Worksteps that you
have designated as a favorite.
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To configure a pane on the main window
After you have logged in to PaperVision Enterprise, select a pane and then do any of the following:
To expand or collapse the pane, click the component name, or click Minimize, or Maximize.
To filter the items in the pane, in the Filter box, type your criteria. Click the X to remove your filter.
To remove or add a component from view, click the down arrow, and then select the components
you want displayed.
To scroll through the items in the pane, click Go to the previous page, or Go to the next page.
To display all the items in a pane, click All.
To change the number of items displayed in the pane, click Display Less, or Display More.
To specify the panes that are displayed on the main window, click the down arrow next to the Filter box, and select the panes you want displayed.
You can rest the pointer on each item in a pane to display the following options. Not all of these options
are available for each item.
Search - Opens the Search dialog box for the project. See "Search for Documents" on
page 33 for more information.
Upload - Opens the Upload Documents dialog box for the project. See "Upload Documents" on
page 47 for more information.
Scan - Opens the Scan New Document window. See "Scan Documents" on page 73 for more
information.
Folders - Opens the Folders window for the project. See "Folder Tasks" on page 26 for more
information.
Favorite - Adds the item to the Favorites pane. Click Favorite again to remove the item from the
Favorites pane.
View - Opens the item in the appropriate viewer.
Pin - Pins a document to the Recent Documents pane. This document will always display
above the recently viewed documents.
Details - Opens a window that displays information on the document. Click Close to close the
window.
Remove - Removes the document from the Documents pane.

22 PaperVision Enterprise User Guide

CHAPTER 2 Get Started

Select a Document Viewer
There are two document viewers available: the PaperVision Viewer and the Browser-Based Viewer. In
general, the PaperVision Viewer requires more set up, but offers more functionality and administrative
options. The Browser-Based Viewer requires very little set up and still offers much of the functionality
available in the PaperVision Viewer. If you are restricted from installing software, use the BrowserBased Viewer as the PaperVision Viewer requires the installation of the PaperVision Assistant. The
following table provides a summary of the key features of each viewer so you can determine which
viewer best meets your needs. It’s easy to select the viewer you want to use and change it as needed.
See "To specify document viewing options" on page 161 for instructions.

Feature

PaperVision
Viewer

BrowserBased
Viewer

Requires installing the PaperVision Assistant. See "Install the
PaperVision Assistant" on page 182 for instructions.
Requires installation on each client
Supported on Windows operating systems
Supported on OSX and mobile operating systems (iOS and
Android)
Supports scanning
Supports the WorkFlow client
Supports batch operations (print, email, save, scan) from
document lists
Perform administrative tasks on WorkFlow, E-Form, and
integration definitions; and Message Capture and Report
Management File Sets
View annotations
Note: Due to a security risk in many browsers, if your
administrator selected the Force Annotations On option and
the document contains a graphical annotation, the document
will not appear in the Browser-Based viewer.
Add and edit annotations
Save and convert files to other formats
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Available Projects
Projects organize documents into logical groupings based on a common indexing scheme. Only an
administrator can create and delete projects, and assign permission to access them. Only the projects
to which you have been assigned access appear in your list of available projects.

To access projects
1. After you have logged in to PaperVision Enterprise, all of the projects to which you have access
appear in the Projects pane.
2. You can rest the pointer on any project and access the following options.
Click Search to search for a document. See "Search for Documents" on page 33 for more
information.
Click Upload to add a document to a project. See "Upload Documents" on page 47 for more
information.
Click Scan to scan a document. See "Scan Documents" on page 48 for more information.
Click Folders to open the folder view. See "Folder Tasks" on page 26 for more information.
Click Favorites to add the project to the favorites pane.
3. Click the project in which you want to work.
If no previous search exists, the Search pane opens
If a previous search exists, a document list appears on the right pane. See "Document Lists"
on page 42 for more information on working with document lists.
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Folder Tasks
On the Folders pane, you can create folders to organize documents for quick access. The folders
results pane on the right displays the contents of any folder you select. Documents exist simply as
shortcuts in the folders. As you place a document into a folder, a shortcut for that document is created to
reference it in that specific folder. You can place one document in multiple folders, which creates
multiple shortcuts (to that specific document) in each folder. On the folders results pane, you can
perform the same functions and view the standard information available for all document lists. (See
"Document Lists" on page 42 for references to the common tasks you can perform and an overview of
the displayed information.) The functionality available to you depends on whether your administrator has
assigned you permission to perform the task.
N O T E

All folder operations are specific to the project in which you are working. For example,
you cannot copy and paste a folder into another project. Folders are project specific.

To create a new folder
1. After you have logged in to PaperVision Enterprise, do one of the following:
Rest the pointer on the project in which you want to create a new folder, and then click
Folders.
Open a document list (see "Document Lists" on page 42 if you need help opening a document
list), and then, on the toolbar, click Show.
2. A list of existing folder appears on the left pane. You can only view one level of folders at a time.
If you want to create a folder at a different level, do one of the following:
If you want to create a folder in a higher level, on the toolbar, click Up.
If you want to create a subfolder of an existing folder, double-click the folder on the left pane.
3. On the toolbar, click Menu, and then click Create.
4. In the Create Folder dialog box, type the folder name, and then click Save.

To edit an existing folder
1. After you have logged in to PaperVision Enterprise, do one of the following:
Rest the pointer on the project in which you want to edit a folder, and then click Folders.
Open a document list (see "Document Lists" on page 42 if you need help opening a document
list), and then, on the toolbar, click Show.
2. A list of existing folders appears on the left pane. You can only view one level of folders at a time.
If you want to edit a folder at a different level, do one of the following:
If you want to edit a folder in a higher level, on the toolbar, click Up.
If you want to edit a subfolder of an existing folder, double-click the folder on the left pane.
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3. Click the folder you want to edit, and then on the toolbar, click Menu. You have the following
options.
To move the folder and its contents to another location, click Move to open the Choose
Folder dialog box. You have the following options.
To move the folder you selected, select the destination folder, and then click OK.
To copy the folder you selected, select the destination folder, and then click OK.
To create a new destination folder, click New Folder, type the name of the new folder,
and then click Save.
To remove the folder and its contents, click Delete.
To rename a folder, click Rename, type the new name of the folder, and then click Save.
To update the Folders pane and the document list with any recent changes, click Refresh.

To copy document shortcuts from a document list and then paste them into a
folder
N O T E

You can paste document shortcuts that are copied from a document list only into
folders that are in the same project.
1. After you have logged in to PaperVision Enterprise, do one of the following:
Rest the pointer on the project in which you want to create a new folder, and then click
Folders.
Open a document list (see "Document Lists" on page 42 if you need help opening a document
list), and then, on the toolbar, click Show.
2. Select the document(s) for which you want to create shortcuts. (Hold down the Ctrl key to select
multiple documents.)
3. On the toolbar, click Move to open the Choose Folder dialog box. Do one of the following:
Select the destination folder, and then click OK.

T I P

You can double-click a folder to view any sub-folders.
To create a new destination folder, click New Folder, type the name of the new folder, and
then click Save.

To delete documents and document shortcuts
1. After you have logged in to PaperVision Enterprise, do one of the following:
Rest the pointer on the project in which you want to delete document shortcuts, and then
click Folders.
Open a document list (see "Document Lists" on page 42 if you need help opening a document
list), and then, on the toolbar, click Show.
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2. On the Folder pane, select the folder containing the document shortcut you want to delete.
3. On the right pane, select the document shortcut you want to delete.
4. On the toolbar, click Recycle to open the Recycle Document dialog box. Do one of the following:
To delete the document shortcut from the folder, select Delete shortcut from folder.
To recycle the document, select Recycle Document. (See "Recycle Bin Tasks" on
page 178 for information on recycling documents.)
5. Click OK.
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Search Pane Overview
With the comprehensive search capabilities in PaperVision Enterprise, you can perform searches
ranging from detailed criteria for specific index values, to broad document searches in a single project.
(See "Global Search Tasks" on page 154 for information on performing searches across multiple
projects.) You enter the criteria for searches on the Search pane.

To open the Search pane
1. After you have logged in to PaperVision Enterprise, if necessary, expand the Projects pane, and
then do one of the following:
Rest the pointer on the project in which you want to search, and then click Search, to open
the Search pane.
Double-click the project.
If no previous search exists, the Search pane opens.
If a previous search exists, a document list appears on the right pane. Click Search Criteria to open the Search pane.
2. (Optional) You can click the down arrow next to the Search breadcrumb and choose the following
options:
Upload - See "Upload Documents" on page 47 for more information.
Scan - See "Scan Documents" on page 48 for more information.
Folders - See "Folder Tasks" on page 26 for more information.
3. (Optional)To hide the fields that are displayed in the Search pane, click Show/Hide, and then
select the fields you want to hide. You can click the field again to display it in the Search pane.
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The Search pane contains the following areas.
Index Fields - Specify these settings to perform an index-field search. (See "Index Field
Searches" on page 33 for more information.)

System Fields - Specify these settings to perform a system field search. ( See "System Field
Searches" on page 35 for more information.)

Options - Specify these settings to define the type of search, how the search results are sorted,
and whether to include recycled documents. (See "Project Search Options" on page 37 for more
information.)
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Full-Text - Specify these settings to perform either a Boolean, or a natural language full-text
search. (See "Full-Text Searches" on page 37 for more information.) Full-Text Options (Stemming, Phonic, Fuzzy Searching, and Synonym Searching) are available only when you
select Show Full Text Options in the Search settings under User Options. (See "User
Options" on page 160 for more information.)
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Search for Documents
You can search for index-fields, system fields, full-text, or any combination by setting the properties on
the Search pane. Searches are not case-sensitive, and include only documents to which you have
security access.
N O T E

The way search results appear depends on the sort order specified in the Options
area, and the Search settings under User Options where you can specify the
maximum number of results per query and how documents are grouped. (See "User
Options" on page 160 for more information.)

To search for documents
1. Open the Search pane. (See "Search Pane Overview" on page 30 if you need instructions.)
2. Specify the search properties:
To search index fields, specify the properties in the Index Fields area. (See "Index Field
Searches" below for more information.)
To search system fields, specify the properties in the System Fields area. (See "System
Field Searches" on page 35 for more information.)
To specify the search type, how search results are sorted, and whether to include recycled
documents, specify the properties in the Options area. (See "Project Search Options" on
page 37 for more information.)
To search full-text, specify the properties in the Full-Text area. (See "Full-Text Searches" on
page 37 for more information.)
3. (Optional) Click Clear Criteria to remove all your search criteria.
4. Click Search to initiate the document search.
The system will complete the document search, sort all of the search results based on your sort
criteria, and then present those results in a document list based on your user settings. (See
"Document Lists" on page 42 for more information about tasks you can perform from a document
list.)

Index Field Searches
On the Search pane, the Index Field area displays all the index fields in the project that your
administrator has granted you permission to view. Using the search options, you can configure each
index you want to search. Numeric, date, and currency index fields display two boxes where you can
type beginning and ending search values. This will return any document that has an index value within
the specified range. Typing a single value in a box, instead of a range, will return all documents with that
index value.

To set index field search criteria
1. Open the Search pane. (See "Search Pane Overview" on page 30 if you need instructions.)
2. In the Index Field area, configure each index field that you want to search. In addition to typing
the values for which you want to search, you can use the options in the table below to further
refine your search criteria.
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3. (Optional) If predefined values exist for the project, click the down arrow in the box, and select
the index value from the list on which you want to search.
4. (Optional) Click Clear Criteria to remove all your search criteria.
5. See "Search for Documents" on the previous page for instructions on completing a document
search.

To search for

Type

Example

Any number of
unknown characters in
an index value

*

T* returns any document where the selected
index value begins with T
*T* returns any document where the selected
index value contains a T
*T returns any document where the selected
index value ends with T

A single unknown
character in an index
value

_

S_N returns SON, but will not return SOON
_* returns any non-blank value

Multiple values within
a single index field by
using "and" and "or"

Values in an index field
that contain an
ampersand

& = and
^ = or

&&

[CURRENTDATETIME]+
or - the following:
Documents of a
specific age based on
the current date and
time.

number of years Y
number of months M
number of days D
number of hours H
number of minutes N
number of seconds S
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*A*&*Z* returns all documents where the
selected index value contains an A and a Z
A*^Z* returns all documents where the selected
index value begins with A or Z
Johnson && Johnson returns all documents
where the selected index value is Johnson &
Johnson. (Predefined index values containing
an ampersand will appear in the list with two
ampersands (&&)).
[CURRENTDATETIME] = Current Date/Time
[CURRENTDATETIME+1Y] = Current
Date/Time plus 1 year
[CURRENTDATETIME-12M] = Current
Date/Time minus 12 months
[CURRENTDATETIME+2D] = Current
Date/Time plus 2 days
[CURRENTDATETIME-96H] = Current
Date/Time minus 96 hours
[CURRENTDATETIME+900N] = Current
Date/Time plus 900 minutes
[CURRENTDATETIME+120S] = Current
Date/Time plus 120 seconds
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To search for

Type

Example

A range of dates

01/01/1995, and 12/31/1999 returns all
Beginning and ending dates documents where the selected index value is
in the format specified for
between January 1, 1995, and December 31,
the index value.
1999. Typing a single value instead of a range
will return all documents with that index value.

A range of numbers or
currency values.

Beginning and ending
values.

100, and 1000 returns all documents where the
selected index value is between 100, and 1000.
Typing a single value instead of a range, will
return all documents with that index value.

System Field Searches
On the Search pane, the System Field area displays all the system fields in the project that your
administrator has granted you permission to search and view. Using the search options, you can
configure each index you want to search.
N O T E

You cannot perform a search on the following system fields:
@Data Group Name
@Original Data Group Name
@Checked Out By Full Name
@Checked Out By User Name
@Recycled By
When you select a system field from those listed above, you cannot configure it in the
search pane, but it is displayed in the search results.
Numeric, date, and currency index fields display two boxes where you can type beginning and ending
search values. This will return any document that has an index value within the specified range. Typing
a single value in a box, instead of a range, will return all documents with that index value.

To set index field search criteria
1. Open the Search pane. (See "Search Pane Overview" on page 30 if you need instructions.)
2. In the System Fields area, configure each system field that you want to search.
3. (Optional) Click Clear Criteria to remove all your search criteria.
4. See "Search for Documents" on page 33 for instructions on completing a document search.

System Field

Definition

@Document Creation Date

Date and time of the latest version of the document

@Document ID

Unique system-assigned ID applied to each document

PaperVision Enterprise User Guide 35

CHAPTER 4 Documents

System Field

Definition

@Duplicate ID

System-assigned ID applied to duplicate documents

@Full-Text Index

Specifies the full-text database number (0 indicates that no fulltext data exists)

@Hash Type

Specifies how the system will parse the data in the
FILESET column to display pages.

@Object ID

Unique ID assigned to each version of a document

@Object Type

Specifies the type of file

@Pages

Number of pages in a document

@Secure List

List of document security level IDs

@Data Group ID

System-assigned ID applied to a data group

@Data Group Name

Name of the data group assigned when imported
(This field is not searchable.)

@Original Data Group Name

Name of the data group assigned in its source location
(This field is not searchable.)

@Source Document ID

Original document ID in the data group from which the
document was imported

@Checked Out By Full Name

Full name of the user who currently has the document checked
out
(This field is not searchable.)

@Checked Out By User ID

User ID of the user who currently has the document checked
out

@Checked Out By User Name

User name of the user who currently has the document checked
out
(This field is not searchable.)

@Checkout Time

Date and time the document was checked out

@Version Creator

User name of the operator who created the version of the
document

@Version Number

Version number of the document

@Version Time

Date and time the version of the document was created

@Recycled By

User name of the user that recycled the document
(This field is not searchable.)

@Recycled By User ID

User ID of the user that recycled the document

@Recycled Time

Date and time the document was sent to the recycle bin

@Lock Time

Date and Time the retention lock expires
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System Field

Definition

@Destruction List ID

ID of the destruction list on which the document appears

@Destruction Time

Destruction date and time applied to the document

Project Search Options
On the Search pane, in the Options area, you can specify:
The type of search to perform using your index field search criteria.
How the search results are sorted by selecting the index value upon which to sort.
Whether the document list is arranged in ascending or descending order.
Whether to include recycled documents in the search (if you have permission to view the
Recycle Bin for the project).

To set project search options
1. Open the Search pane. (See "Search Pane Overview" on page 30 if you need instructions.)
2. In the Options area, set the following options:
Search Type - From the Search Type list, select one of the following:
For your search to return any document that meets at least one of your index field search
criteria, select Or.
For your search to return any document that meets all of your index field search criteria,
select And.
Sort By - From the Sort By list, select the index field or system field by which to sort your
search results. Select [+] to arrange the results in ascending order, or [-] to arrange the results in descending order. For example, to sort the search results in ascending order by company name, select COMPANY NAME [+].
Include Recycled Documents - Select this option to include recycled documents in your
search.

Full-Text Searches
You can perform full-text searches on projects containing documents with full-text data. Anytime a fulltext-supported document is added to a project, PaperVision Enterprise populates the full-text database.
(See "Supported File Formats for Full-Text Extraction" on page 60 for a list of supported file types for full
text extraction.)
You can combine full-text searches with document index field searches and system field searches on
documents with full-text data, by specifying the properties in both the Index Field, System Field, and
the Full-Text Search Criteria areas. The full-text search is performed first, and then the document
index field and system field search is performed on those results. You can change the order of those
operations by selecting the Query After Indices option.
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Your search results are displayed in a document list. (See "Document Lists" on page 42 for more
information about tasks you can perform from a document list.) In addition to the standard information
available in a document list, full-text search results also include:
Hits - The total number of full-text matches in a document.
Score - The total number of hits in a document divided by the largest number of hits of any document in the project. This value is displayed as a percentage. The document with the most hits
has a score of 100%.
Title - The first 512 characters of the full-text data in the document.

E X A M P L E
If a search returns four documents with hits of 115, 77, 50, and 5, the documents
will have the following scores:
Document 1: 115 hits divided by 115 hits = 100%
Document 2: 77 hits divided by 115 hits = 67%
Documents 3: 50 hits divided by 115 hits = 43%
Document 4: 5 hits divided 115 hits = 4%
Click the arrow in the first column to display or hide full-text information in the document list. This arrow
only appears when full-text information is available.

Boolean Full-Text Searches
A Boolean search request consists of a group of words or phrases that are linked by search operators
that precisely indicate the relationship between the words or phrases. Boolean searches treat two or
more words that occur together as a phrase. The table following the procedure describes the valid
search operators and shows examples of how to use them.

To set Boolean full-text search properties
1. Open the Search pane. (See "Search Pane Overview" on page 30 if you need instructions.)
2. In the Full-Text area, in the Criteria box, type the search criteria. (See the table following this procedure for information on using Boolean search operators.)
3. Select Boolean Search.
4. (Optional) Select Query After Indices to perform a full-text search on the results of an index field
search. (See "Index Field Searches" on page 33 if you need help building an index field search.)
5. Select from the following options.
Stemming - Select this option to expand a search to include grammatical variations of the
words in your search criteria. For example, a stemming search for "fish" would also find "fishing." A search for "applied" would also find "applying," "applies," and "apply." Selecting this
option performs a stemming search for all of the words in your query. To apply a stemming
search to specific words, type a tilde (~) at the end of the desired words in your criteria (for
example, fish~).
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Phonic - Select this option to expand a search to include words that sounds like the words in
your search criteria and begin with the same letter. For example, a phonic search for "Smith"
will also find "Smithe" and "Smythe." Selecting this option performs a phonic search for all of
the words in your query. To apply a phonic search to specific words, type a number sign (#) in
front of the desired words in your search criteria (for example, #Smith).
Fuzzy Searching - Select this option to expand a search to include misspelled versions of
the words in your search criteria. For example, a fuzzy search for "apple" will find "appple."
Fuzzy searching will locate text that may contain typographical errors or text that was created from optical character recognition (OCR). The fuzziness values range from 1 to 10. A
search for "alphabet" with a fuzziness value of 1 would find "alphaqet." A fuzziness value of 3
would find "alphaqet," "alpkaqet," and "allkaget."
Selecting this option and typing a fuzziness value performs a fuzzy search for all of the words
in your search criteria. To apply a fuzzy search to specific words, type the percent sign (%) in
the search criteria as shown in the examples below:
ba%nana - specifies that the word must begin with "ba" and have at most one difference
between it and "banana"
b%%anana - specifies that the word must begin with "b" and have at most two differences between it and "banana"
Synonym Searching - Select this option to expand a search to include synonyms or related
concepts of the words in your search criteria. For example, a synonym search for the word
"fast" would also find "quick." Selecting this option performs a synonym search for all of the
words in your query. To apply a synonym search to specific words, type an ampersand (&) at
the end of the desired words in your criteria (for example, improve&). You do not need to
select Synonym Searching when you use the ampersand (&), but you must select at least
one of the following synonym libraries to perform synonym searching for either all of the
words in your query, or for specific words:
WordNet Synonyms - Select this option to use the WordNet thesaurus developed at Princeton University.
WordNet Related Words - Select this option to use the WordNet's extensive lexical and
semantic network of the English language to include links between words other than synonym relationships, including antonyms, hypernyms, hyponyms, meronyms, and
holonyms.
User Synonyms - Select this option to use the server's user-defined synonyms.
6. (Optional) Click Clear Criteria to remove all your search criteria.
7. See "Search for Documents" on page 33 for instructions on completing a document search.
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The following table describes the valid search operators and examples of how to use them.

Search
Operator

Description

Usage Example
apple AND pear

AND

OR

NOT

Specifies that both words must be present

Specifies that at least one of the words must
be present

Results in a search for documents
that contain both "apple" and "pear"
apple OR pear
Results in a search for documents
that contain either "apple" or "pear"

apple AND NOT pear
Specifies that the word is not present; can be
Results in a search for documents
used with the AND and OR operators
that contain "apple" and not "pear"
apple w/6 pear

w/n

Specifies that words must occur no more than Results in a search for documents
n words apart
that contain "apple" within six words
of "pear"
*apple AND pea*

*

A wildcard character that matches any
number of letters

Results in a search for documents
that contain any word that ends with
"apple" and any word the begins with
"pea"
apple AND pe?r

?

A wildcard character that matches any single Results in a search for documents
that contain "apple" and any word that
letter
begins with "pe" and ends with "r" and
contains one letter in between.
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Natural Language Full-Text Searches
Natural-language searches use "term weighting," which evaluates the frequency and density of a word's
occurrences in documents. The system searches for words in phrases individually (not as a full phrase)
and ranks the search results based on this term weighting.

E X A M P L E
Perform a search for the following text: "Get me Sam's memo on the 2015 takeover of CorpX."
The system locates all documents that contain words that match the following individual search
terms: "Sam," "memo," "2015", "takeover," and "CorpX." The system then weighs the terms. If
the term 2015 exists in 3,000 files and the term Sam exists in only two files, the files that also
contain the term Sam receive a higher relevancy ranking than those that do not contain Sam. In a
natural-language search, words such as "get," "me," "on," "the," "and," "of," and "or" are
considered "noise" and are ignored.

To set natural language full-text search properties
1. Open the Search pane. (See "Search Pane Overview" on page 30 if you need instructions.)
2. In the Full-Text area, type the search criteria in the Criteria box.
3. Select Natural Language.
4. (Optional) Select Query After Indices to perform a full-text search on the results of an index field
search. (See "Index Field Searches" on page 33 if you need help building an index field search.)
5. Select from the following options.
Stemming - Select this option to expand a search to include grammatical variations of the
words in your search criteria. For example, a stemming search for "fish" would also find "fishing." A search for "applied" would also find "applying," "applies," and "apply." You can perform a stemming search for all of the words in your query by selecting this option, or for
specific words by placing a tilde (~) at the end of the desired words in your criteria (for
example, fish~).
Phonic - Select this option to expand a search to include words that sounds like the words in
your search criteria and begin with the same letter. For example, a phonic search for "Smith"
will also find "Smithe" and "Smythe." You can perform a phonic search for all of the words in
your query by selecting this option, or for specific words by placing a number sign (#) in front
of the desired words in your search criteria (for example, #Smith).
Fuzzy Searching - Select this option to expand a search to include misspelled versions of
the words in your search criteria. For example, a fuzzy search for "apple" will find "appple."
Fuzzy searching will locate text that may contain typographical errors or text that was created from optical character recognition (OCR). The fuzziness values range from 1 to 10. A
search for "alphabet" with a fuzziness value of 1 would find "alphaqet." A fuzziness value of 3
would find "alphaqet," "alpkaqet," and "allkaget."
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You can perform a fuzzy search for all of the words in your search criteria by selecting this
option and typing a fuzziness value; or for specific words by placing the percent sign (%) in
the search criteria as shown in the examples below:
ba%nana - specifies that the word must begin with "ba" and have at most one difference
between it and "banana"
b%%anana - specifies that the word must begin with "b" and have at most two differences between it and "banana"
Synonym Searching - Select this option to expand a search to include synonyms or related
concepts of the words in your search criteria. For example, a synonym search for the word
"fast" would also find "quick." You can perform a synonym search for all of the words in your
query by selecting this option, or for specific words by placing an ampersand (&) at the end of
the desired words in your criteria (for example, improve&). You do not need to select Synonym Searching when you use the ampersand (&), but you must select one or more synonym libraries.
You must select at least one of the following options to perform synonym searching for either
all of the words in your query or certain words:
WordNet Synonyms - Select this option to use the WordNet thesaurus developed at Princeton University.
WordNet Related Words - Select this option to use the WordNet's extensive lexical and
semantic network of the English language to include links between words other than synonym relationships, including antonyms, hypernyms, hyponyms, meronyms, and
holonyms.
User Synonyms - Select this option to use the server's user-defined synonyms.
6. (Optional) Click Clear Criteria to remove all your search criteria.
7. See "Search for Documents" on page 33 for instructions on completing a document search.

Document Lists
Working in document lists lets you select multiple documents, and then perform the same task on all of
them. For example, if an index value, such as an address or zip code changes, you can select all
documents affected by the change, and then modify the index value only once for the correction to be
made for all of the documents.
Document lists appear:
When documents that have matching criteria are found during a project-level search. (See
"Search for Documents" on page 33 for more information.)
When documents that have matching criteria are found during a global search. (See "Global
Search Tasks" on page 154 for more information.)
In Destruction Lists. (See "Destruction List Tasks" on page 168 for more information.)
In the Recycle Bin. (See "Recycle Bin Tasks" on page 178 for more information.)
In folders on the Folders tab. (See "Folder Tasks" on page 26 for more information.)
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The sections listed below describe tasks that are common to all document lists. See the content for the
location where the document list appears (referenced in the previous list) for functionality that is specific
to that location. For example, if you are working with a document list that appears in a destruction list,
see the "Destruction List Tasks" on page 168 section for functionality that is not covered in the sections
referenced in the following list. The functionality available to you depends on whether your administrator
has assigned you permission to perform the task. The following sections describe the tasks that you
can perform from all document lists.
See "View Documents" on page 46 for instructions to perform this task.
See "Group, Sort, and Filter Document Lists" on page 45 for instructions to perform this task.
See "Document List Options" on page 45 for instructions to perform this task.
See "Upload Documents" on page 47 for instructions to perform this task.
See "Scan Documents" on page 48 for instructions to perform this task.
See "Folder Tasks" on page 26 for instructions to perform this task.
See "Save Documents" on page 50 for instructions to perform this task.
See "Email Documents" on page 51 for instructions to perform this task.
See "Print Documents" on page 53 for instructions to perform this task.
See "Add Documents to a List" on page 54 for instructions to perform this task.
See "Export Document List Items" on page 54 for instructions to perform this task.
See "Print Document List" on page 55 for instructions to perform this task.
See "Edit Document Index Values" on page 55 for instructions to perform this task.
See "Delete Documents" on page 56 for instructions to perform this task.
See "Apply or Remove Document Security" on page 56 for instructions to perform this task.
See "Apply or Remove Document Retention Locks" on page 57 for instructions to perform this
task.
See "Apply or Remove Document Destruction Dates" on page 58 for instructions to perform this
task.
See "Rebuild Full-Text Data" on page 59 for instructions to perform this task.
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Document List Overview
Document lists appear on the right pane, and display the following information.

The number of documents that appear per page in a document list is determined by the Max. Results Per Query setting under User Options. (See "To specify search options" on page 161 for
instructions to modify this setting.)
The order and grouping of documents is determined by the Document Grouping setting under
User Options. (See "To specify search options" on page 161 for instructions to modify this setting.) No document grouping is applied during full-text search results.
Index fields display as column headers in document lists. Click the header to sort the column in
ascending or descending order.
After a document is placed in the Recycle Bin, it displays with red text when it appears in any
document list.
Documents that contain detail sets (also referred to as “duplicate documents”) appear with a plus
sign.
The Status column displays various symbols to indicate when a document is checked out, has
security applied (for administrators only), and has a destruction or retention date applied. Rest
the pointer on the symbol for additional information.
The total number of search results are displayed on the lower-right portion of the pane.
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Group, Sort, and Filter Document Lists
If you have a large number of list items, it may be helpful to group, sort, or filter them. These operations
are performed independently by page, on your query results.

To group list items
1. On the document list, select the column heading you want to use to group documents, and then
drag it to the row above the grid.
The documents are now grouped by each entry in that column heading. For example, to group all
the documents by the Name index field, , drag the Name column heading to the Group by row
above the grid. The grid will then contain all the documents grouped by name.
2. (Optional) You can drag additional column headings to the row above the grid to divide the list into
groups and subgroups.
For example, if you grouped documents by Name, you could drag an index field (Date) to the row
above the grid. The result would include all the documents grouped by Name. Each of those
groups would have subgroups based on the Date index field.

To filter list items
1. On the document list, select the column heading you want to use to filter the search results, and
then click the filter button to open the filter dialog box.
2. Do any of the following:
To filter the list based on specific index values, select the values you want to include in the
filtered list.
To filter the list based on a condition, type the value you want to use in the box, click the
down arrow, and then select the appropriate operator.
For example, to filter all rows where the value in the selected column is greater than 15, type
15 in the box, and then select Is greater than from the list. Optionally, if you want the filter to
be case sensitive, click Match case.
To filter by more than one condition, type the value you want to use for the first condition in
the first box, click the down arrow, and then select the appropriate operator. In the second
box, type the value you want to use for the second condition, click the down arrow, and then
select the appropriate operator.

To sort list items
1. On the document list, click a column heading to sort the results in ascending order.
2. (Optional) Click the column heading again to reverse the sort order.

Document List Options
When viewing document lists, you can select to group or expand documents by detail sets, select all
documents in the list, remove all detail set grouping, perform in-line editing on index values, and refresh
the document list.

To expand documents
1. Open a document list. (See "Document Lists" on page 42 if you need help.) Documents that are
grouped by detail sets, are displayed with a right arrow in the left column.
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2. Do one of the following to expand documents.
To expand all documents grouped by detail sets, on the toolbar, click Expand.
To expand a single detail set, on the left column, click the right arrow of the detail set you
want to expand.
3. Do one of the following to collapse documents.
To collapse all documents and group them by detail set, on the toolbar, click Collapse.
To collapse a single detail set, on the left column, click the down arrow of the detail set you
want to collapse.

To select all documents
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the toolbar, click Select.
3. (Optional) to deselect all documents, on the toolbar click Deselect.

To remove or apply detail set grouping for documents
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. Do one of the following:
To remove detail set grouping, on the toolbar, click Single.
All documents are listed individually, and the left column showing detail sets is removed.
To apply detail set grouping, on the toolbar, click Detail.
The left column displays a right arrow next to documents grouped by detail set.

To perform in-line editing on documents
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. Select the document in the document list that you want to edit.
3. Press Enter, and update the index values that you want to change.
4. After you have made your changes, press Enter again, and then click OK.

To refresh the document list
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the toolbar, click Refresh.

View Documents
If your administrator has assigned you permission to do so, you can view documents that appear in a
document list. There are two document viewers available for your use. (See "Select a Document
Viewer" on page 23 for information about each viewer.) When you view a document from a document
list, it opens in the viewer you have selected in your system settings. (See "To specify document
viewing options" on page 161 for instructions to specify the document viewer.) See "PaperVision Viewer
Overview" on page 62 or "Browser-Based Viewer Overview" on page 118 for information about the
operations you can perform after opening the document viewer you selected.

To view a document list item
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
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2. On the document list, double-click the document you want to view.

N O T E

For full-text documents, if your administrator has specified that annotations are “forced
on” and the document contains an annotation, then the full-text is hidden behind the
annotation and you cannot view the obscured text on the Full-Text tab.

Upload Documents
If your administrator has assigned you permission to do so, you can add documents, from the:
Search pane for projects.
Document lists for project and global searches.
Folders tab.
Browser-Based Viewer. (See "Upload Documents" on page 120 for instructions to add documents from the Browser-Based Viewer, as the following procedure is not applicable from that
location.)
PaperVision Viewer. (See "Add Documents" on page 77 for instructions to add documents from
the PaperVision Viewer, as the following procedure is not applicable from that location.)
Documents are added to the project that is selected when you click the Upload command, and the
index fields that appear are those that have been defined for documents in the selected project.

To add a document to a project
1. On the toolbar, click Upload to open the Upload Documents pane.
2. In the Document Index Fields area, type or select the document index values.
If you previously had a document selected, the index values displayed are from that document.
You can use or overwrite these values.
3. (Optional) If you want to add the document into a folder, do the following:
1. Next to the Folder box, click Browse.
2. In the Choose Folder dialog box, select a folder and then do one of the following:
Click OK to add the document to the folder you selected.
(Optional) To create a new folder, select the appropriate parent folder, click New Folder,
and then type the name of the new folder.
4. In the Files area, click Select File.
5. In the Choose File to Upload dialog box, select the file, and then click Open.
6. (Optional) If you want to add multiple documents using the same index values, click Additional
Files, and then repeat the previous two steps to select another document.
7. When you are finished selecting files, click Save.
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Scan Documents
If your administrator has assigned you permission to do so, you can scan and upload single-page or
multiple-page documents directly from a TWAIN-enabled scanning device into PaperVision Enterprise
from the:
Search pane for projects.
Document lists for project and global searches.
Folders tab.
PaperVision Viewer.
WorkFlow Viewer.
Using a direct connection to the scanner, any PaperVision Enterprise machine can serve as a scan
station. The scan feature lets you add, move, or delete pages within a document and maintain version
control of those documents. When new documents are scanned, they are temporarily stored on the local
computer where they were scanned. After documents are indexed, they are automatically uploaded.
Documents are added to the project currently selected. If applicable, any document-level security
definitions are applied.
To scan documents from a document list, you must:
Select the PaperVision Viewer as your document viewer. (See "To specify document viewing
options" on page 161 if you need instructions.)

N O T E

If you have the Browser-Based Viewer selected as your document viewer, the Scan
option is not available.
Select a TWAIN-enabled scanning device. (See "Select Scanner and Set Scanner Properties"
on page 75 for instructions to select a scanner and set scanner properties.)
Specify how documents are handled during scanning. (See "Specify Scanning Settings" on
page 106 for instructions to specify scanning settings.)

I M P O R T A N T

To scan documents into PaperVision, the scanner must be connected directly to the
computer hosting the PaperVision Assistant. Do not use wireless or other network
connections.

To scan documents
1. Place the pages you want to scan in the scanner.
2. On the toolbar, click Scan to open the PaperVision Viewer.
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N O T E

Documents are added to the project that is selected when you click the Scan
command, and the index fields that appear are those that have been defined for
documents in the selected project.
3. On the Home tab, in the General group, click Scan New Document.
4. (Optional) If the Select Source dialog box appears, click the scanner you want to use, and then
click Select.
The pages are scanned and placed in the Pending Document(s) View. See "Manage Pending
Documents" on page 88 for instructions to add index values and upload documents.

T I P

If the pages did not scan correctly, in the General group, click Remove From
Pending, and then click Yes in the confirmation message to delete the document from
the Pending Document(s) View.
5. (Optional) If your system has been configured to do so, a message appears asking if you want to
add pages to the scanned document. To do so, add pages to the scanner, and then click Yes.
When you are finished scanning pages, click No to this message.
6. (Optional) If your system has been configured to do so, the Indexing Editor appears where you
can do one of the following:
To index the document later, click Cancel. When you are ready to add index values for the
document(s), see "Manage Pending Documents" on page 88 for instructions.
To index the document now, in the boxes for the index values, type or select a new index
value, or if your system is configured to so, index values from the previously selected document appear which you can use or overwrite.
7. (Optional) If you want to add the document into a folder, do the following:
1. Next to the Add to Folder box, click the ellipsis button.
2. In the Selected Folder dialog box, do one of the following:
Click the folder to which you want to add the document.
To create a new folder, select the appropriate parent folder, click Create Folder, type the
name for the new folder, and then click OK.
3. Click OK.
8. On the Indexing Editor, click OK.
If you indexed and saved the document, it is uploaded automatically.
If you still need to index the document, see "Manage Pending Documents" on page 88 for instructions.

PaperVision Enterprise User Guide 49

CHAPTER 4 Documents

Save Documents
If your administrator has assigned you permission to do so, you can save documents that appear in a
document list. If a document is an image-based or PDF format, you can convert it to a format you
specify when you save it. If the document is not an image-based or PDF format, it will be saved in its
original format. Only image-based documents can be converted. For example, if the image is a TIF, it
can be converted to a PDF when saved. Microsoft Word documents, however, will remain as Word
documents. (See "Document Types" on page 59 for information about imaged-based and non-image
based document formats.)
N O T E

To save documents from a document list, you must select the PaperVision Viewer as
your document viewer. (See "To specify document viewing options" on page 161 if you
need instructions.)

To save documents
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the document(s) you want to save. (Hold down the Ctrl key to select
multiple documents.)
3. On the toolbar, click Save.

N O T E

If the project has Enhanced Auditing enabled, when you click Save As, the
Enhanced Auditing dialog box appears. You must specify the values in this dialog
box before you can continue with this procedure. See "Enhanced Auditing" on page 60
for instructions to set the values in the Enhanced Auditing dialog box.
4. In the Output Directory box, type the path, or click the ellipsis button to open the Browse For
Folder dialog box to locate, and then select the location where you want the document(s) saved.
You can create a new folder by clicking Make New Folder, and then typing the name of the
folder.
5. After you have selected or created a folder for the document(s), click OK.
6. In the File Name list, do one of the following:
To use the system date and time for the file name, select Date/Time.
To specify a file name, select User Specified, and then type the name in the box.
To use an index value for the file name, select the index you want to use.

N O T E

Only image-based documents can be converted to a different format. For example, if
the image is a TIF, it can be converted to a PDF when saved. Microsoft Word
documents, however, will remain as Word documents.
7. In the Format list, select the format for the document(s).
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8. In the Page Range list, do one of the following:
To save the entire document, select All Pages.
To save specific pages, click Page Range, and then type the page numbers. You can specify individual pages and page ranges (for example, 1-5, 8, 11-13).
9. If you are saving a COLD document, in the Format list select one of the following options:
To save the document text, select Text.
To save the overlay images, select Overlay.
10. If the document has annotations, do one of the following:
To save the annotations, select Include Annotation.
To exclude the annotations, clear Include Annotation.

N O T E

If your administrator set user permissions so that annotations are “forced on,” you
cannot clear the Include Annotation check box, and the Overlay setting is forced on
for COLD documents.
11. Click OK to save the selected document(s).

Email Documents
If your administrator has assigned you permission to do so, you can send documents by email from
document lists using any MAPI-compliant email application. If the document is an image-based or PDF
format, you can convert it to a format you specify when you send it. If the document is not an imagebased or PDF format, it will be sent in its original format. Only image-based documents can be
converted. For example, if the image is a TIF, it can be converted to a PDF when sent. Microsoft Word
documents, however, will remain as Word documents. (See "Document Types" on page 59 for
information about imaged-based and non-image based document formats.)
To send documents by email, you must have an email address associated with your user account.
Contact your administrator if you need one added. When you send a document via email, the document
files and index values are included in the email message.
N O T E

To send documents by email from a document list, you must select the PaperVision
Viewer as your document viewer. (See "To specify document viewing options" on
page 161 if you need instructions.)

To send documents using a MAPI-compliant email application
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the document(s) you want to send. (Hold down the Ctrl key to select
multiple documents.)
3. On the toolbar, click Email.

PaperVision Enterprise User Guide 51

CHAPTER 4 Documents

N O T E

If the project has Enhanced Auditing enabled, when you click Email, the Enhanced
Auditing dialog box appears. You must specify the values in this dialog box before you
can continue with this procedure. See "Enhanced Auditing" on page 60 for instructions
to set the values in the Enhanced Auditing dialog box.
4. In the File Name list, do one of the following:
To use the system date and time for the file name, select Date/Time.
To specify a file name, select User Specified, and then type the name in the box that
appears.
To use an index value for the file name, select the index you want to use.
5. In the Format list, select the format for the document(s).

N O T E

Only image-based documents can be converted to a different format. For example, if
the image is a TIF, it can be converted to a PDF when saved. Microsoft Word
documents, however, will remain as Word documents.
6. In the Page Range list, do one of the following:
To send the entire document, select All Pages.
To send specific pages, click Page Range, and then type the page numbers. You can specify individual pages and page ranges (for example, 1-5, 8, 11-13).
7. If you are sending a COLD document, in the Format list select one of the following options:
To save the document text, select Text.
To save the overlay images, select Overlay.
8. If the document has annotations, do one of the following:
To send the annotations, select Include Annotation.
To exclude the annotations, clear Include Annotation.

N O T E

If your administrator set user permissions so that annotations are “forced on,” you
cannot clear the Include Annotation check box, and the Overlay setting is forced on
for COLD documents.
9. Click OK.
10. When the Batch Email dialog box appears, click Finish.
11. When your email application appears, type the email address for the recipient, the subject of the
email, the message text, and then send the email.
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Print Documents
If your administrator has assigned you permission to do so, you can print documents that appear in a
document list.
N O T E

To print documents from a document list, you must select the PaperVision Viewer as
your document viewer. (See "To specify document viewing options" on page 161 if you
need instructions.)

N O T E

The options under the Printer Properties link vary depending on the type of printer. If
you need information about printer properties, see your printer documentation. Only the
print options that are specific to PaperVision Enterprise are documented in the
following procedure.

To print documents
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the document(s) you want to print. (Hold down the Ctrl key to select
multiple documents, or, on the toolbar, click Select to select all documents.)
3. On the toolbar, click Print.

N O T E

If the project has Enhanced Auditing enabled, when you click Print, the Enhanced
Auditing dialog box appears. You must specify the values in this dialog box before you
can continue with this procedure. See "Enhanced Auditing" on page 60 for instructions
to set the values in the Enhanced Auditing dialog box.
4. In the Print dialog box, specify the print options.
5. If you are printing a COLD document, in the Overlay list select one of the following options:
To print the document as text, select Text.
To print the document text with the overlay image, select Overlay.
6. If the document has annotations, do one of the following:
To print the annotations, select Include Annotation.
To exclude the annotations, clear Include Annotation.

N O T E

If your administrator set user permissions so that annotations are “forced on,” you
cannot clear the Include Annotation check box, and the Overlay setting is forced on
for COLD documents.
7. After you specify the print options, click Print.
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Add Documents to a List
You can add documents to a user-defined list that can then be migrated for other uses. You can add
documents from various projects and data groups in your repository to a list, and then save them and
any existing or modified document index fields into a new data group. An administrator can then save
this new data group to any location, including external media.
For example, you might need to supply an attorney with documents that apply to a specific case. You
can add only the applicable documents to a list, and then submit them for migration. After they are
migrated, your administrator can then burn them onto a CD or DVD so that the attorney can access the
information. The original documents are not altered, nor are they removed from PaperVision.
Before documents can be migrated, they must be added to a list as described in the following procedure.
(See for information about the document migration process and the tasks you can perform for migration
jobs.)

To add documents to a list
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the document(s) you want to add to a list. (Hold down the Ctrl key to
select multiple documents, or, on the toolbar, click Select to select all documents.)
3. On the toolbar, click List, and then do one of the following:
To create a new list, click New List, type a name for the list, click Save, and then select the
list.
To use an existing list, click the list.
4. Click OK to confirm adding the document(s) to the list.
5. When you are ready to submit the list for migration, see for information about the document migration process and the tasks you can perform for migration jobs.

To delete a list
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the toolbar, click List, and then select the list that you want to delete.
3. Click Delete List, and then click OK.

Export Document List Items
From a document list, you can select documents, and then export the displayed information into a
Microsoft Excel file.
N O T E

Only the information displayed on the document list is exported. The content of
referenced documents is not exported.

To export document list items
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the documents for which you want to export the displayed information. (Hold down the Ctrl key to select multiple documents, or , on the toolbar, click Select to
include all documents)
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3. On the toolbar, click Results, and then click Save.
4. When prompted, do one of the following:
Click Open to view the XML file contents on a new tab in the browser.(See the documentation for your specific browser for instructions to print, save, etc.)
Click one of the Save options. If you select Save As, you can specify a location and file
name for the export file, and then click Save.

Print Document List
If your administrator has assigned you permission to do so, you can print the entire document list in a
print-friendly format.
N O T E

Only the information displayed on the document list is printed. The content of
referenced documents is not printed.

To print a document list
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the toolbar, click Results, and then click Print.
3. Click Print to print the document list. The document list appears in a print-friendly format on a
new tab, and the Print dialog box opens.
4. In the Print dialog box, specify the print options, and then click Print

Edit Document Index Values
If your administrator has assigned you permission to do so, you can alter index values for documents
that appear in a document list. The options available for altering index values depend on how your
administrator has configured the project. You can either type a new index value, select a value from a
list, or both. When you change the index values for a document, the server updates the values
immediately when you click Save.
N O T E

When index field values are saved in PaperVision Enterprise, the following characters
are automatically removed from them: % ^ & * | <

To alter document index values
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the document(s) for which you want to change the index values.
(Hold down the Ctrl key to select multiple documents, or, on the toolbar, click Select to select all
documents.)
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I M P O R T A N T

If you selected multiple documents, be aware that the changes you make are applied to
all of the selected documents. Use care to leave the values you are not changing as
they are. For example, to change the date for all of the selected documents but nothing
else, ensure that you modify only the date field and not any other index fields.
3. On the toolbar, click Edit to open theEdit dialog box.
4. In the box for the index field(s) you want to modify, type or select the new index value.
5. Click Update.

Delete Documents
If your administrator has assigned you permission to do so, you can delete documents that appear in a
document list. How document deletion is handled depends on how your administrator has configured the
Recycle Bin settings for the project. When you delete a document, it is either moved to the Recycle Bin
or it is deleted along with all of its associated versions and annotations. Furthermore, depending on how
the administrator configured the data group for the documents, physical files might also be deleted from
their source media. Contact your administrator to learn how document deletion is configured.

To delete documents
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the document(s) you want to delete. (Hold down the Ctrl key to
select multiple documents.)
3. On the toolbar, click Recycle.
4. Click Yes to confirm the deletion.

Apply or Remove Document Security
Your administrator can assign or deny permissions to specific projects and functionality within them. In
addition, your administrator can define document security levels that you can apply if you have
permission to do so. Security applied at the document-level provides for more precise settings. For
example, access to documents can be restricted to certain people based on date ranges or invoice
amount ranges.
If document security is applied to a document and you do not have access to it, that document will not
appear in your document lists. If you have access to a secured document (or are logged in as an
administrator), the Status column in the document list displays a padlock symbol for secured
documents.

To apply document security
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the documents for which you want to apply security. (Hold down the
Ctrl key to select multiple documents.)
3. On the toolbar, click Secure to open the Apply Document Security Levels dialog box.
4. In the Document Security area, select the check boxes that correspond to the security level(s)
you want to apply.
5. Click Save.
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To remove document security
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the documents for which you want to remove security. (Hold down
the Ctrl key to select multiple documents.)
3. On the toolbar, click Secure to open the Apply Document Security Levels dialog box.
4. In the Document Security area, clear the check boxes that correspond to the security level(s)
you want to remove.
5. Click Save.

Apply or Remove Document Retention Locks
Applying a retention lock to a document prevents it from being deleted before the specified lock date and
time. Depending on how your administrator has configured the Recycle Bin settings for your project, a
document with a retention lock can be moved to the Recycle Bin, but it cannot be emptied from the
Recycle Bin before the specified lock date and time. If your administrator has assigned you permission
to do so, you can apply and remove document retention lock dates. For the documents that have a
retention lock applied, the Status column in the document list displays a symbol of a document with a
padlock on it.
N O T E

If you do not have permission to remove retention locks, you cannot apply a new lock
date that is later than the current lock date.

To apply or edit a document retention lock
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the documents for which you want to apply or edit a document retention lock. (Hold down the Ctrl key to select multiple documents.)
3. On the toolbar, click Retention to open the Records Retention dialog box.
4. If necessary, expand Retention.
5. Click Lock Date/Time box, and then select date and time up to which the document must be
retained. Click Close.
6. (Optional) In the Comments box, you can type comments that can be viewed until the document
is destroyed.
7. Click Apply.
8. In the confirmation message, click yes to confirm the retention lock date and time.

To remove a document retention lock
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the documents for which you want to remove the document retention lock. (Hold down the Ctrl key to select multiple documents.)
3. On the toolbar, click Retention to open the Records Retention dialog box.
4. Select Remove, and then click Yes.
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Apply or Remove Document Destruction Dates
If your administrator has assigned you permission to do so, you can apply and remove document
destruction dates. For the documents that have a destruction date applied, the Status column in the
document list displays a note symbol. When you rest the pointer on the symbol, it displays the
scheduled destruction date, any related comments that were entered, and the user name for the person
who applied the destruction date. Depending on how your administrator has configured the Recycle Bin
settings for your project, a document with a destruction date that has been reached will either be deleted
or moved to the Recycle Bin during the destruction process. If a document is in a destruction list and
you apply a destruction date to it, it is automatically and immediately removed from all destruction lists.
(See "Destruction List Tasks" on page 168 for information about how destruction lists are used.)
N O T E

For document destruction to automatically happen, your administrator must have
configured a Records Retention Policy Set at the project level. If this has not occurred,
documents will not be deleted even if their specified destruction date has passed.

To apply or edit a document destruction date
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the document(s) for which you want to apply or edit a document
destruction date. (Hold down the Ctrl key to select multiple documents.)
3. On the toolbar, click Retention to open the Records Retention dialog box.
4. If necessary, expand Destruction.
5. In the Destruction Date/Time box, and then select date and time up to which the document
must be retained. Click Close.
6. (Optional) In the Comments box, you can type comments that can be viewed until the document
is destroyed.
7. Click Apply.
8. In the confirmation message, click Yes to confirm the destruction date and time.

To remove a document destruction date
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the document(s) for which you want to remove the document
destruction date. (Hold down the Ctrl key to select multiple documents.)
3. On the toolbar, click Retention to open the Records Retention dialog box.
4. Select Remove, and then click Yes.
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Rebuild Full-Text Data
You can submit individual documents to have their full-text indexes rebuilt. This feature is useful if the
full-text data for a document has become corrupt or has changed.

To rebuild full-text data
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, select the document(s) for which you want to rebuild full-text data. (Hold
down the Ctrl key to select multiple documents.)
3. On the toolbar, click Rebuild, and then click OK.

Document Types
PaperVision Enterprise makes a distinction between image-based, and non-image-based documents.
These document types are handled differently in the PaperVision Viewer during check out, editing, and
adding signatures and annotations. Image-based documents are those that support scanning and
include the following formats:
JPG
PNG
GIF
BMP
TIFF and PDF formats are treated as image-based documents when they are loaded into PaperVision from a PaperFlow or PVE XML data group generated by PaperFlow or PaperVision Capture using single-page images.
TIFFs are treated as image-based documents when they are added to PaperVision using the
scan feature.
After you check out an image-based document, you can insert, move, and delete pages in the
PaperVision Viewer. You can also graphically add signatures and annotations to image-based
documents.
PaperVision Enterprise categorizes all other documents as non-image-based documents. TIFF and
PDF formats are treated as non-image-based documents when:
They are loaded into PaperVision from a PaperFlow or PVE XML data group generated by PaperFlow or PaperVision Capture using multiple-page images or full-text.
They are added using the Add New Document feature.
Some documents that you might typically think of as image-based, such as CAD or Visio drawings, are
treated as non-image-based documents in PaperVision because their file formats do not support
scanning in the PaperVision Viewer. When you check out non-image-based documents, they are saved
to a location you specify, and then you can edit them in the native application for that file type.
Signatures are associated with the document, but do not appear graphically. Annotations are not
supported for non-image based documents.

PaperVision Enterprise User Guide 59

CHAPTER 4 Documents

Enhanced Auditing
If your administrator has enabled Enhanced Auditing for a project, when you select the Print, Open,
Email, Save As, Check Out, or Share Document commands, the Enhanced Auditing dialog box
appears, and displays the method used to open it. You must specify the values in the Enhanced
Auditing dialog box before the command you selected will run. If you are using the PaperVision Viewer,
you can also manually open the Enhanced Auditing dialog box to make a general disclosure that was
not initiated by a document command. See "To make a general disclosure " on page 108 for instructions.

To specify the values in the Enhanced Auditing dialog box
N O T E

The options available for specifying the Recipient and Reason values depend on how
your administrator has configured the enhanced auditing options for the project. You
can either type a new value, or select a value from the list.
1. In the Recipient box, type or select the name of the document recipient.
2. In the Reason box, type or select the reason for disclosing the document.
3. In the Notes box, type any notes you want to include in the Security Access Report. (See "Security Audit Options" on page 97 for information about this report and how to access it.)
4. Click OK to save the values you specified.

Supported File Formats for Full-Text
Extraction
All file formats are supported for full-text extraction with the following exceptions: E-Forms, .exe files,
and image files (except PDF formats). If a document is not supported for full-text extraction, you can
still upload the document and locate it by searching for index field values. However, full-text information
cannot be extracted.
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PaperVision Viewer Overview
Before you can open documents in the PaperVision Viewer, you must select the PaperVision Viewer as
your document display method. (See "To specify document viewing options" on page 161 for
instructions.) If you need help determining which document viewer to use, see "Select a Document
Viewer" on page 23 for more information about each viewer.
Use the following procedure to open the PaperVision Viewer.

To open the PaperVision Viewer
1. After you have logged in to PaperVision Enterprise, open a document list. (See "Document Lists"
on page 42 if you need help.)
2. On the document list, double-click a document to open the PaperVision Viewer.
The operations listed below are available in the PaperVision Viewer. Accessibility to specific operations
is controlled by your administrator, and the available operations may vary depending on the type of
document you opened.
See "Customize the Workspace" on the facing page to access instructions to set options that
customize the workspace.
See "Modify Index Values" on page 68 for instructions to perform this task.
See "Full-Text Options" on page 68 for instructions to perform tasks for full-text documents.
See "Thumbnail Options" on page 69 for instructions to perform tasks on the Thumbnails pane.
See "Textual Notes Options" on page 71 for instructions to perform tasks on the Textual Notes
pane.
See "Document Signature Options" on page 72 for instructions to perform tasks on the Signatures pane.
See "Scan Documents" on page 73 for instructions to perform this task.
See "Select Scanner and Set Scanner Properties" on page 75 for instructions to perform these
tasks.
See "Print Documents" on page 76 for instructions to perform this task.
See "Add Documents" on page 77 for instructions to perform this task.
See "Open Documents in Native Applications" on page 78 for instructions to perform this task.
See "Email Documents" on page 79 for instructions to perform this task.
See "Save Documents As" on page 81 for instructions to perform this task.
See "Navigate Documents and Pages" on page 83 for instructions to perform these tasks.
See "View and Edit Annotations" on page 84 for instructions to perform these tasks.
See "Workflow Options" on page 88 for instructions to perform these tasks.
See "Manage Pending Documents" on page 88 for instructions to perform tasks in the Pending
Documents View.
See "Version Control Options" on page 91 for instructions to perform tasks for version control.
See "Share Documents" on page 95 for instructions to perform this task.
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See "View Associated Documents" on page 97 for instructions to perform this task.
See "Security Audit Options" on page 97 for instructions to perform tasks for security audits.
See "Apply or Remove Document Retention Locks" on page 99 for instructions to perform these
tasks.
See "Apply or Remove Document Destruction Dates" on page 100 for instructions to perform
these tasks.
See "View Source File Information" on page 101 for instructions to perform this task.
See "Settings Overview" on page 101 to access instructions to specify various settings for the
PaperVision Viewer.
See "General Disclosure" on page 108 for instructions to perform this task.
See "Additional PaperVision Viewer Options" on page 110 for instructions to perform these
tasks.
See "PaperVision Viewer Keyboard Shortcuts" on page 111 for more information on available keyboard shortcuts.
See "Delete, Insert, Scan, and Move Pages" on page 109 for instructions to perform these tasks.
See "Supported File Types in the PaperVision Viewer" on page 112 for a listing of these file
types.

Customize the Workspace
One of the benefits of the PaperVision Viewer is that it is flexible and easy to customize to meet your
needs. Following are some of the ways you can customize the workspace.
You can specify which panes appear, and their location and size. (See "Set Pane Options" below
for instructions.)
You can specify the number of pages displayed on the Document tab. (See "Set Document
View" on page 65 for instructions.)
You can set the rotation and scale for documents. (See "Rotation and Scale Options" on page 65
for instructions.)
You can hide and show the ribbon. (See "Minimize and Maximize the Ribbon" on page 66 for
instructions.)
You customize the Quick Access Toolbar. (See "Customize the Quick Access Toolbar" on
page 66 for instructions.)

Set Pane Options
The PaperVision Viewer contains multiple panes that are easy to customize to meet your needs. The
Document and Full-Text panes are the primary panes on the workspace. They remain stationary, and
the functionality described in the following procedures is not available for them.
Pane settings are stored in the DocviewerDocking.xml file at the following location on your local
computer:
C:\Users\username\AppData\Local\Digitech
Systems\PaperVision\DocumentViewer\
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You can copy the DocviewerDocking.xml file, so you do not have to specify settings on each
computer.

To specify which panes appear
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the View tab.
3. In the Show/Hide group, select the check boxes for the panes you want to appear. Clear the
check boxes for the panes you want to hide.

To remove and apply Auto Hide
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the tab, for the pane you want to set.
3. On the upper-right corner of the pane, click the pin to remove and apply Auto Hide.
When Auto Hide is removed, the pane remains open and the pin appears in the following position:

When Auto Hide is applied, the pane is hidden (or “pinned” to the edge of the PaperVision Viewer
window), and a tab appears that displays the title of the pane. When you point to the title, the
pane temporarily displays until you click another area. The tab for the pane appears on the side
nearest to its original location. For example, if the Indexes pane was anchored on the left side, it
now appears as a tab on the left side. When Auto Hide is applied, the pin appears in the following
position:

To float panes
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the tab for the pane you want to float, and then click the title bar.
3. Drag the pane until it detaches from the workspace.

To dock floating panes
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the title bar on the pane you want to dock, and then drag the pane until you see the following symbols:

The portion of the square that has color indicates where the pane will be docked.
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3. Do one of the following:
To dock the pane on the left edge of the workspace, drag it to the
To dock the pane on the right edge of the workspace, drag it to the

symbol.
symbol.

To dock the pane on the upper edge of the workspace, drag it to the

symbol.

To dock the pane on the lower edge of the workspace, drag it to the

symbol.

To size panes
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the tab for the pane you want to size, and then rest the pointer on a border of the pane.
3. When the pointer becomes a double-headed arrow, drag the border to size the pane.

To reset panes to their default settings
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the View tab.
3. In the Docking group, click Reset Docking to clear docking settings.

Set Document View
You can set the number of pages that display on the Document tab in the PaperVision Viewer.

To set the document view
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the View tab.
3. In the Document Views group, do one of the following:
To display one page at a time on the Document tab, click One Page.
To display two pages at a time side-by-side on the Document tab, click Two Pages.

Rotation and Scale Options
Options to adjust how you view items include applying:
Rotation
Scaling (that specifies how items are sized to appear on the window)
Zoom (that increases the size of a selected area)
You can also reset the view to the default values.
N O T E

The view you set applies until you reset it. For example, if you rotate an item 90
degrees, the rest of the items appear rotated by 90 degrees until you reset the rotation.
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To set document view options
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the Rotate and Scale group, click one of the following options:
Rotate - Rotates the view 90 degrees clockwise each time you click.
Width - Sizes the item to the width of the window.
Height - Sizes the item to the height of the window.
Window - Sizes the item so that all of it appears within the window.
Reset - Sets the view back to the default settings.

To zoom the view
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Do one of the following:
Click the left mouse button and drag the pointer around the region you want to magnify.
If you are using an iPad or Android device, pinch the area you want to magnify.

Minimize and Maximize the Ribbon
The ribbon is the rectangular area that appears across the top of the PaperVision Viewer. The ribbon is
composed of tabs, each of which represent a subset of functionality. The tabs contain related
commands that are organized, grouped, and labeled. You can hide the ribbon when you want to
maximize the workspace, and then show it when you need to access commands.

To minimize and maximize the ribbon
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Do one of the following:
On the upper-right corner of the pane, do one of the following:
To minimize the ribbon, click the
To maximize the ribbon, click the

symbol.
symbol.

On the Quick Access Toolbar, click the down arrow, and then do one of the following:
To hide the ribbon, click Minimize the Ribbon.
To show the ribbon, click Maximize the Ribbon.

Customize the Quick Access Toolbar
You can select the icons to display on the Quick Access Toolbar and whether the toolbar appear above
or below the ribbon in the PaperVision Viewer. The Quick Access Toolbar is a collection of icons that
provides shortcuts to commonly used commands so you can access functions without having to switch
between tabs. For example, if you are working on the Edit tab and want to print a document without
having to go to the Home tab, you can add the print icon to the Quick Access Toolbar.
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To customize the Quick Access Toolbar
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Quick Access Toolbar, click the down arrow.
3. On the menu, you can do the following:
To add a command, select it.
To remove a command, clear the check box.
To display the toolbar below the ribbon, click Show Below the Ribbon.
To display the toolbar above the ribbon, click Show Above the Ribbon.
To hide the ribbon, click Minimize the Ribbon.
To show the ribbon, click Maximize the Ribbon.
To add more commands, click More Commands, and then complete the following procedure:
1. In the Choose commands from list, select the ribbon from which you want to select a command.
2. In the box under the selected ribbon, click the command you want to add. (To select multiple
commands, hold down the Ctrl key.)
3. Click Add to move the command(s) to the Customize Quick Access Toolbar area.
4. For commands in the Customize Quick Access Toolbar area, you can do the following:

To
Remove commands

Reorder commands

Reset commands to the
original default setting

Do this
Click the command, and then click Remove.
(To select multiple commands, hold down the Ctrl key.)
Select the command you want to move, and then click the up
arrow or down arrow.
Commands appear on the Quick Access Toolbar in the order
that they appear in the list.
Click Reset.
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Modify Index Values
If your administrator has assigned you permission to do so, you can modify index values for documents
in the PaperVision Viewer. The options available for modifying index values depend on how your
administrator has configured the project. You can either type a new index value, select a value from a
list, or both.
N O T E

When index field values are saved in PaperVision Enterprise, the following characters
are automatically removed from them: % ^ & * | <

To modify index values
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. If you do not see the Indexes pane, on the left side of the PaperVision Viewer, click the Indexing
tab.
3. On the Indexes pane, in the box for the index field(s) you want to modify, type or select the new
index value.
4. On the Home ribbon, click Save.

Full-Text Options
If you performed a full-text search on a project, you can view and search the full-text data, and view the
full-text search results for each document. The full-text search results provide a summary of each fulltext hit in the document. (See "Full-Text Searches" on page 37 if you need help performing a full-text
search.)

To view full-text data
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Full-Text tab to display the full-text data.

To search the full-text data
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Full-Text tab to display the full-text data.
3. On the lower-left portion of the Full-Text tab, type your search criteria in the Type text to find
box.

T I P

If the Type text to find box is hidden, click Find to show it.
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4. (Optional) Click the down arrow and choose from the following options to refine your search.
Match whole word only - Select this option for the search results to include only matches
where your entry appears as a word by itself, and not as part of a word.
Match case - Select this option for your search to be case sensitive.

N O T E

The Match diacritic, kashida, and alef hamza options are not functional.
5. Click Find Next to find the next search result, or click Find Previous to find the previous search
result.

To view the full-text search results
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the Misc group, click FT Results to open the Full-Text Results window.
For each full-text hit in the document, the following information appears:
Page - The page on which the hit occurred.
Word/Phrase - The search word or phrase.
Context - The text before and after the hit.
3. To view the page on which a hit occurred, double-click the hit from the list.

Thumbnail Options
The Thumbnails pane displays thumbnail images of the pages in a document. Thumbnails images are
available only for image-based documents. For non-image-based documents, the Thumbnails pane
displays a symbol that is based on the file extension. For example, when viewing a text document the
Thumbnails pane displays the following symbol
. (See "Document Types" on page 59 for a
definition of image- and non-image-based documents.) After you check out an image-based document,
on the Thumbnails pane you can cut, copy, paste, delete, and move pages. (See "To check out a
document" on page 92 if you need instructions.)

To view thumbnails
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. If you do not see the Thumbnails pane, on the right side of the PaperVision Viewer, click the
Thumbnails tab.
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3. For image-based documents, the following icons can appear on the thumbnails.

This Symbol

Indicates That
There is a textual note associated with the page. You can view the
note by clicking the Textual Notes tab. (See "Textual Notes
Options" on the facing page for more information.)
There is an annotation on the page. (See "View and Edit
Annotations" on page 84 for more information.)
This page was moved to the clipboard.
This page was copied to the clipboard.
This page was inserted after the document was checked out. It is
not saved until the document is checked back in. (See "Version
Control Options" on page 91 for instructions to check a document
out and in.)

To cut and paste pages
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. If you do not see the Thumbnails pane, on the right side of the PaperVision Viewer, click the
Thumbnails tab.
3. Select the page you want to move to the clipboard. (To select multiple pages, hold down the Ctrl
key.)
4. Right-click the selected page, and then click Cut.
The selected page is placed on the clipboard and the scissor symbol appears on the thumbnail.
5. (Optional) To clear the clipboard, right click a page, and then click Clear Copy/Cut.
6. On the Thumbnails pane, go to the page where you want to paste the page you cut.
7. Right-click the page, point to Paste, and then click either Before or After to paste the page
before or after the current page.

To copy and paste pages
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. If you do not see the Thumbnails pane, on the right side of the PaperVision Viewer, click the
Thumbnails tab.
3. Select the page you want to copy to the clipboard. (To select multiple pages, hold down the Ctrl
key.)
4. Right-click the selected page, and then click Copy.
The selected page is copied to the clipboard and the copied symbol appears on the thumbnail.
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5. (Optional) To clear the clipboard, right click a page, and then click Clear Copy/Cut.
6. On the Thumbnails pane, go to the page where you want to paste the page you copied.
7. Right-click the page, point to Paste, and then click either Before or After to paste the page
before or after the current page.

To delete pages
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. If you do not see the Thumbnails pane, on the right side of the PaperVision Viewer, click the
Thumbnails tab.
3. Select the page you want to delete. (To select multiple pages, hold down the Ctrl key.)
4. Right-click the selected page, and then click Delete.
5. Click Yes to confirm the deletion.

To move pages
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. If you do not see the Thumbnails pane, on the right side of the PaperVision Viewer, click the
Thumbnails tab.
3. Select the page you want to move. (To select multiple pages, hold down the Ctrl key.)
4. Drag the page to where you want it.

Textual Notes Options
You can add textual notes to documents to indicate their progress or share other information. Textual
notes do not have full-text search capabilities. When a textual note exists, the page appears with this
symbol

on the Thumbnails pane.
N O T E

After a textual note is created, it cannot be modified or deleted.

To add a textual note to a document
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the right side of the PaperVision Viewer, click the Textual Notes tab.
3. On the Textual Notes pane, click New Note.
4. Type the note in the box, and then click Add.
The note displays the name of the user who added it, the date and time when it was added, and
the note text.
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To view textual notes
T I P

When a textual note exists, the page appears with this symbol
pane.

on the Thumbnails

1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the right side of the PaperVision Viewer, click the Textual Notes tab.
3. On the Textual Notes pane, do one of the following:
To view notes in a text format, click
To view notes in a graphic format, click

.
.

To print textual notes
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the right side of the PaperVision Viewer, click the Textual Notes tab.
3. On the Textual Notes pane, click Print.
4. In the Print dialog box, specify the print options, and then click Print.

Document Signature Options
Whether you can view and/or add document signatures depends on if your administrator has assigned
you permission to do so. You can add a signature to a document for approval or to ensure that the
document has not been changed. When you add a signature to an image-based document, the signature
appears on the document and the Signatures pane. When you add a signature to a non-image-based
document, the signature appears only on the Signatures pane. (See "Document Types" on page 59 for
a definition of image-based and non-image-based documents.)
The system performs non-repudiation that absolutely ensures that neither the record of the signature
(that is, the database entry for the signature) nor the document itself was altered. A signature that has
passed the non-repudiation validation appears with a green check next to it. If either the signature entry
in the database or the document itself is modified, the non-repudiation check will fail and a red box
appears next to the signature in place of the green check mark. This validation is an important
requirement for admissibility of legal documents signed electronically.
Document signatures are deleted when:
A document is checked in for non-image-based documents. (Signatures will persist on imagebased documents, unless your administrator has modified the default security policy.)
The project or document that contains the signatures is deleted.
A data group is purged.
A document is rolled back to a previous version.
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To add a signature to a document
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the lower-left corner of the PaperVision Viewer, click the Signatures tab.
3. On the Signatures pane, click Add Signature.
4. In the Signature box, type the signature for the document.
5. (Optional) In the Signature Authorization Code box, type an authorization code.

N O T E

If your system is configured so that an authorization code is not required, the
Signature Authorization Code box is unavailable. If an authorization code is
required, you must type it before you proceed.
6. Click Sign.
7. In the confirmation message, click Yes.
8. If this is an image-based document, when you see the signature, place the pointer where you
want to add the signature, and then click the mouse button to place the signature on the document.

To view a document signature
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the lower-left corner of the PaperVision Viewer, click the Signatures tab.
3. (Optional) To view additional information about a signature, double-click it to open the Signature
Information dialog box.

To print a document signature
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the lower-left corner of the PaperVision Viewer, click the Signatures tab.
3. Double-click the signature to print.
4. In the Signature Information dialog box, click Print.
5. Specify the print options, and then click Print.

Scan Documents
If your administrator has assigned you permission to do so, from the PaperVision Viewer, you can scan
documents into projects and pages into image-based documents. Using a direct connection to the
scanner, any PaperVision Enterprise machine can serve as a scan station. The scan feature lets you
add or move pages within a document and maintain version control of those documents. When new
documents are scanned, they are temporarily stored on the local computer where they were scanned.
After documents are indexed, they are automatically uploaded. Documents are added to the project
currently selected. If applicable, any document-level security definitions are applied.
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To scan documents, you must:
Select the PaperVision Viewer as your document viewer. (See "To specify document viewing
options" on page 161 if you need instructions.)
Select a TWAIN-enabled scanning device. (See "Select Scanner and Set Scanner Properties"
on the facing page for instructions to select a scanner and set scanner properties.)
Specify how documents are handled during scanning. (See "Specify Scanning Settings" on
page 106 for instructions to specify scanning settings.)

I M P O R T A N T

To scan documents into PaperVision, the scanner must be connected directly to the
computer hosting the PaperVision Assistant. Do not use wireless or other network
connections.

N O T E

The following procedure describes how to scan documents into projects. To scan
pages into image-based documents, see "To scan pages into an image-based
document" on page 110 for instructions.

To scan documents
1. Place the pages you want to scan in the scanner.
2. On the Home tab, in the General group, click Scan New Document.

N O T E

Documents are added to the project that is selected when you click the Scan New
Document command, and the index fields that appear are those that have been
defined for documents in the selected project.
3. (Optional) If the Select Source dialog box appears, click the scanner you want to use, and then
click Select.
The pages are scanned and placed in the Pending Document(s) View. See "Manage Pending
Documents" on page 88 for instructions to add index values and upload documents.

T I P

If the pages did not scan correctly, in the General group, click Remove From
Pending, and then click Yes in the confirmation message to delete the document from
the Pending Document(s) View.
4. (Optional) If your system has been configured to do so, a message appears asking if you want to
add pages to the scanned document. To do so, add pages to the scanner, and then click Yes.
When you are finished scanning pages, click No to this message.
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5. (Optional) If your system has been configured to do so, the Indexing Editor appears where you
can do one of the following:
To index the document later, click Cancel. When you are ready to add index values for the
document(s), see "Manage Pending Documents" on page 88 for instructions.
To index the document now, in the boxes for the index values, type or select a new index
value, or if your system is configured to do so, index values from the previously selected document appear which you can use or overwrite.
6. (Optional) If you want to add the document into a folder, do the following:
1. Next to the Add to Folder box, click the ellipsis button.
2. In the Selected Folder dialog box, do one of the following:
Click the folder to which you want to add the document.
To create a new folder, select the appropriate parent folder, click Create Folder, type the
name for the new folder, and then click OK.
3. Click OK.
7. On the Indexing Editor, click OK.
8. See "Manage Pending Documents" on page 88 for instructions to upload documents.

Select Scanner and Set Scanner
Properties
In addition to the scanner properties described here, you can specify how documents are handled during
scanning. See "Specify Scanning Settings" on page 106 for instructions. See "Scan Documents" on
page 73 for instructions to scan documents from the PaperVision Viewer.

To select a scanner
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the General group, click the down arrow next to Scan New Doc.
3. Click Select Scanner to open the Select Source dialog box.
4. In the Sources box, click the scanner you want to use, and then click Select.

To set scanner properties
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the General group, click the down arrow next to Scan New Doc.
3. Click Scanner Properties to open the Select Source dialog box.
4. In the Sources box, click the scanner for which you want to set the properties, and then click
Select.
The properties that appear are specific to your scanner. Click Help on the Properties dialog box
or see the product documentation for your scanner for information about the properties.
5. After you set the scanner properties, click OK to save the specified settings.

PaperVision Enterprise User Guide 75

CHAPTER 5 PaperVision Viewer

Print Documents
If your administrator has assigned you permission to do so, from the PaperVision Viewer, you can print
documents.
N O T E

The options under the Printer Properties link vary depending on the type of printer. If
you need information about printer properties, see your printer documentation. Only the
print options that are specific to PaperVision Enterprise are documented in the
following procedure.

To print a document
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the General group, click Print.

N O T E

If the project has Enhanced Auditing enabled, when you click Print, the Enhanced
Auditing dialog box appears. You must specify the values in this dialog box before you
can continue with this procedure. See "Enhanced Auditing" on page 60 for instructions
to set the values in the Enhanced Auditing dialog box.
3. In the Print dialog box, specify the print options.
4. If you are printing a COLD document, in the Overlay list select one of the following options:
To print the document as text, select Text.
To print the document text with the overlay image, select Overlay.
5. If the document has annotations, do one of the following:
To print the annotations, select Include Annotation.
To exclude the annotations, clear Include Annotation.

N O T E

If your administrator set user permissions so that annotations are “forced on,” you
cannot clear the Include Annotation check box, and the Overlay setting is forced on
for COLD documents.
6. After you specify the print options, click Print.
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Add Documents
If your administrator has assigned you permission to do so, from the PaperVision Viewer, you can add
documents to projects. Documents are added to the project that was selected when you clicked the
Add command, and the index fields that appear are those that have been defined for documents in the
selected project.

To add a document
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the General group, click Add.
3. In the Add Document(s) dialog box, do one of the following:
To import documents from a directory, click Add files, select the file(s), and then click
Open.
To drag documents from a directory, select the file(s), and then drag them into the dialog box.
4. Do one of the following:
To add index values for the document(s), click Index Now.
The Add Document(s) dialog box appears with index values for the currently-displayed document.
To index the document(s) later, click Index Later to place the documents in the Pending
Document(s) area. When you are ready to add index values for the document(s), see "Manage Pending Documents" on page 88 for instructions.
5. In the Value column, type or select the index values for the selected document.

N O T E

When index field values are saved in PaperVision Enterprise, the following characters
are automatically removed from them: % ^ & * | <
6. If you are adding multiple documents, select the next document, and then repeat the previous
step for each document.
7. (Optional) If you want to add the document(s) into a folder, do the following:
1. Next to the Add to Folder box, click the ellipsis button.
2. In the Selected Folder dialog box, do one of the following:
Click the folder to which you want to add the document.
To create a new folder, select the appropriate parent folder, click Create Folder, type the
name for the new folder, and then click OK.
3. Click OK.
8. Click Save.
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Open Documents in Native Applications
If your administrator has assigned you permission to do so, you can open documents in their native
applications. To do so, the native application must be installed.
The ability to open the file you are viewing in its native application is determined by your operating
system. If you attempt to open an unsupported file type on an iPad or Android device, the native
application must be installed on the device. Otherwise, the document may not open outside the
PaperVision Viewer. When documents with annotations are viewed in their native applications, the
annotations are not applied to the document.
If your administrator has given you permission to access document versioning and this document is an
external document, you have the option to check out the document before opening it. Changes to imagebased documents will not affect the retrievable document until your changes have been checked in. You
can still access the document (on the same computer) to make additional changes prior to checking it
in.

To open a document
N O T E

You must have permissions to document versioning for the check out option to be
available.
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the General group, click Open.
3. In the Open Document dialog box, do one of the following:
To check out the document from version control before opening it, click Yes.(See "Version
Control Options" on page 91 for more information about version control and for instructions to
check the document back in.)
To open the document without checking it out, click Cancel.

N O T E

If the project has Enhanced Auditing enabled, the Enhanced Auditing dialog box
appears. You must specify the values in this dialog box before you can continue with
this procedure. See "Enhanced Auditing" on page 60 for instructions to set the values
in the Enhanced Auditing dialog box.
4. If an application has not already been associated with this file, then select one. Otherwise, the
document opens in the application associated with the file type in your operating system.

78 PaperVision Enterprise User Guide

CHAPTER 5 PaperVision Viewer

Email Documents
If your administrator has assigned you permission to do so, you can send documents by email using any
MAPI-compliant email application or the automation service. (See "Specify General Settings" on
page 102 for instructions to change the email method.) If you are using a MAPI-compliant email
application and the document is an image-based or PDF format, you can convert it to a format you
specify when you send it. If the document is not an image-based or PDF format, it will be sent in its
original format. Only image-based documents can be converted. For example, if the image is a TIF, it
can be converted to a PDF when sent. Microsoft Word documents, however, will remain as Word
documents. (See "Document Types" on page 59 for information about imaged-based and non-image
based document formats.) If you are using the automation service to send emails, document conversion
is not available.
To send documents by email, you must have an email address associated with your user account.
Contact your administrator if you need one added. When you send a document via email, the document
files and index values are included in the email message.

To send documents using a MAPI-compliant email application
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the General group, click Email.
3. On the toolbar, click Email.

N O T E

If the project has Enhanced Auditing enabled, when you click Email, the Enhanced
Auditing dialog box appears. You must specify the values in this dialog box before you
can continue with this procedure. See "Enhanced Auditing" on page 60 for instructions
to set the values in the Enhanced Auditing dialog box.
4. In the File Name list, do one of the following:
To use the system date and time for the file name, select Date/Time.
To specify a file name, select User Specified, and then type the name in the box that
appears.
To use an index value for the file name, select the index you want to use.

N O T E

Only image-based documents can be converted to a different format. For example, if
the image is a TIF, it can be converted to a PDF when saved. Microsoft Word
documents, however, will remain as Word documents.
5. In the Format list, select the format for the document(s).
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N O T E

If you email a multi-page PDF and select the same format but with a specific page
range and/or include annotations, the file will be converted to an image-based PDF.
6. In the Page Range list, do one of the following:
To send the entire document, select All Pages.
To send specific pages, click Page Range, and then type the page numbers. You can specify individual pages and page ranges (for example, 1-5, 8, 11-13).
7. If you are sending a COLD document, in the Format list select one of the following options:
To save the document text, select Text.
To save the overlay images, select Overlay.
8. If the document has annotations, do one of the following:
To send the annotations, select Include Annotations.
To exclude the annotations, clear Include Annotations.

N O T E

If your administrator set user permissions so that annotations are “forced on,” you
cannot clear the Include Annotations check box, and the Overlay setting is forced on
for COLD documents.
9. Click OK.
10. When the Batch Email dialog box appears, click Finish.
11. When your email application appears, type the email address for the recipient, the subject of the
email, the message text, and then send the email.

To send documents using the automation service
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the General group, click Email.

N O T E

If the project has Enhanced Auditing enabled, when you click Email, the Enhanced
Auditing dialog box appears. You must specify the values in this dialog box before you
can continue with this procedure. See "Enhanced Auditing" on page 60 for instructions
to set the values in the Enhanced Auditing dialog box.
3. In the Page Range area, select one of the following options:
All Pages - Select this option to send all pages of the document.
Current Page - Select this option to send the currently-displayed page.
Page Range - Select this option to send a page range, for example, 7-10.
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N O T E

When you send documents using the automation service, you can enter only a single
page range.
4. In the To box, type the email address for the recipient.
5. (Optional) In the Cc box, type the email addresses for those to receive a courtesy copy.
6. (Optional) In the Bcc box, type the email addresses for those to receive a courtesy copy without
other recipients knowing.
7. (Optional) In the Subject box, type a subject for the email message.
8. (Optional) In the text box, type a message.
9. Click Send.

Save Documents As
If your administrator has assigned you permission to do so, from the PaperVision Viewer you can save
documents and specify the directory where you want the document saved and its file name. If a
document is an image-based or PDF format, you can convert it to a format you specify when you save
it. If the document is not an image-based or PDF format, it will be saved in its original format. Only
image-based documents can be converted. For example, if the image is a TIF, it can be converted to a
PDF when saved. Microsoft Word documents, however, will remain as Word documents. (See
"Document Types" on page 59 for information about imaged-based and non-image based document
formats.)

To save documents
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the General group, click Save As to open the Save As dialog box.

N O T E

If the project has Enhanced Auditing enabled, when you click Save As, the
Enhanced Auditing dialog box appears. You must specify the values in this dialog
box before you can continue with this procedure. See "Enhanced Auditing" on page 60
for instructions to set the values in the Enhanced Auditing dialog box.
3. In the Output Directory box, type the path, or click the ellipsis button to open the Browse For
Folder dialog box where you can browse to, and then select the location where you want the document saved. You can also create a new folder by clicking Make New Folder, and then typing
the name of the folder.
4. After you have selected a location or created a folder for the document, click OK.
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5. In the File Name list, do one of the following:
To use the system date and time for the file name, select Date/Time.
To specify a file name, select User Specified, and then type the name in the box that
appears.

N O T E

The system will append user-specified file names with the extension for the specified
format, even if you type a different extension. For example, if you type file.doc, and
then save the file as a bitmap, the file name will be file.doc.bmp.
To use an index value for the file name, select the index you want to use.

N O T E

Only image-based documents can be converted to a different format. For example, if
the image is a TIF, it can be converted to a PDF when saved. Microsoft Word
documents, however, will remain as Word documents.
6. In the Format list, select the format for the saved document.

N O T E

If you save a multi-page PDF to the same format but with a specific page range and/or
include annotations, the file will be converted to an image-based PDF.
7. In the Page Range list, do one of the following:
To save the entire document, select All Pages.
To save only the current page of the document, select Current Page.
To save specific pages, click Page Range, and then type the page numbers. You can specify individual pages and page ranges (for example, 1-5, 8, 11-13).
8. If you are saving a COLD document, in the Format list select one of the following options:
To save the document text, select Text.
To save the overlay images, select Overlay.
9. If the document has annotations, do one of the following:
To save the annotations, select Include Annotations.
To exclude the annotations, clear Include Annotations.

N O T E

If your administrator set user permissions so that annotations are “forced on,” you
cannot clear the Include Annotations check box, and the Overlay setting is forced on
for COLD documents.
10. Click OK to save the selected document.
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Navigate Documents and Pages
Document and page navigation commands help you easily move through document lists. The
commands that are available depend on the number of documents in the list and the number of pages
comprising each one. In addition, if you enabled the Document Grouping option under System
Settings, multiple documents with the same index values display as if they were a single document and
Item Navigation commands will be available. (See "To specify search options" on page 161 for
instructions to set document grouping options.)

To use document navigation commands
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the Document Navigation group, select from the following commands:
To go to the document before the current document in the document list, click Previous.
To go to the document after the current document in the document list, click Next.
To go to the document that is first in the document list, click First.
To go to the document that is last in the document list, click Last.

To use page navigation commands
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the Page Navigation group, select from the following commands:
To go to the previous page of the current document, click Previous.
To go to the next page of the current document, click Next.
To go to the first page of the current document, click First.
To go to the last page of the current document, click Last.
To go to a specific page, type the page number in the box, and then press Enter.

Set Rotation and Scale Options
Options to adjust how you view items include applying:
Rotation
Scaling (that specifies how items are sized to appear on the window)
Zoom (that increases the size of a selected area)
You can also reset the view to the default values.
N O T E

The view you set applies until you reset it. For example, if you rotate an item 90
degrees, the rest of the items appear rotated by 90 degrees until you reset the rotation.
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To set document view options
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the Rotate and Scale group, click one of the following options:
Rotate - Rotates the view 90 degrees clockwise each time you click.
Width - Sizes the item to the width of the window.

N O T E

This functionality is not compatible with Grouped Documents.
Height - Sizes the item to the height of the window.
Window - Sizes the item so that all of it appears within the window.
Reset - Sets the view back to the default settings.

To zoom the view
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Do one of the following:
Click the left mouse button and drag the pointer around the region you want to magnify.
If you are using an iPad or Android device, pinch the area you want to magnify.

View and Edit Annotations
If your administrator has assigned you permission to do so, you can view, create, and modify
annotations. You can use annotations to mark up images within a document. For example, you can use
annotations to obscure content, highlight important sections, and add custom images. Annotations are
simply overlays on images, and can be applied only on image-based documents. (See "Document
Types" on page 59 for information about image- and non-image-based documents.) You can specify
how annotations are handled when an image-based document is modified. (See "Specify Annotation
Settings" on page 107 for instructions.) You can also use textual notes to add information to documents.
Textual notes are available for all document types. (See "Textual Notes Options" on page 71 for
instructions to add textual notes.)
Administrators can define user permissions so that annotations are "forced on." When this occurs:
Annotations always appear on documents, and are included when the document is saved, printed, or sent in an email message.
Users can perform operations on documents to which they have access, but they cannot
remove, hide, or move the annotations.
For full-text documents, full-text is hidden behind the annotation, but users can still perform a fulltext search on the document.
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If an annotation fails to appear, the document will not be displayed to ensure that obscured information is not exposed. This method is enforced in PaperVision Enterprise, but there are extenuating circumstances outside of PaperVision Enterprise when a determined user might be able to
view an annotated page without the annotation, thereby exposing any information hidden underneath the annotation.

N O T E

Depending on the import settings assigned to an entity by your administrator,
annotations might be lost when data groups are reloaded into PaperVision. Contact
your administrator for information about how annotations are handled in your system.

To show or hide annotations
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the Annotations group, click Show/Hide.
When you click Show/Hide, annotations are turned on or off. When annotations are turned on,
the Show/Hide icon appears with a blue background.

To open the annotation tools
N O T E

You can open the annotation tools only if your administrator has assigned you
permission to create and modify annotations.
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the Annotations group, click Show/Hide as needed to ensure that annotations are turned on.
When annotation are turned on, the Show/Hide icon appears with a blue background, and a pin
appears on the upper-left corner of the main workspace
3. Click the pin to remove and apply Auto Hide to the annotation tools.
When Auto Hide is applied, the annotation tools are hidden (or “pinned” to the edge of the workspace). When you point to the pin, the annotation tools temporarily display until you click another
area. When Auto Hide is applied, the pin appears in the following position:

When Auto Hide is removed, the pane remains open and the pin appears in the following position:
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The following table describes each annotation tool.

Button and
Command Name

Function

Click Select, to clear the currently selected annotation tool.
Select

Rectangle Zoom

Zooms in on the area you select. To reset the view, on the Home tab,
in the Rotate and Scale group, click Reset.

Creates marks as if you were using a highlighter pen.
Create Highlight
Draws a rectangle.
Create Rectangle
Draws an ellipse.
Create Ellipse
Draws straight lines.
Create Line
Draws multiple, connected straight lines.
1. Click Create Polyline, and then click the point where the
polyline starts.

Create Polyline

2. Drag to the location of a vertex, and then click to create the
vertex.
3. Repeat the previous step to create each additional vertex.
4. Double-click the location where the polyline ends.

Draws freehand, as if you were using a pen and paper.
Create Freehand
Draws a polygon.
1. Click Create Polygon, and then click the point where the
polygon starts.

Create Polygon

2. Drag to the location of a vertex, and then click to create the
vertex.
3. Repeat the previous step to create each additional vertex.
4. Double-click to complete the polygon.
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Button and
Command Name

Function

Adds descriptive text. To modify the text, double-click the annotation.
Create Text

Add/Edit Custom
Annotations

Specifies a custom image to place on documents and adds a button
for it. (See "To add, edit, or delete a custom annotation" below if you
need help.)

To add annotations to documents
1. Open the annotation tools. (See "To open the annotation tools" on page 85 if you need help.)
2. Click the button for the type of annotation you want to create.
See the table under "To open the annotation tools" on page 85 for a description of each button,
and instructions to add annotations with multiple line segments.
3. On the document, drag the annotation to where you want it.

To set annotation options
1. Open the annotation tools. (See "To open the annotation tools" on page 85 if you need help.)
2. Right-click the annotation to open the available options.

N O T E

The options available are specific for each annotation and will vary.

To cut, copy, delete, or paste annotations
1. Open the annotation tools. (See "To open the annotation tools" on page 85 if you need help.)
2. Right-click the annotation, and then select the command you want to use.

To add, edit, or delete a custom annotation
N O T E

Custom annotations created in the PaperVision Viewer are not supported in the
Browser-Based Viewer and cannot be viewed.
1. Open the annotation tools. (See "To open the annotation tools" on page 85 if you need help.)
2. Click Add/Edit Custom Annotations.
3. In the Custom Annotations dialog box, do one of the following:
To add a custom annotation, click Add.
To edit a custom annotation, select it, and then click Edit.
To delete a custom annotation, select it, and then click Delete.
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4. In the Annotation Name box, type the name for the custom annotation.
This name appears when you rest the mouse on the annotation button.
5. In the Image Path box do one of the following:
Type the path to the image you want to use.
Click the ellipses button, select the image, and then click Open.
6. Click OK to save your changes.

Workflow Options
See "WorkFlow Options" on page 147 for information on performing tasks in the WorkFlow group.

Manage Pending Documents
Documents are placed in the Pending Document(s) View when you:
Use the Add command on the Home tab, and then click Index Later.
Use the Scan New Document command on the Home tab.
In the Pending Document(s) View, you can navigate through documents and pages, set document
view options, add index values to the documents, and upload them to PaperVision Enterprise. The
documents in the Pending Document(s) View will remain there until you manually upload them to the
server, or they are indexed and saved which causes an automatic upload.
N O T E

You must be logged in for the upload process to complete. If you log out before
documents are uploaded, they will remain in the Pending Document(s) View until you
log in again and complete the upload.

To open the Pending Documents View
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the Misc group, click Pending Document(s) to open the Pending Documents View.

To add index values
1. Open the Pending Documents View. (See "To open the Pending Documents View" above if
you need help.)
2. Navigate to the document for which you want to add index values. (See "To use document navigation commands" on page 90 if you need help.)
3. On the left side of the PaperVision Viewer, click the Indexing tab.

T I P

If you are adding index values to multiple documents, click the pin on the Indexes pane
to remove Auto Hide so that the pane remains open.
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4. On the Indexes pane, in the Value column, type or select the index value for each field.

N O T E

When index field values are saved in PaperVision Enterprise, the following characters
are automatically removed from them: % ^ & * | <
5. (Optional) If you want to add the document into a folder, do the following:
1. In the Add to Folder area, click the ellipsis button.
2. In the Selected Folder dialog box, do one of the following:
Click the folder to which you want to add the document.
To create a new folder, select the appropriate parent folder, click Create Folder, type the
name for the new folder, and then click OK.
3. Click OK.
6. Do one of the following:
In the General group, click Upload Document to save your index values and upload the document to the project.
In the Document Navigation group, click any of the available options, and when prompted,
click Yes to save your index values and automatically upload the document to the project.

To upload documents
1. Open the Pending Documents View. (See "To open the Pending Documents View" on the previous page if you need help.)
2. Navigate to the document that you want to upload. (See "To use document navigation commands" on the next page if you need help.)
3. In the General group, click Upload Files.
The document is uploaded to the project from which it was originally added and removed from the
Pending Documents View.

N O T E

You must be logged in for the upload process to complete. If you log out before
documents are uploaded, they will remain in the Pending Document(s) View until you
log in again and complete the upload.

To remove a document from the Pending Documents View
1. Open the Pending Documents View. (See "To open the Pending Documents View" on the previous page if you need help.)
2. Navigate to the document that you want to remove. (See "To use document navigation commands" on the next page if you need help.)
3. In the General group, click Remove From Pending.
4. Click Yes to confirm the removal of the document.
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To use document navigation commands
1. Open the Pending Documents View. (See "To open the Pending Documents View" on page 88
if you need help.)
2. In the Document Navigation group, select from the following commands:
To go to the document before the current document, click Previous.
To go to the document after the current document, click Next.
To go to the document that is first in the Pending Documents View, click First.
To go to the document that is last in the Pending Documents View, click Last.

To use page navigation commands
1. Open the Pending Documents View. (See "To open the Pending Documents View" on page 88
if you need help.)
2. In the Page Navigation group, select from the following commands:
To go to the previous page of the current document, click Previous.
To go to the next page of the current document, click Next.
To go to the first page of the current document, click First.
To go to the last page of the current document, click Last.
To go to a specific page, type the page number in the box, and then press Enter.

To set document view options
1. Open the Pending Documents View. (See "To open the Pending Documents View" on page 88
if you need help.)
2. In the Zoom/Format group, click one of the following options:
Rotate - Rotates the view 90 degrees clockwise each time you click.
Reset - Sets the view back to the default settings.
Width - Sizes the item to the width of the window.
Height - Sizes the item to the height of the window.
Window - Sizes the item so that all of it appears within the window.

To zoom the view
1. Open the Pending Documents View. (See "To open the Pending Documents View" on page 88
if you need help.)
2. Do one of the following:
Click the left mouse button and drag the pointer around the region you want to magnify.
If you are using an iPad or Android device, pinch the area you want to magnify.
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Full-Text Search Results
If you performed a full-text search on a project, you can view the full-text search results for each
document. The full-text search results provide a summary of each full-text hit in the document. (See
"Full-Text Searches" on page 37 if you need help performing a full-text search.)

To view the full-text search results
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the Home tab, in the Misc group, click FT Results to open the Full-Text Results window.
For each full-text hit in the document, the following information appears:
Page - The page on which the hit occurred.
Word/Phrase - The search word or phrase.
Context - The text before and after the hit.
3. To view the page on which a hit occurred, double-click the hit from the list.

Version Control Options
Version control options are available so you can manage multiple versions of documents. In addition to
standard document check-out and check-in operations, you can roll documents back to previous
versions and view old versions of documents. The PaperVision Viewer handles image-based and nonimage-based documents differently. (See "Document Types" on page 59 for more information.) When
you check out image-based-document types, you can delete, insert, scan, and move pages in the
PaperVision Viewer. When you check out non-image-based document types, they are saved to a
location you specify, and then you can edit them in the native application for that file type. To save your
changes to documents, you must check in and apply a version to them.

To view the current check out status of a document
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. On the lower-right corner of the status bar, this symbol
appears when a document is checked
out. Rest the pointer on the symbol to see the date and time the document was checked out and
by whom.

N O T E

If the document is checked out, the Check Out command on the Edit ribbon is not
available.

To refresh the current document
C A U T I O N

When working with an image-based document that is checked out, refreshing it will
discard any changes made after the document was checked out. To preserve your
changes (added, deleted, moved pages), check the document in before you refresh it.
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1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Versioning group, click Refresh.

To check out a document
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Versioning group, click Check Out.

N O T E

If the project has Enhanced Auditing enabled, when you click Check Out, the
Enhanced Auditing dialog box appears. You must specify the values in this dialog
box before you can continue with this procedure. See "Enhanced Auditing" on page 60
for information to set the values in the Enhanced Auditing dialog box.
3. Do one of the following:
If the document is image-based, in the Check Out Document message, click OK.
If the document is non-image-based, complete the following steps:
1. In the Check Out Document dialog box, select the location where you want to save the
document.
2. (Optional) If you want to change the file name, type the new name in the File Name box.
3. Click Save.
4. If an application has not already been associated with this file, then select one. Otherwise,
the document opens in the application associated with the file type in your operating system.

To modify an image-based document
Check out the image-based document you want to modify. (See "To check out a document"
above if you need help.)
After the image-based document is checked out, you can delete, insert, scan, and move pages in
the PaperVision Viewer. See "Delete, Insert, Scan, and Move Pages" on page 109 for instructions.

To undo a document check out
C A U T I O N

When you undo a document check out, any changes made while the document was
checked out are not submitted.
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Versioning group, click Undo.
3. In the Document Undo Checkout dialog box, click Yes to undo the document check out.
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To check in a document
N O T E

Your administrator specifies how many versions of a document are kept before the
oldest versions are automatically deleted or moved. If a document check in initiates the
deletion of a previous version, the oldest version is either automatically deleted or
moved to the Recycle Bin.
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Versioning group, click Check In to open the Check In Document dialog box.
3. Select one of the following:
New Version (Major) - Select this option to increment the version by a whole number. For
example, version 1.002 becomes version 2.000. Selecting this option indicates that substantial changes occurred.
New Revision (Minor) - Select this option to increment the minor version of the document.
For example, version 1.002 becomes version 1.003. Selecting this option indicates that minor
changes occurred.
4. Do one of the following:
If the Source File Path and Delete Source File after Check In options are unavailable,
then go to step 5.
If the Source File Path and Delete Source File after Check In options are available, then
complete the following sub-procedure:
1. Ensure that the correct path appears in the Source File Path box. If you need to change
the path, click the ellipses button to select the file that contains the new version or revision, and then click Open.
2. (Optional) To delete the local copy of the document after it is checked in, select Delete
Source File after Check In.
5. (Optional) In the Comments box, type any notes you want to make about the changes.
The comments you type appear in the Comments column when the revision history is viewed for
the document.
6. Click OK.

To view the revision history of a document
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Versioning group, click History.

N O T E

Recycled documents appear in red text.
3. To view the contents of a specific document version, select it, and then click the View link.
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To roll back a document to an earlier version
N O T E

When you roll back a document to an earlier version, the system increments the
version number, even though the contents of the document are restored to the contents
of the earlier version. For example, version 3.000 does not roll back to version 2.000;
instead, the system increments the version to 4.000.
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Versioning group, click History.

N O T E

Recycled documents appear in red text.
3. Select the document version to which you want to roll back, and then click Roll Back.
4. In the confirmation message dialog box, click Yes.

To restore a document from the Recycle Bin
N O T E

The restore option appears only if your system administrator has specified that deleted
documents are moved to the Recycle Bin instead of being immediately deleted, and
there are recycled documents available.
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Versioning group, click History.

N O T E

Recycled documents appear in red text.
3. Select the document version that you want to restore, and then click Restore.
4. In the confirmation message dialog box, click Yes.
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Share Documents
Whether you can share documents depends on if your administrator has assigned you permission to do
so. When you share a document, a user outside your network or company can access it through a URL
address. For example, instead of faxing or emailing sensitive loan-processing information as an
attachment, you can share a document. The shared document opens through an application on the
user's computer. When sharing documents:
Document security is fully protected during transmission.
You can share multiple documents at the same time.
You can apply passwords and expiration dates to shared documents.
Applied annotations do not appear on shared documents.

To share a document
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Share Document to open the Share Document dialog box.

N O T E

If the project has Enhanced Auditing enabled, when you click Share Document, the
Enhanced Auditing dialog box appears. You must specify the values in this dialog
box before you can continue with this procedure. See "Enhanced Auditing" on page 60
for information to set the values in the Enhanced Auditing dialog box.
3. In the Expiration box, do one of the following.
Click the calendar to select the date and time that access to the document will expire.
Type the date and time that access to the document will expire.
Leave the existing default value that expires access to the document in 24 hours from the current date and time.
4. In the Password box, type the password required to view the document.

I M P O R T A N T

If you do not specify a password, any user who obtains the URL can view the
document.
5. Click OK.
6. In the confirmation message, if the information is correct, click Yes.
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7. Click Copy to Clipboard to copy the URL where the shared document can be accessed.

I M P O R T A N T

This is the only time the URL appears, so make sure you copy it. If you don't have the
URL to access the document, your administrator must manually delete the document
share or you will have to wait until it expires before you can share the document again.
8. After you have pasted the copied URL into a safe location, close the dialog box.

Duplicate Documents
You can create a duplicate of a document and edit the index values of the new document. The two
documents are tied together by the @Duplicate ID system field, and appear as a detail set in document
searches.
N O T E

When you create a duplicate document, full-text data is not copied from the original
document. The duplicate document does not have any full-text data and therefore will
not meet any full-text search criteria. However, if the duplicate document is a textbased file (such as a .txt, or .doc file), you can submit it for a full-text rebuild. (See
"Rebuild Full-Text Data" on page 59 for more information.)

To create a duplicate document
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Duplicate to open the Duplicate Docs dialog box.
3. Do one of the following to populate index fields.
In the index field box, type the index value you want to assign to the duplicate document.
Select the check box next to any index field to carry over the index value from the original document.

N O T E

When index field values are saved in PaperVision Enterprise, the following characters
are automatically removed from them: % ^ & * | <
4. Once you have configured the index values, click OK to add the duplicate document to the project.

96 PaperVision Enterprise User Guide

CHAPTER 5 PaperVision Viewer

View Associated Documents
If your administrator configured document associations for the project in which you are searching, you
can view documents (across projects) that are associated with the document open in the PaperVision
Viewer. Documents are associated by a common index field or value specified by your administrator.
When you view associated documents, the following search methods are used.
When the document association is based on an index field, the index value in the current document is used to search the index field configured in the associated project to find documents
with the same index value.
When the document association is based on an index value (or wildcard), the value specified by
your administrator is used to search the index field configured in the associated project to find
documents with the same index value.

N O T E

If the document you are currently viewing does not have any associated documents,
the Associated Documents option is not available.

To view associated documents
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Associated Documents.
The associated documents appear in a document list. The project that contains the documents
and the number of documents displayed appears at the top of the list. (If you need help using the
toolbar options, see the topics under "Document Lists" on page 42 for instructions.)
3. To view a document, double-click it.
4. If your administrator has defined multiple document associations, you can click the Document
Association list, and then select the one you want to use.

Security Audit Options
If your administrator has assigned you permission to do so, you can perform security audits for
documents. Security audits generate a Security Audit Report that records the following information
each time a document is accessed:
The user who accessed the document
The date and time the document was accessed
The operation performed
The pages that the performed operation affected
The source (IP address) from which the document was accessed
The recipient of the document. (Only available when Enhanced Auditing is enabled.)
The reason the operation was performed on the document. (Only available when Enhanced
Auditing is enabled.)
Any related notes. (Only available when Enhanced Auditing is enabled.)
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To generate a Security Audit Report
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Security Audit to open the Security Audit Report.
3. You can navigate through the report by using the following commands.
To go to the first page of the report, on the toolbar, click First Page.
To go to the previous page of the report, on the toolbar, click Previous Page.
To go to the next page of the report, on the toolbar, click Next Page.
To go to the last page of the report, on the toolbar, click Last Page.
4. (Optional) To stop generating the report while it is building, on the toolbar, click Stop Rendering.
5. (Optional) To regenerate the Security Audit Report, on the toolbar, click Refresh.
6. (Optional) To size the Security Audit Report within the window, on the tool bar, click Zoom,
and then select a sizing option from the list.

To print a Security Audit Report
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Security Audit to open the Security Audit Report.
3. (Optional) To open a preview of the printed report, on the toolbar, click Print Layout. Click Print
Layout again to return to the Security Audit Report.
4. (Optional) To specify the paper size, orientation, and print margins, click Page Setup and specify those properties in the Page Setup dialog box.
5. On the toolbar, click Print.
6. In the Print dialog box, specify the print options, and then click Print.

To search the Security Audit Report
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Security Audit to open the Security Audit Report.
3. On the toolbar, type your search criteria in the Find Text in Report box.
4. On the toolbar, click Find to begin the search. The first search result is highlighted in blue.
5. (Optional) Click Next to find the next search result.

To export a Security Audit Report
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Security Audit to open the Security Audit Report.
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3. On the toolbar, click Export and do one of the following:
To save the report as a Microsoft Excel spreadsheet, click Excel and the Save As dialog box
opens. Specify a location and file name for the export file, and then click Save.
To save the report as a PDF file, click PDF and the Save As dialog box opens. Specify a location and file name for the export file, and then click Save.
To save the report as a Microsoft Word document, click Word and the Save As dialog box
opens. Specify a location and file name for the export file, and then click Save.

Apply or Remove Document Retention
Locks
If your administrator has assigned you permission to do so, you can apply and remove document
retention locks. Applying a retention lock to a document prevents it from being deleted before the
specified lock date and time. Depending on how your administrator has configured the Recycle Bin
settings for your project, a document with a retention lock can be moved to the Recycle Bin, but it
cannot be emptied from the Recycle Bin before the specified lock date and time. You can also apply and
remove retention locks from document lists. (See "Apply or Remove Document Retention Locks" on
page 57 for instructions that apply to document lists.)
N O T E

If you do not have permission to remove retention locks, you cannot apply a new lock
date that is later than the current lock date.

To apply or edit a document retention lock
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Retention Destruction to open the Retention/Destruction dialog box.
3. In the Retention area,in the Date/Time box, click the calendar to select the date and time up to
which the document must be retained.
4. (Optional) In the Comments box, you can type comments that can be viewed until the document
is destroyed.
5. Click Apply.
6. In the confirmation message, click Yes to confirm the retention lock date and time.
7. Close theRetention/Destruction dialog box.

To remove a document retention lock
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Retention Destruction to open the Retention/Destruction dialog box.
3. In the Retention area, click Remove.
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4. In the confirmation message, click Yes to confirm the removal of the retention lock date and
time.
5. Close theRetention/Destruction dialog box.

Apply or Remove Document Destruction
Dates
If your administrator has assigned you permission to do so, you can apply and remove document
destruction dates. Depending on how your administrator has configured the Recycle Bin settings for
your project, a document with a destruction date that has been reached will either be deleted or moved
to the Recycle Bin during the destruction process. If a document is in a destruction list and you apply a
destruction date to it, it is automatically and immediately removed from all destruction lists. (See
"Destruction List Tasks" on page 168 for information about how destruction lists are used.) You can also
apply and remove destruction dates from document lists. (See "Apply or Remove Document
Destruction Dates" on page 58 for instructions that apply to document lists.)
N O T E

For document destruction to automatically happen, you administrator must have
configured a Records Retention Policy Set at the project level. If this has not occurred,
documents will not be deleted even if their specified destruction date has passed.

To apply or edit a document destruction date
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Retention Destruction to open the Retention/Destruction dialog box.
3. In the Destruction area, in the Date/Time box, click the calendar to select the date and time
when the document is to be destroyed.
4. (Optional) In the Comments box, you can type comments that can be viewed until the document
is destroyed.
5. Click Apply.
6. In the confirmation message, click Yes to confirm the destruction date and time.
7. Close the Retention/Destruction dialog box.

To remove a document destruction date
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Retention Destruction to open the Retention
Destruction dialog box.
3. In the Destruction area, click Remove.
4. In the confirmation message, click Yes to confirm the removal of the destruction date and time.
5. Close the Retention/Destruction dialog box.
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View Source File Information
For documents you can view the following source information:
Source Data Group
File Path from Root (Size)
Creation Date and Time
Version Date and Time
Non-Repudiation Results
When you open a document, PaperVision Enterprise calculates a SHA256 hash value for the document and compares it to the stored value to verify that the document has not been altered. The
non-repudiation validation returns one of the following results.
Verified - Displays a green check mark. The hash value calculated when you opened the document is the same as the stored value. This confirms that the document has not been altered.
Failed - Displays a red X. The hash value calculated when you opened the document is different from the stored value. This indicates that the document has been altered.
Skipped - Your administrator has configured PaperVision Enterprise to skip the non-repudiation process for documents. No new hash value is calculated when you open the document.

To view source file information
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Source Information to open the Source File Information dialog box.

Settings Overview
PaperVision Viewer settings are stored in the DocviewerSettings.xml file at the following location
on your local computer:
C:\Users\username\AppData\Local\Digitech
Systems\PaperVision\DocumentViewer\
You can copy this file so you do not have to specify settings on each computer. When you change a
system setting, it takes effect the next time you load a document.

To access settings
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Settings to open the Settings dialog box.
For instructions to specify the settings on each tab, see the following sections:
See "Specify General Settings" on the next page to specify the settings on the General tab.
See "Specify Display Settings" on page 103 to specify the settings on the Display tab.
See "Specify Keyboard Shortcuts (Hot Keys)" on page 105 to specify the settings on the Hot
Keys tab.
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See "Specify Printing Settings" on page 105 to specify the settings on the Printing tab.
See "Modify WorkFlow Settings" on page 150 to specify the settings on the WorkFlow tab.
See "Specify Scanning Settings" on page 106 to specify the settings on the Scanning tab.
See "Specify Annotation Settings" on page 107 to specify the settings on the Annotation
tab.

Specify General Settings
You can specify how documents are cached, the method used to send emails, and document sharing
options.

To specify general settings
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Settings.
3. Click the General tab where you can specify the following options:
In the Document Cache area, you can specify the following options:
Maximum Number of Documents in Cache - Use this box to specify the maximum
number of documents to be cached on the client. The default value is 10.
Maximum Number of Pages Downloaded per Request - Use this box to specify the
maximum number of pages to be cached at one time while viewing and navigating documents. For example, if you set this value to 5, in a 100-page document, pages 1-5 are
cached, and then when you navigate to page 6, pages 6-10 are cached. The default value
is 1.

N O T E

If the number of thumbnails exceeds this value, then the number of
documents cached at one time will equal the number of thumbnails.
In the Email area, you can specify the following options:
Send Emails via MAPI Client - Select this option for emails to be sent from the PaperVision Viewer using a MAPI (Messaging Application Programming Interface) client. This
option is selected by default.
Send Emails via Automation Server - Select this option for emails to be sent from the
PaperVision Viewer using the automation service.
In the Document Sharing area, you can specify the following options:
Display confirmation prompt for password and expiration date - Select this option to
display a confirmation message with the specified expiration date, time, and password for
the document share. The settings must be verified before the share is created. If this
option is cleared, the confirmation message does not appear. This option is selected by
default.
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Enable password - Select this option to allow a password to be specified for documents
to be shared. The same password must be entered to view the shared document. If this
option is cleared, the Password box is unavailable when the document is shared. This
option is selected by default.
Close dialog when copying to clipboard - Select this option to automatically close the
dialog box after the URL used to access the shared document is copied to the clipboard.
When this option is cleared the dialog box with the URL must be closed manually.
Default Duration - Use this box to specify the default number of days that the document
share remains available. The person setting up the document share can override this
value. The default value is 1.
In the External Documents area, you can specify the following option:
Use Embedded Web Browser Control - Administrators can specify file types that open
in their native applications instead of the PaperVision Viewer. If you have an Internet
Explorer plug-in that supports the specified file type, then the document appears in a web
browser control in the PaperVision Viewer. Otherwise, a prompt appears, and you can
choose to download the file or open it in the native application for that file type. If this
option is cleared, you will always receive the prompt to download or open the file for document types specified by your administrator to open in their native applications. This
option is selected by default.
4. After you have finished specifying the settings, click Save.

Specify Display Settings
On the Display tab you can specify:
Font options and margins for documents in a text format (TXT, RTF, HTM/HTML and
COLD/ERM).
Display setting for presentation and word-processing documents.
The display resolution for various types of documents.
The maximum size of displayed images.

To specify display settings
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Settings.
3. Click the Display tab where you can specify the following options:
In the Text Formats area, you can specify the following options:
Font Name - From this list, you can select the font to use for displaying documents that
are in a text format. The default value is Courier New.
Font Size - Use this box to specify the font size. The default value is 11.
Bold - Select this check box to display the font in bold text.
Italic - Select this check box to display the font in italics.
Left Margin - Use this box to specify the size of the left margin (in pixels) when displaying
documents. The default value is 5.
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Right Margin - Use this box to specify the size of the right margin (in pixels) when displaying documents. The default value is 5.
Top Margin - Use this box to specify the size of the top margin (in pixels) when displaying
documents. The default value is 5.
Bottom Margin - Use this box to specify the size of the bottom margin (in pixels) when
displaying documents. The default value is 5.
In the Word Processing Documents area, you can specify one of the following options for
the Display Mode:
Fit to Width - Select this option for documents to display at the width of the window. This
value is selected by default.
Fit to Height - Select this option for documents to display at the height of the window.
Fit to Max Pages Across - Select this option for documents to display so that all of the
image appears within the window.
In the Document Resolution area, you can specify the following options:
Diagram Resolution - Use this box to specify the DPI resolution for the display of diagrams. The default value is 200.
Legacy PDF Annotation Scaling - Use this box to specify the DPI resolution of PDF
documents. If your administrator set user permissions so that annotations are “forced on,”
this option is unavailable. The default value is 96.

N O T E

For PDF documents with annotations, changing the PDF Resolution
setting affects the size and position of annotations on the document.
Spreadsheet Resolution - Use this box to specify the DPI resolution for the display of
spreadsheets. The default value is 200.
Word Processing Resolution - Use this box to specify the DPI resolution for the display
of word-processing documents. The default value is 200.
In the Presentation Documents area, you can specify the following options:
Landscape Width and Height - Use these boxes to specify the landscape width and
height in pixels for the display of presentation documents. The default values are 1100,
and 850.
Portrait Width and Height - Use these boxes to specify the portrait width and height in
pixels for the display of presentation documents. The default values are 850, and 1100.
In the Image Display area, you can specify the following option:
Max Image Size - Use this box to specify the maximum size in megabytes for displayed
images. Images that are larger than the size you specified are automatically scaled down.
If large images are not displaying properly, decreasing this value may improve the display
of the image without degrading its quality. If Max Image Size is set to 0, images are never
scaled down. The default value is 5.
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Scaling Mode - From the list, select the scaling mode you want to use for all images.
Select Native to scale images using ImageGear algorithms. Select WPF to scale images
using Windows Presentation Foundation algorithms. See http://help.accusoft.com/ImageGear-Net/v21.0/Windows/HTML/topic152.html for more information on
scaling algorithms. The default setting is Native.
4. After you have finished specifying the settings, click Save.

Specify Keyboard Shortcuts (Hot Keys)
Keyboard shortcuts consist of one keystroke or multiple keystroke combinations that activate
operations in PaperVision Enterprise. The same key combination may perform a different operation
depending on your location in PaperVision Enterprise. See "PaperVision Viewer Keyboard Shortcuts" on
page 111 for a listing of keyboard shortcuts you can use in various locations. Use the procedure below
to access a list of keyboard shortcuts that you can customize.

To customize keyboard shortcuts (hot keys)
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Settings.
3. Click the Hot Keys tab.
4. Click the key combination for the keyboard shortcut you want to customize.
5. From the Key list, select the primary key you want to assign to the command.
6. To create a key combination, select the check box next to key(s) you want to include (Ctrl, Alt,
Shift).
7. (Optional) To reset the keyboard shortcut to the original default setting, click Reset.
8. To save your settings, click OK.

To restore all keyboard shortcuts (hot keys) to the default values
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Settings.
3. Click the Hot Keys tab.
4. Scroll to the bottom of the right pane, and then click Restore Default Hot Keys.
5. Click OK to confirm the reset of all hot keys to the default settings.

Specify Printing Settings
You can specify printing settings for the font, placement, and content for document headers and footers.
(See "Print Documents" on page 76 for instructions to print documents.)

To specify printing settings
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Settings.
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3. Click the Printing tab where you can specify the following options:
In the Font area, you can specify the following options:
Font Name - From this list, you can select a different font. The default font is Courier
New.
Font Size - In this box, you can type the font size. The default value is 11.
Bold - Select this check box to print the font in bold type.
Italic - Select this check box to print the font in italics.
In the Data area, for each listed location, you can type a custom value (for example, confidential) or specify one of the following options:
None - Select this value to print nothing on the page at the listed location. This is the
default value for each location.
Current Date - Select this value to print the current date on the page at the at the listed location.
Current Date and Time - Select this value to print the current date and time on the page
at the listed location.
Current Time - Select this value to print the current time on the page at the listed location.
Index Fields - Select this value to print the index fields in the document on the page at the
listed location.
Page Number - Select this value to print numbers on the page at the listed location.
4. After you have finished specifying the settings, click Save.

Specify Workflow Settings
See "Modify WorkFlow Settings" on page 150 for information on specifying workflow settings.

Specify Scanning Settings
You can specify how documents are handled during scanning.

To specify scanning settings
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Settings.
3. Click the Scanning tab where you can specify the following options:
New Document File Type - From this list, select one of the following options:
Single-Page TIFF - Select this option to save each scanned image as an individual image
(single-page TIFF) within the document. Selecting this option lets you add, remove, and
move pages in scanned documents from the PaperVision Viewer.
Multi-Page PDF - Select this option to save all pages for the scanned document as a
single, multiple-page PDF file. If you select this option, you must use a third-party application (a PDF editor) to add, remove, and move pages in scanned documents.
Pre-Populate New Fields - Select this option to populate document index values with the
same values as the document currently being viewed. This option is selected by default.
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Prompt to Add Pages - Select this option to receive a prompt to add more pages after the
scanner has finished scanning all of its pages. Selecting this option lets you add pages to the
document before it is indexed. After scanning and indexing are complete, the document cannot be modified until it is uploaded and then checked out. This option is selected by default.
Show Indexing Grid After Scan - Select this option for the indexing grid to automatically
open after a document is scanned to allow for immediate indexing. If this option is cleared,
scanned documents are placed in the Pending Documents area where they can be indexed
later.
4. After you have finished specifying the settings, click Save.

Specify Annotation Settings
You can specify how annotations are handled when an image-based document is modified. (See
"Document Types" on page 59 for information about image- and non-image-based documents.) See
"View and Edit Annotations" on page 84 for instructions to add annotations.

To specify annotation settings
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Settings.
3. Click the Annotation tab where you can specify the following options to determine what happens to annotations when a modified document is checked in.
Annotations follow Images - Select this option to keep annotations with the images to
which they are applied. For example, you have annotations on specific diagrams within a document. If you placed an annotation on a diagram on page 10, and then inserted five new
pages before it, the image that was page 10 is now page 15. Therefore, you must select this
option to keep the annotations in the correct location. Otherwise, the new page 10 image will
have the annotation that applies to the diagram on the new page 15. When this option is selected, annotations on an image that is deleted are also deleted. This option is selected by
default.
Annotations follow Page Numbers - Select this option to keep annotations with the page
number. This option is useful when annotations do not have to remain on a specific image.
For example, you have annotations on the first page of the document that apply to the entire
document and you want them to always appear on page 1. If you insert a page in front of page
1, the annotations will stay on page 1 regardless of what the image is. When this option is
selected, annotations on a deleted page are retained as long as that same page number
exists in the document.

N O T E

If you roll back a document to an earlier version, annotations are kept with their page
numbers.
4. After you have finished specifying the settings, click Save.
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Specify Signature Settings
On the Signatures tab you can specify authorization codes and fonts for electronic signatures.

To specify signature options
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click Settings.
3. Click the Signatures tab.
4. In the Signature Authorization Area area, you can specify the following options.
Authorization Code Required - Select this option to require the entry of an authorization
code to electronically sign a document.
Reset Authorization Code - In this box, type the code that must be entered to electronically
sign a document.
Re-enter Authorization Code - In this box, re-type the authorization code to verify it.
5. In the Signature Font and Signature Details Font areas, you can specify the font and font size
to use for electronic signatures and signature details.

General Disclosure
If your administrator has enabled Enhanced Auditing for a project, the Enhanced Auditing dialog box
appears when you select Print, Open, Email, Save As, Check Out, or Share Document. You must
specify the values in the Enhanced Auditing dialog box before the command you selected will run.
You can also manually open the Enhanced Auditing dialog box to make a general disclosure that was
not initiated by a command as described in the following procedure.

To make a general disclosure
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Misc group, click General Disclosure to open the Enhanced Auditing
dialog box.

N O T E

The options available for specifying the Recipient and Reason values depend on how
your administrator has configured the enhanced auditing options for the project. You
can either type a new value, or select a value from the list.
3. In the Recipient box, type or select the name of the document recipient.
4. In the Reason box, type or select the reason for disclosing the document.
5. In the Notes box, type any notes you want to include in the Security Access Report. (See "Security Audit Options" on page 97 for information about this report and how to access it.)
6. Click OK to save the values you specified.
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Delete, Insert, Scan, and Move Pages
After you check out an image-based document, you can delete, insert, scan, and move pages in the
PaperVision Viewer. (See "Document Types" on page 59 for a definition of image- and non-image-based
documents.) To save your changes to documents, you must check in and apply a version to them. (See
"Version Control Options" on page 91 for instructions.)
T I P

As you work with pages in a document, you might find it helpful to view their thumbnail
images. (See "Thumbnail Options" on page 69 for more information.)

To check out an image-based document
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Click the Edit tab, in the Versioning group, click Check Out.

N O T E

If the project has Enhanced Auditing enabled, when you click Check Out, the
Enhanced Auditing dialog box appears. You must specify the values in this dialog
box before you can continue with this procedure. See "Enhanced Auditing" on page 60
for information to set the values in the Enhanced Auditing dialog box.
3. In the Check Out Document message, click OK.

To delete pages from an image-based document
1. Check out the image-based document you want to modify. (See "To check out an image-based
document" above if you need help.)
2. Click the Edit tab, in the Page group, click Delete.
3. In the Page Range box, specify the pages you want to delete. You can specify individual pages
and page ranges (for example, 1-5, 8, 11-13).
4. Click OK.

To insert pages into an image-based document
1. Check out the image-based document you want to modify. (See "To check out an image-based
document" above if you need help.)
2. Navigate to the page in the document where you want to insert a page.
3. Click the Edit tab, in the Page group, do one of the following:
To insert pages before the current page, click Insert Before.
To insert pages after the current page, click Insert After.
4. In the Select Image File(s) to Import dialog box, locate and select the items you want to insert.
(Hold down the Ctrl key to select multiple items.)
5. Click Open.
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To scan pages into an image-based document
1. Check out the image-based document you want to modify. (See "To check out an image-based
document" on the previous page if you need help.)
2. Navigate to the page in the document where you want to scan pages.
3. Click the Home tab.
4. In the General group, next to Scan New Document, click the down arrow.
5. Do one of the following:
To insert pages before the current page, click Scan Pages Before.
To insert pages after the current page, click Scan Pages After.
The pages are scanned and now appear in the document.

To move pages in an image-based document
1. Check out the image-based document you want to modify. (See "To check out an image-based
document" on the previous page if you need help.)
2. Click the Edit tab, in the Page group, click Move Pages.
3. In the Source Page Range box, specify the pages you want to move. You can specify individual
pages and page ranges (for example, 1-5, 8, 11-13).
4. In the Destination Page box, type the page number to which you want the page(s) moved.
5. Click OK.

Additional PaperVision Viewer Options
You can improve the image quality of documents rendered as images in the PaperVision Viewer. This is
useful when you zoom in on a document and find that the image quality is degraded too much for your
purposes. These options are applied immediately to the image so that you can see which options
provide the quality you need.

To improve the quality of an image in the PaperVision Viewer
1. Open the PaperVision Viewer. (See "To open the PaperVision Viewer" on page 62 if you need
help.)
2. Right-click the document, and then do any of the following:
To enhance the quality of an image by adjusting pixel positions and intensity, click Antialias.
This setting is applied to all images you open in the PaperVision Viewer.
To enhance the quality of an image by adding or removing pixels to maintain the original resolution, click Resample. This setting is applied to all images you open in the PaperVision
Viewer.
To enhance the quality of an image by changing the scaling algorithm, click Scaling, and
then choose one of the following from the list. This setting is applied to all images you open in
the PaperVision Viewer. See http://help.accusoft.com/ImageGear-Net/v21.0/Windows/HTML/topic152.html for more information on scaling algorithms.
Click Native to scale the image using ImageGear algorithms.
Click WPF to scale the image using Windows Presentation Foundation algorithms.
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PaperVision Viewer Keyboard Shortcuts
Keyboard shortcuts consist of one keystroke or multiple keystroke combinations that activate
operations in the PaperVision Viewer. You can save time using keyboard shortcuts for repetitive,
frequently used functions. The following keyboard shortcuts are available.

Keyboard Shortcut

Function

Ctrl + Home

Displays the first page of the first document on the search results list

Ctrl + End

Displays the first page of the last document on the search results list

Ctrl + Page Up

Displays the first page of the previous document on the search results
list

Ctrl + Page Down

Displays the first page of the next document on the search results list

Home

Displays the first page of the current document

End

Displays the last page of the current document

Page Down

Displays the next page of the current document

Page Up

Displays the previous page of the current document

Ctrl + J

Jumps to a specific page of the current document

Ctrl + R

Rotates images 90 degrees

Ctrl + I

Scales image or document to full width

Ctrl + T

Scales images or document to original view (reset page)

Ctrl + H

Scales image or document to full height

Ctrl + W

Scales image to window

Ctrl + Shift + A

Adds new document

Ctrl + Shift + I

Checks in current document

Ctrl + Shift + H

Opens document history

Ctrl + E

Sends document as an email message

Ctrl + Shift + F

Opens Document Source File information

Ctrl + Shift + R

Opens Retention/Destruction information

Ctrl + Alt + A

Opens Security Audit report

Ctrl + Shift + U

Undoes a document check out

Ctrl + O

Opens the current document

Ctrl + D

Opens the Associated Document list

Ctrl + Shift + O

Checks out the current document

Ctrl + Shift + S

Opens the Save As dialog box
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Keyboard Shortcut

Function

Ctrl + P

Prints current document

Ctrl + S

Saves document changes

Ctrl + G

Opens Share Document window

Ctrl + Shift + V

Displays annotations

Ctrl + N

Scans new document

Ctrl + Alt + S

Selects new scanner

Ctrl + Alt + P

Displays scanner properties

Ctrl + Shift + W

Creates a new workflow instance

F8

Opens Workflow Status window

Shift + F5

Refreshes workflow instances

Ctrl + Delete

Deletes pending document

Ctrl + Alt + F

Displays full-text results

F5

Refreshes current document

F3

Opens Settings dialog box

Supported File Types in the PaperVision
Viewer
The permissions granted by the administrator determine whether you can view documents in the
PaperVision Viewer. You can view the following file formats without installing any additional software.

File Extension

Associated Application or File Format

ARC

Compressed Archive Format (Most commonly created as Macintosh
Hierarchical File Systems or MS-DOS archives.)

BMP

Standard Windows Bitmap Graphic Format (including OS/2)

BTR

Brooktrout FAX

CAL

CALS Raster Type 1

CAR

Computer Assisted Retrieval Format (used for microfilm-based
document and record storage and retrieval)

CGM

Computer Graphics Metafile

CLP

Windows Clipboard

CR2

Canon CR2 Digital Camera RAW Format

CRW

Canon CRW Digital Camera RAW Format
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File Extension

Associated Application or File Format

CSV

Comma Separated Values

CUR

Windows Mouse Cursor

CUT

Dr Halo Bitmap Graphic Format

DCM

DICOM (Digital Imaging and Communications in Medicine) Image
Format

DCRAW

Digital Camera RAW Format

DCX

Intel Multi-Page FAX

DGN

MicroStation Drawing

DICOM

Digital Imaging and Communications in Medicine

DNG

Adobe Digital Negative Format

DOC

Microsoft Word

DOCM

Microsoft Word (file contains macros)

DOCX

Microsoft Word (Microsoft Office Open XML Format)

DOT

Microsoft Word (template file)

DWF

Autodesk Design Web Format

DWG

Autodesk AutoCAD Drawing Format

DXF

Autodesk AutoCAD Drawing Exchange Format

EML

Microsoft Outlook Express Email

GEM

GEM Paint Raster Format

GIF

Graphic Image Format

GZ

GZip Compressed Archive Format

GZIP

GZip Compressed Archive Format

Hasselblad

Hasselblad Digital Camera RAW Format

HDP

HD Photo Format

HeaderlessRaw

Headerless Digital Camera RAW Format

HPGL

Hewlett-Packard Graphics Language Format

HTM

Hyper Text Markup Language Format

HTML

Hyper Text Markup Language Format

ICA

IBM Image Object Content Architecture

ICO

Windows ICON Format

IFF

Electronic Arts Interchange File Format
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File Extension

Associated Application or File Format

Imacon

Imacon Digital Camera RAW Format

IMG

Xerox Raster Format

IMR

IMRS-Raster Image Format

IMT

IMNET Format

JP2

JPEG 2000 File Format

JPEG

JPEG File Interchange Format

JPG

JPEG File Interchange Format

JPX

JPX File Format (JPEG 2000 Extensions)

KDC

Kodak Digital Camera RAW Format

KFX

Kofax Group 4 Image Format

LeicaRaw

Leica/Panasonic Digital Camera RAW Format

LV

Laserdata LaserView Format

MEF

Mamiya Digital Camera RAW Format

MHT

MIME HTML Web Page Archive Format

MHTML

MIME HTML Web Page Archive Format

MJ2

Reserved for Future Use

MODCA

IBM Mixed Object Document Content Architecture Format

MOS

Leaf Digital Camera RAW Format

MRW

Konica-Minolta Digital Camera RAW Image Format

MSG

Microsoft Outlook Message

MSP

Microsoft Paint Format

NCR

NCR Bitonal Image Format

NEF

Nikon Digital Camera RAW Format

ODP

Open Document Presentation Format used by OpenOffice and
StarOffice. It is based on the ODF (OpenDocument Format by OASIS)

ODS

Open Document Spreadsheet Format used by OpenOffice, StarOffice. It
is based on the ODF (OpenDocument Format by OASIS).

ODT

Open Document Text Format used by OpenOffice and StarOffice. It is
based on the ODF (OpenDocument Format by OASIS).

ORF

Oylmpus Digital Camera RAW Format

OTS

Open Document Spreadsheet Template Format used by OpenOffice and
StarOffice. It is based on the ODF (OpenDocument Format by OASIS).
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File Extension

Associated Application or File Format

PBM

Portable Bitmap Format

PCD

Kodak Photo CD

PCX

PC Paintbrush

PDF

Adobe Portable Document Format

PEF

Pentax/Samsung Digital Camera RAW Format

PhaseOne

Phase One Digital Camera RAW Format

PNG

Portable Network Graphic Format

PPT

Microsoft PowerPoint

PPTX

Microsoft PowerPoint (Microsoft Office Open XML Format)

PS

PostScript Language Format

PSB

Adobe Photoshop (Large Document Format)

PSD

Adobe Photoshop

PTOCA

IBM Presentation Text Object Content Architecture

RAF

FujiFilm Digital Camera RAW Format

RAS

Sun Raster Format

RAW

Headerless RAW Format

RTF

Rich Text Format

SCI

SCITEX

SGI

Silicon Graphics Raster Format

SonyRaw

Sony Digital Camera RAW Format

SVG

Scalable Vector Graphics

TAR

Unix Standard Archive Format

TGA

Truevision Targa Graphic Format

TIF

Tagged Image File Format

TIFF

Tagged Image File Format

TXT

Text Format

U3D

Universal 3D File Format

VDX

Microsoft Visio

VSD

Microsoft Visio

VSS

Microsoft Visio

VST

Microsoft Visio
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File Extension

Associated Application or File Format

VSX

Microsoft Visio

VTX

Microsoft Visio

VZW

Microsoft Visio

WBMP

Wireless BMP Format

WPG

WordPerfect Graphic Format

XBM

X Windows Bitmap Graphic Format

XLS

Microsoft Excel

XLSB

Microsoft Excel (binary workbook file)

XLSM

Microsoft Excel (file contains macros)

XLSX

Microsoft Excel (Microsoft Office Open XML Format)

XLTX

Microsoft Excel (template file)

XML

Extensible Markup Language Format

XPM

X Windows Pixmap Format

XPS

XML Paper Specification Format

XWD

X Windows Dump Format

ZIP

WinZip
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Browser-Based Viewer Overview
Before you can open documents in the Browser-Based Viewer, you must select the Browser-Based
Viewer as your document display method. (See "To specify document viewing options" on page 161 for
instructions.) If you need help determining which document viewer to use, see "Select a Document
Viewer" on page 23 for more information about each viewer.

To open the Browser-Based Viewer
1. After you have logged in to PaperVision Enterprise, open a document list. (See "Document Lists"
on page 42 if you need help.)
2. On the document list, double-click a document to open the Browser-Based Viewer.
The operations listed below are available in the Browser-Based Viewer. Accessibility to specific
operations is controlled by your administrator, and the available operations may vary depending on the
type of document you opened.
See "Print Documents" on the facing page for instructions to perform this task.
See "Upload Documents" on page 120 for instructions to perform this task.
See "Open Documents in Native Applications" on page 120 for instructions to perform this task.
See "Navigate Documents and Pages" on page 121 for instructions to perform these tasks.
See "Set Document View Options" on page 122 for instructions to set these options.
See "Version Control Options" on page 123 for instructions to perform tasks for version control.
See "Alter Document Index Values" on page 126 for instructions to perform this task.
See "Email Documents" on page 126 for instructions to perform this task.
See "Duplicate Documents" on page 127 for instructions to perform this task.
See "Share Documents" on page 128 for instructions to perform this task.
See "View Associated Documents" on page 129 for instructions to perform this task.
See "View Source File Information" on page 130 for instructions to perform this task.
See "Full-Text Options" on page 131 for instructions to perform this task.
See "Textual Note Options" on page 131 for instructions to perform tasks for textual notes.
See "Show and Hide Annotations" on page 132 for instructions to perform these tasks.
See "WorkFlow Options" on page 147 for instructions to perform these tasks.
See "Document Signature Options" on page 133 for instructions to perform tasks for document
signatures.
See "Document-Rendering Options" on page 134 for instructions to set these options.
See "Document Font Options" on page 135 for instructions to set these options.
See "Supported File Types in the Browser-Based Viewer" on page 136 for a listing of these file
types.
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Print Documents
If your administrator has assigned you permission to do so, from the Browser-Based Viewer, you can
print documents. The file type of the document determines what happens when you click the Print
command:
Multiple-page images prompt you to specify a page range, are converted to a PDF, and then printed.
Single-page images, PDFs, Office documents, and E-Forms are converted directly to a PDF,
and then open in your default PDF viewer where you can specify print options, and then print
them.
All other file types, open in the Browser-Based Viewer Print window, where you can specify print
options, and then print the document.

N O T E

You may see different print results when printing with PCL printer drivers as compared
to PostScript printer drivers.

To print a document
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on the previous
page if you need help.)
2. On the toolbar, click Print.

N O T E

If the project has Enhanced Auditing enabled, when you click Print, the Enhanced
Auditing dialog box appears. You must specify the values in this dialog box before you
can continue with this procedure. See "Enhanced Auditing" on page 60 for instructions
to set the values in the Enhanced Auditing dialog box.
3. Do one of the following:
When prompted, select whether you want to open or save the document, and then print it
through the application you use to view PDF documents.
In the Print dialog box, select one of the following Page Range options, and then click OK.
All - Select this option to send all pages of the document.
Current Page - Select this option to send the currently-displayed page.
Pages - Select this option to send a page range (for example, 7-10) or specific pages (for
example, 1, 8, 12).
When prompted, select whether you want to open or save the document, and then print it
through the application you use to view PDF documents.
When the document opens in the application you use to view PDF documents, specify the
print options, and then print the document.
When the document opens in the Browser-Based Viewer Print window, click Print, specify
the print options, and then print the document.
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Upload Documents
If your administrator has assigned you permission to do so, from the Browser-Based Viewer you can
add documents to projects.

To upload a document
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click Upload.
The Upload New Document dialog box appears with index values for the currently-displayed
document.
3. In the Document Index Fields area, type the required document index values.
4. (Optional) If you want to add the document into a folder, do the following:
1. Next to the Folder box, click Browse.
2. In the Choose Folder dialog box, do one of the following:
Click the folder to which you want to add the document.
To create a new folder, select the appropriate parent folder, click New Folder, type the
name for the new folder, and then click Save.
3. Click OKto place the document in the selected folder.
5. Next to the File box, click Browse.
6. In the Choose File to Upload dialog box, select the file, and then click Open.
7. Click Save.
In the Progress area, a progress message briefly appears while the document is uploaded.

Open Documents in Native Applications
If your administrator has assigned you permission to do so, you can open documents in native formats.
(See "Supported File Types in the Browser-Based Viewer" on page 136 for a complete listing of
supported files.)
The ability to open the file that you are viewing in its native application is determined by your operating
system. If you attempt to open an unsupported file type on an iPad or Android device, the native
application must be installed on the device. Otherwise, the document may not open outside the
Browser-Based Viewer. When documents with annotations are viewed in their native applications, the
annotations are not applied to the document.
If your administrator has give you permission to access document versioning and this document is an
external document, you have the option to check out the document before opening it. Changes to imagebased documents will not affect the retrievable document until your changes have been checked in. You
can still access the document (on the same computer) to make additional changes prior to checking it
in.

120 PaperVision Enterprise User Guide

CHAPTER 6 Browser-Based Viewer

To open a document in its native application
N O T E

You must have permissions to document versioning for the check out option to be
available.
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click Open.

N O T E

If the project has Enhanced Auditing enabled, when you click Open, the Enhanced
Auditing dialog box appears. You must specify the values in this dialog box before you
can continue with this procedure. See "Enhanced Auditing" on page 60 for instructions
to set the values in the Enhanced Auditing dialog box.
3. In the Message from webpage dialog box, do one of the following:
To check out the document from version control before opening it, click OK.(See "Version
Control Options" on page 123 for more information about version control and for instructions
to check the document back in.)
To open the document without checking it out, click Cancel.
4. In the prompt at the bottom of the window, do one of the following:
Click Open to open the file in its native application.
Click one of the Save options to save the file to a location where you can then open it.

Navigate Documents and Pages
Document and page navigation commands help you easily move through document lists. The
commands that are available depend on the number of documents in the list and the number of pages
comprising each one. In addition, if you enabled the Document Grouping option under System
Settings, multiple documents with the same index values display as if they were a single document and
Item Navigation commands will be available. (See "To specify search options" on page 161 for
instructions to set document grouping options.)

To use document navigation commands
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, select from the following commands:
To go to the document before the current document in the document list, click Previous.
To go to the document after the current document in the document list, click Next.
To go to the document that is first in the document list, click First.
To go to the document that is last in the document list, click Last.
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To use page navigation commands
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, select from the following commands:
To go to the previous page of the current document, click Previous.
To go to the next page of the current document, click Next.
To go to the first page of the current document, click First.
To go to the last page of the current document, click Last.
To go to a specific page, click Jump, type a page number, and then click OK.

To use item navigation commands
N O T E

Item navigation commands appear only when document grouping is in use.
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, select from the following commands:
To go to the previous item in the grouped document, click Previous.
To go to the next item in the grouped document, click Next.

Set Document View Options
Options to adjust how you view items include applying:
Rotation
Scaling (that specifies how items are sized to appear on the window)
Zoom (that increases the size of a selected area)
You can also reset the view to the default values.
N O T E

The view you set applies until you reset it. For example, if you rotate an item 90
degrees, the rest of the items appear rotated by 90 degrees until you reset the rotation.

To set document view options
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click one of the following options:
Rotate - Rotates the view 90 degrees clockwise each time you click.
Reset - Sets the view back to the default settings.
Scale to Width - Sizes the item to the width of the window.
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Scale to Height - Sizes the item to the height of the window.
Scale to Window - Sizes the item so that all of it appears within the window.

To zoom the view
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. Do one of the following:
Click the left mouse button and drag the pointer around the region you want to magnify.
If you are using an iPad or Android device, pinch the area you want to magnify.

Version Control Options
Version control options are available so you can manage multiple versions of documents. In addition to
standard document check-out and check-in operations, you can roll documents back to previous
versions and view old versions of documents.

To view the current check out status of a document
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click Status.

N O T E

If the document is not checked out, the Status option is not available.
The Current Status dialog box displays the date and time the document was checked out and by
whom.

To check out a document
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click Check Out.

N O T E

If the project has Enhanced Auditing enabled, when you click Check Out, the
Enhanced Auditing dialog box appears. You must specify the values in this dialog
box before you can continue with this procedure. See "Enhanced Auditing" on page 60
for information to set the values in the Enhanced Auditing dialog box.
3. In the prompt at the bottom of the window, do one of the following:
Click Open to open the file in its native application.
Click one of the Save options to save the file to a location where you can then open and edit
it.
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To undo a document check out
C A U T I O N

When you undo a document check out, any changes made while the document was
checked out are not submitted.
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click Undo.
3. In the Message from webpage dialog box, click OK to confirm the undoing of the check out.

To check in a document
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click Check In to open the Check In dialog box.
3. In the Changes Made area, select one of the following:
New Version (major) - Select this option to increment the version by a whole number. For
example, version 1.002 becomes version 2.000. Selecting this option indicates that substantial changes occurred.
New Revision (minor) - Select this option to increment the minor version of the document.
For example, version 1.002 becomes version 1.003. Selecting this option indicates that minor
changes occurred.
4. Next to the File Path box, click Browse to open the Choose File to Upload dialog box.
5. Locate, and then select the file that contains the new version or revision, and then click Open.
6. (Optional) In the Comments box, type any notes you want to make about the changes.
The comments you type appear in the Comments column when the revision history is viewed for
the document.
7. Click Save.

N O T E

Your administrator specifies how many versions of a document are kept before the
oldest versions are automatically deleted or moved. If a document check in initiates the
deletion of a previous version, the oldest version is either automatically deleted or
moved to the Recycle Bin.

To view the revision history of a document
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click History.

N O T E

Recycled documents appear in red text.
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3. Select the version you want to view, and then click View.
4. In the confirmation message dialog box, click OK

To roll back a document to an earlier version
N O T E

When you roll back a document to an earlier version, the system increments the
version number, even though the contents of the document are restored to the contents
of the earlier version. For example, version 3.000 does not roll back to version 2.000;
instead, the system increments the version to 4.000.
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click History.

N O T E

Recycled documents appear in red text.
3. Select the document version to which you want to roll back, and then click Roll Back.
4. In the confirmation message dialog box, click OK.

To restore a document from the Recycle Bin
N O T E

The restore option appears only if your system administrator has specified that deleted
documents are moved to the Recycle Bin instead of being immediately deleted, and
there are recycled documents available
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click History.

N O T E

Recycled documents appear in red text.
3. Select the document version that you want to restore, and then click Restore.
4. In the confirmation message dialog box, click OK.
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Alter Document Index Values
The options available for altering index values depend on how your administrator has configured the
project. You can either type a new index value, select a value from a list, or both.
N O T E

When index field values are saved in PaperVision Enterprise, the following characters
are automatically removed from them: % ^ & * | <

To alter document index values
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, (if necessary) click Manage, and then click Edit to open the Edit Index Values
dialog box.
3. In the box for the index field(s) you want to modify, type or select the new index value.
Only the index values specific to the currently-displayed document will change.
4. Click Save.

Email Documents
If your administrator has assigned you permission to do so, you can send documents by email. To do
so, you must have an email address associated with your user account. Contact your administrator if
you need one added. The document files and index values are included in the email message. If the
document is an image-based format, it is converted to a PDF when you send it. If the document is not
an image-based, it will be sent in its original format. For example, if the image is a TIF, it is converted to
a PDF when sent. Microsoft Word documents, however, will remain as Word documents. (See
"Document Types" on page 59 for information about imaged-based and non-image based document
formats.)
N O T E

When sending a grouped document by email, only the document currently displayed in
the Browser-Based Viewer is included in the email.
When sending documents by email from the Browser-Based Viewer, annotations are
not included.

To email a document
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, (if necessary) click Manage, and then click Email to open the Email dialog box.
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N O T E

If the project has Enhanced Auditing enabled, when you click Email, the Enhanced
Auditing dialog box appears. You must specify the values in this dialog box before you
can continue with this procedure. See "Enhanced Auditing" on page 60 for instructions
to set the values in the Enhanced Auditing dialog box.
3. In the Page Range area, select one of the following options:
All - Select this option to send all pages of the document.
Current Page - Select this option to send the currently-displayed page.
Pages - Select this option to send a page range, for example, 7-10.

N O T E

When you send documents using the Browser Based Viewer, only a single page range
is supported.
Pages settings are ignored for Object Type 2 PDF files. Regardless of your settings,
the entire PDF will be included in the email.
4. In the To box, type the email address for the recipient.
5. (Optional) In the Cc box, type the email addresses for those to receive a courtesy copy.
6. (Optional) In the Bc box, type the email addresses for those to receive a courtesy copy without
other recipients knowing.
7. (Optional) In the Subject box, type a subject for the email message.
8. (Optional) In the Message box, type a message.
9. Click Email.

Duplicate Documents
You can create a duplicate of a document and edit the index values of the new document. The two
documents are tied together by the @Duplicate ID system field, and appear as a detail set in document
searches.
N O T E

When you create a duplicate document, full-text data is not copied from the original
document. The duplicate document does not have any full-text data and therefore will
not meet any full-text search criteria. However, if the duplicate document is a textbased file (such as a .txt, or .doc file), you can submit it for a full-text rebuild. (See
"Rebuild Full-Text Data" on page 59 for more information.)
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To create a duplicate document
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, (if necessary) click Manage, and then click Duplicate to open the Duplicate
Docs dialog box.
3. Do one of the following to populate index fields.
In the index field box, type the index value you want to assign to the duplicate document.
Select the check box next to any index field to carry over the index value from the original document.

N O T E

When index field values are saved in PaperVision Enterprise, the following characters
are automatically removed from them: % ^ & * | <
4. After you have configured the index values, click Duplicate to add the duplicate document to the
project.

Share Documents
Whether you can share documents depends on if your administrator has assigned you permission to do
so. When you share a document, a user outside your network or company can access it through a URL
address. For example, instead of faxing or emailing sensitive loan-processing information as an
attachment, you can share a document. The shared document opens through an application on the
user's computer. When sharing documents:
Document security is fully protected during transmission.
You can share multiple documents at the same time.
You can apply passwords and expiration dates to shared documents.
Applied annotations do not appear on shared documents.

N O T E

A PaperVision Enterprise license is consumed only during the active viewing of a
shared document through the provided URL. A license is not consumed for the duration
of time while the document is shared.

To share a document
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, (if necessary) click Manage, and then click Share to open the Share Document
dialog box.
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N O T E

If the project has Enhanced Auditing enabled, when you click Share, the Enhanced
Auditing dialog box appears. You must specify the values in this dialog box before you
can continue with this procedure. See "Enhanced Auditing" on page 60 for information
to set the values in the Enhanced Auditing dialog box.
3. In the Expiration box, do one of the following.
Type the date and time that access to the document will expire.
Leave the existing default value that expires access to the document in 24 hours from the current date and time.
4. In the Password box, type the password required to view the document.

I M P O R T A N T

If you do not specify a password, any user who obtains the URL can view the
document.
5. Click Save.
6. In the confirmation message, if the information is correct, click OK.
7. In the Share Document dialog box, click Copy to Clipboard to copy the URL where the shared
document can be accessed.

I M P O R T A N T

This is the only time the URL appears, so make sure you copy it. If you don't have the
URL to access the document, your administrator must manually delete the document
share or you will have to wait until it expires before you can share the document again.
8. After you have pasted the copied URL into a safe location, click Close.

View Associated Documents
If your administrator configured document associations for the project in which you are searching, you
can view documents (across projects) that are associated with the document open in the Browser
Based Viewer. Documents are associated by a common index field or value specified by your
administrator. When you view associated documents, the following search methods are used.
When the document association is based on an index field, the index value in the current document is used to search the index field configured in the associated project to find documents
with the same index value.
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When the document association is based on an index value (or wildcard), the value specified by
your administrator is used to search the index field configured in the associated project to find
documents with the same index value.

N O T E

If the document you are currently viewing does not have any associated documents,
the Associated option is not available.

To view associated documents
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, (if necessary) click Manage, and then click Associated.
The associated documents appear in a document list. The project that contains the documents
and the number of documents displayed appears at the top of the list. (If you need help using the
toolbar options, see the topics under "Document Lists" on page 42 for instructions.)
3. To view a document, double-click it.
4. If your administrator has defined multiple document associations, you can click the Document
Association list, and then select the one you want to use.

View Source File Information
For documents you can view the following source file information:
Source Data Group
File Path from Root (Size)
Creation Date and Time
Version Date and Time
Non-Repudiation Results
When you open a document, PaperVision Enterprise calculates a SHA256 hash value for the document and compares it to the stored value to verify that the document has not been altered. The
non-repudiation validation returns one of the following results.
Verified - Displays a green check mark. The hash value calculated when you opened the document is the same as the stored value. This confirms that the document has not been altered.
Failed - Displays a red X. The hash value calculated when you opened the document is different from the stored value. This indicates that the document has been altered.
Skipped - Your administrator has configured PaperVision Enterprise to skip the non-repudiation process for documents. No new hash value is calculated when you open the document.

To view source file information
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, (if necessary) click Manage, and then click Info to open the Source File Information dialog box.
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Full-Text Options
If you performed a full-text search on a project you can view the full-text data, and the full-text search
results for each document. The full-text search results provide a summary of each full-text hit in the
document. (See "Full-Text Searches" on page 37 if you need help performing a full-text search.)

To view the full text data for a document
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, (if necessary) click Manage, and then click Full Text to view only the full-text
data for the document.
3. To return to the regular view of the document, click the Full Text option again.

To view the full-text search results for a document
N O T E

This feature is available only when you run a full-text search before opening the
Browser-Based Viewer. (See "Full-Text Searches" on page 37 if you need help.)
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, (if necessary) click Manage, and then click FT Results to open the Full Text
Search Results dialog box.
3. The Full Text Search Results dialog box lists each full-text hit in the document with the following information.
Page - The page on which the hit occurred.
Word/Phrase - The search word or phrase.
Context - The text before and after the hit.
4. To view the page on which a hit occurred, select the hit from the list, and then click View.

Textual Note Options
You can add textual notes to documents to indicate their progress or share other information. Textual
notes do not have full-text search capabilities.
N O T E

After a textual note is created, it cannot be modified or deleted. When a textual note
exists, the Notes icon displays with a red push pin on it.

To add a textual note to a document
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, (if necessary) click Annotate, and then click Notes to open the Textual Note dialog box.
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3. In the Textual Note box, type the note, and then click Add.
The lower box displays a heading with your user name and the date and time you added the note,
followed by the note.
4. Click Save.

To view a textual note
T I P

When a textual note exists, the Notes icon displays with a red push pin on it.
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, (if necessary) click Annotate, and then click Notes to open the Textual Note dialog box.

To print a textual note
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, (if necessary) click Annotate, and then click Notes to open the Textual Note dialog box.
3. Click Print.
4. In the Print dialog box, specify the print parameters, and then click Print.

Show and Hide Annotations
Whether you can show and hide document annotations depends on if your administrator has assigned
you permission to do so.
N O T E

To add and edit annotations you must be using the PaperVision Viewer and have
permission assigned by your administrator. See "To specify document viewing
options" on page 161 for instructions to switch to the PaperVision Viewer, and "View
and Edit Annotations" on page 84 for instructions for annotation tasks in the
PaperVision Viewer.

To show and hide annotations
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
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2. On the toolbar, do one of the following:
To show annotations, (if necessary) click Annotate, and then click Show.

N O T E

Custom annotations created in the PaperVision Viewer are not supported in the
Browser-Based Viewer and cannot be viewed.
To hide annotations, click Hide.

Workflow Options
See "WorkFlow Options" on page 147 for information on performing workflow tasks.

Document Signature Options
Whether you can view and/or apply document signatures depends on if you administrator has assigned
you permission to do so. You can add a signature to a document for approval or to ensure that the
document has not been changed. When you apply a signature to a document, validation occurs on all
files within it. Because the system must calculate SHA256 hashes for every page of the document, for
optimal performance use single-file documents for signing. The system performs non-repudiation that
absolutely ensures that neither the record of the signature (that is, the database entry for the signature)
nor the document itself was altered.
A signature that has passed the non-repudiation validation appears with a green check next to it. If either
the signature entry in the database or the document itself is modified, the non-repudiation check will fail
and a red box appears next to the signature in place of the green check mark.
Document signatures are deleted when:
The project or document that contains the signatures is deleted.
A data group is purged.
A document is rolled back to a previous version.

To view a document signature
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click Show to display signature information at the bottom of the window.
3. (Optional) To view additional information about a signature, double-click it to open the Signature
Information dialog box.

To print signature information
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click Show to display signature information at the bottom of the window.
3. Double-click the signature to print.
4. In the Signature Information dialog box, click Print.
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To apply a document signature
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click Sign to open the Sign Document dialog box.
3. In the Signature box, type the signature for the document.
4. (Optional) In the Signature Authorization Code box, type an authorization code.

N O T E

If your system is configured so that an authorization code is not required, the
Signature Authorization Code box is unavailable. If an authorization code is
required, you must type it before you proceed.
5. Click Sign.
6. In the confirmation message, click OK.
7. When the pointer becomes a cross, place the pointer where you want to apply the signature, and
then click the mouse button to place the signature on the document.

Document-Rendering Options
You can specify how certain types of documents are rendered when they are opened in the BrowserBased Viewer. Generally, you can render documents as images or in their native applications.
The following list summarizes how specific documents are rendered in the Browser-Based Viewer:
Images are displayed in their native format and are not converted to another format in the
Browser-Based Viewer.
Non-converted documents, such as text, HTML, files of unknown types, and files with missing
extensions, are not converted in the Browser-Based Viewer. As a result, these types of files do
not support graphical annotations.
PDF and Postscript documents (such as PS, EPS) are not converted in the Browser-Based
Viewer. However, PDF files support existing annotations.
Multiple-part files, such as ZIP, GZIP, and TAR, are displayed in a tree structure. If you select a
file in the container, its contents are displayed if they are supported file types.
Message documents (EML and MSG) and their attachments, are displayed in a general email layout. When you select an attachment in a supported file format, the page navigation operations
are accessible.

N O T E

Document-rendering options are saved based on a per-project, per-browser basis. By
default, document-rendering options are set to display documents as PNG images at
200 DPI resolution.
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To set rendering options for documents
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click Options to open the Edit Viewer Options dialog box.
3. Click the General Rendering tab.
4. For each document type (except for PDF documents), you can set the following options:
Render As - From this list, select Image to cause the document type to render as images or
select Native to cause spreadsheets to open in their native application.
Image Page Resolution - In this box, you can specify the resolution in dpi (dots per inch) at
which the document will display.
5. For presentation documents only, you can set the following additional options:
Page Size - From this list, you can select Letter, Legal, A4, or Custom. If you select custom, type the width and length dimensions in the two boxes to the right. You can select in for
inches, or cm for centimeters as the unit of measure.
Paper Orientation - Select either Portrait (vertical) or Landscape (horizontal) orientation.
6. For PDF documents, from the Render As list, you can select either Image or SVG (Scalable
Vector Graphics).
Documents rendered as scalable vector graphics render more slowly, but more clearly.

Document Font Options
You can set font options for textual documents in the Browser-Based Viewer.

To set font options for textual documents
1. Open the Browser-Based Viewer. (See "To open the Browser-Based Viewer" on page 118 if you
need help.)
2. On the toolbar, click Options to open the Edit Viewer Options dialog box.
3. Click the Fonts tab.
4. For each font type, you can set the following options:
Font Name - From this list, you can select a different font.
Font Size - In this box, you can type the font size.
Font Bold - Select this check box to display the font in bold text.
5. For plain text font only, you can select the Font Italics check box to display the font in italics.
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Supported File Types in the Browser-Based
Viewer
The permissions granted by the administrator determine whether you can view documents in the
Browser-Based Viewer. You can view the following file formats without installing any additional
software.

File Extension

Associated Application or File Format

ARC

Compressed Archive Format (Most commonly created as Macintosh
Hierarchical File Systems or MS-DOS archives.)

BMP

Standard Windows Bitmap Graphic Format (including OS/2)

BTR

Brooktrout FAX

CAL

CALS Raster Type 1

CAR

Computer Assisted Retrieval Format (used for microfilm-based
document and record storage and retrieval)

CGM

Computer Graphics Metafile

CLP

Windows Clipboard

CR2

Canon CR2 Digital Camera RAW Format

CRW

Canon CRW Digital Camera RAW Format

CSV

Comma Separated Values

CUR

Windows Mouse Cursor

CUT

Dr Halo Bitmap Graphic Format

DCM

Digital Imaging and Communications in Medicine

DCRAW

Digital Camera RAW Format

DCX

Intel Multi-Page FAX

DGN

MicroStation Drawing

DIB

Microsoft Device Independent Bitmap

DICOM

Digital Imaging and Communications in Medicine

DICM

Digital Imaging and Communications in Medicine

DNG

Adobe Digital Negative Format

DOC

Microsoft Word

DOCM

Microsoft Word (file contains macros)

DOCX

Microsoft Word (Microsoft Office Open XML Format)

DOT

Microsoft Word (template file)
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File Extension

Associated Application or File Format

DWF

Autodesk Design Web Format

DWG

Autodesk AutoCAD Drawing Format

DXF

Autodesk AutoCAD Drawing Exchange Format

EML

Microsoft Outlook Express Email

EPS

Encapsulated PostScript Format

GEM

GEM Paint Raster Format

GIF

Graphic Image Format

GZ

GZip Compressed Archive Format

GZIP

GZip Compressed Archive Format

Hasselblad

Hasselblad Digital Camera RAW Format

HDP

HD Photo Format

HeaderlessRaw

Headerless Digital Camera RAW Format

HPF

Hewlett-Packard Plot Format

HPGL

Hewlett-Packard Graphics Language Format

HTM

Hyper Text Markup Language Format

HTML

Hyper Text Markup Language Format

ICA

IBM Image Object Content Architecture

ICO

Windows ICON Format

IFF

Electronic Arts Interchange File Format

Imacon

Imacon Digital Camera RAW Format

IMG

Xerox Raster Format

IMR

IMRS-Raster Image Format

IMT

IMNET Format

JP2

JPEG 2000 File Format

JPEG

JPEG File Interchange Format

JPG

JPEG File Interchange Format

JPX

JPX File Format (JPEG 2000 Extensions)

KDC

Kodak Digital Camera RAW Format

KFX

Kofax Group 4 Image Format

LeicaRaw

Leica/Panasonic Digital Camera RAW Format

LV

Laserdata LaserView Format
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File Extension

Associated Application or File Format

MEF

Mamiya Digital Camera RAW Format

MHT

MIME HTML Web Page Archive Format

MHTML

MIME HTML Web Page Archive Format

MJ2

Reserved for Future Use

MODCA

IBM Mixed Object Document Content Architecture Format

MOS

Leaf Digital Camera RAW Format

MRW

Konica-Minolta Digital Camera RAW Image Format

MSG

Microsoft Outlook Message

MSP

Microsoft Paint Format

NCR

NCR Bitonal Image Format

NEF

Nikon Digital Camera RAW Format

ODP

Open Document Presentation Format used by OpenOffice and
StarOffice. It is based on the ODF (OpenDocument Format by OASIS).

ODS

Open Document Spreadsheet Format used by OpenOffice, StarOffice. It
is based on the ODF (OpenDocument Format by OASIS).

ODT

Open Document Text Format used by OpenOffice and StarOffice. It is
based on the ODF (OpenDocument Format by OASIS).

ORF

Oylmpus Digital Camera RAW Format

OTS

Open Document Spreadsheet Template Format used by OpenOffice and
StarOffice. It is based on the ODF (OpenDocument Format by OASIS).

PAL

Dr Halo Palette Format

PBM

Portable Bitmap Format

PCD

Kodak Photo CD

PCX

PC Paintbrush

PDF

Adobe Portable Document Format

PEF

Pentax/Samsung Digital Camera RAW Format

PhaseOne

Phase One Digital Camera RAW Format

PGM

Portable Graymap Graphic Format

PNG

Portable Network Graphic Format

PNM

PBM Portable Any Map Graphic Format

PPM

Portable Pixelmap Graphic Format

PPT

Microsoft PowerPoint
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File Extension

Associated Application or File Format

PPTX

Microsoft PowerPoint (Microsoft Office Open XML Format)

PS

PostScript Language Format

PSB

Adobe Photoshop (Large Document Format)

PSD

Adobe Photoshop

PTO

Hugin-PTX Group Project Format

PTOCA

IBM Presentation Text Object Content Architecture

RAF

FujiFilm Digital Camera RAW Format

RAS

Sun Raster Format

RAW

Headerless RAW Format

RTF

Rich Text Format

SCI

SCITEX

SGI

Silicon Graphics Raster Format

SonyRaw

Sony Digital Camera RAW Format

SVG

Scalable Vector Graphics

TAR

Unix Standard Archive Format

TGA

Truevision Targa Graphic Format

TIF

Tagged Image File Format

TIFF

Tagged Image File Format

TXT

Text Format

U3D

Universal 3D File Format

VDX

Microsoft Visio

VSD

Microsoft Visio

VSS

Microsoft Visio

VST

Microsoft Visio

VSX

Microsoft Visio

VTX

Microsoft Visio

VZW

Microsoft Visio

W2D

Autodesk 2D XML Vector Data

W3D

Adobe Shockwave 3D Scene Export Format

WBMP

Wireless BMP Format

WDP

HD Photo Format
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File Extension

Associated Application or File Format

WPG

WordPerfect Graphic Format

XBM

X Windows Bitmap Graphic Format

XHTML

Extensible Hyper Text Markup Language Format

XLS

Microsoft Excel

XLSB

Microsoft Excel (binary workbook file)

XLSM

Microsoft Excel (file contains macros)

XLSX

Microsoft Excel (Microsoft Office Open XML Format)

XLTX

Microsoft Excel (template file)

XML

Extensible Markup Language Format

XPM

X Windows Pixmap Graphic Format

XPS

XML Paper Specification Format

XWD

X Windows Dump Format

ZIP

WinZip
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Basic WorkFlow Overview
A workflow definition describes a series of activities (worksteps, tasks, pre-conditions, etc.) and the
order and conditions under which they run. The WorkFlow engine implements the workflow definition to
automate a business process.
To build a workflow definition, administrators include the following elements:
Defined workflow participants
Workflow definition, which serves as a template of the activities that must occur in the workflow
Start workstep, which kicks off the first workflow instance when an associated pre-condition is
met
Worksteps, including the associated tasks, post-conditions, time limits, and workflow participants; worksteps can be automated, which means the system undertakes them, or manual,
which means a user or group undertakes them.
Stop step, which serves as the last step in the workflow instance
All workflow definitions follow the same basic steps.
1. The WorkFlow engine searches for documents that meet the pre-condition criteria. Each match
creates a workflow instance.
2. In each instance, the WorkFlow engine routes the document to the first workstep. Automated
worksteps are completed by the WorkFlow engine. Manual worksteps are assigned to users or
groups who can view them on the Worksteps Waiting/Owned tab. Clicking on a workstep
opens the document viewer where you can select each workstep instance and associated tasks.
3. As each task is completed, the WorkFlow engine evaluates post-conditions. After at least one
post-condition is met, the workflow instance is transitioned to the next workstep.
4. When the last workstep meets a post-condition, the workflow instance transitions to the stop
workstep, and the workflow instance is complete.
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The following figure illustrates a simple loan-processing workflow.

When working with workflows, keep the following in mind:
A single document can be active in multiple workflow instances at the same time.
If someone deletes the document from the system, the workflow instance automatically transitions to the stop step, and the application sends the workflow administrator a notice in the log
file.
Documents restored from the Recycle Bin are not reinstated back into workflows.
A workstep instance can be owned by only one user at a time.
A workstep instance does not have to be completed all at once.
Tasks within a workstep instance do not have to be performed in a specific order.
The system tracks all workflow instances individually for audit reports.
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WorkFlow Terms You Should Know
This content contains definitions for terms that are used throughout the documentation and online help
when working with workflows and worksteps. Knowing this terminology will help you use the product
and its documentation more effectively. These terms adhere to the standard terms and approved
synonyms prescribed by the Workflow Management Coalition.

Workflow Definition
A workflow definition describes a series of activities (worksteps, tasks, pre-conditions, etc), and the
order and conditions under which they execute, that are controlled by the WorkFlow engine to automate
a business process.

Workflow or Workflow Instance
A workflow or workflow instance is a representation of a single enactment of a workflow definition. A
workflow instance is the live execution of a workflow definition. When a document is imported into
PaperVision that meets the pre-conditions for a workflow definition, the system will spawn a workflow
instance of that workflow definition. In other words, you may create a workflow definition for a loan
processing application, but the workflow instances are the live representations of loans as they are
processed through that workflow.
N O T E

A single document can be active in multiple workflow instances at the same time. If the
document is deleted from the system, the workflow instance will be transitioned to the
end automatically with a history entry outlining that the document was deleted.

Pre-Conditions
Pre-conditions define a set of rules based on document index criteria that are used to determine if
documents should automatically spawn new workflow instances when a document is added to the
system (via importing data groups or manually adding a new document). A workflow definition can
contain multiple pre-conditions. Once a pre-condition is met for a specific workflow definition and the
workflow instance has been instantiated, no additional pre-conditions for that same workflow will be
evaluated. However, other workflow definitions’ pre-conditions will be evaluated to see if workflow
instances should be created for them. If no pre-conditions are defined for a workflow, workflow
instances will have to be manually created by administrators or users explicitly granted access to do so.
N O T E

Pre-conditions defined as new versions are not re-evaluated for existing documents
(those already residing in the system) when importing with the Full Reload as New
Object Version option. Pre-conditions defined as new versions are only re-evaluated
during document check-in.
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Workstep Definition
A Workstep definition describes an activity that forms one logical step within a process defined by a
workflow definition. This activity may be automated by the WorkFlow server (with no user intervention)
or may require the user to perform one or a series of tasks. A workstep definition includes one or more
tasks that are assigned to a single participant. While worksteps must be performed in the order defined
by the workflow definition, tasks within a workstep can be performed in any order.

Workstep or Workstep Instance
A workstep or workstep instance is a representation of a single enactment of a workstep definition
within a workflow instance. It is the smallest unit of work scheduled by the WorkFlow engine. Once a
workflow instance is created, there is always exactly one active/current workstep instance representing
the workstep that the workflow is currently on. The workstep instance may be owned by a single user
who is currently working on it or it may be unowned (waiting to be taken ownership of). A workstep
instance does not have to be completed all at once. In other words, a user may perform certain tasks on
workstep A; complete work on workstep B; then return to complete workstep A at a later time.

Tasks
A task represents an item of work that can be performed during a workstep. Only one user can own a
workstep; all tasks to be performed within that workstep must be performed by that one user (more than
one user cannot be assigned to the tasks comprising the workstep). Tasks within a workstep do not
have to be performed in any specific order. However, the administrator can order the tasks differently for
each user.
Tasks can include user operations or automated operations. User tasks are instructions telling the user
to do something. Once the user has done that task, the user can mark it as completed. Automated tasks
are operations that are carried out by the system for the user. Automated tasks include forcing a
document index field to a specific value, executing command-line instructions (to launch separate
applications or perform a system operation), and raising events (to allow a third-party application to
interact with the workstep). Automated tasks are executed after the previous task in the workstep is
executed.

Workstep Participants
A workstep participant indicates whether a group of users will complete the workstep or the server
(Automated) will automatically perform every task in the workstep.

Workstep Transition
A workstep transition occurs when a workstep is completed and the flow of the workwlow moves
(transitions) to another workstep.

Post Conditions
Post conditions are rules that are evaluated when a workstep instance is activated. After each task is
processed, post conditions are used to determine whether the workstep is completed. Post conditions
contain two pieces of information, including evaluation rules and the transition workstep. The evaluation
rules specify the tasks to be completed and/or any document index criteria that must exist in order for
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the rule to be satisfied. If the rule is satisfied, then the workstep is marked as completed and then
transitioned to its transition workstep. The transition workstep specifies the next workstep; it can also
specify the end of the entire workflow or transition to another workflow entirely.
A workstep definition may contain multiple post-conditions. Each post condition is evaluated in order
(i.e. when a workstep contains multiple post conditions, the first post condition that is met will initiate
the workstep transition, and the workstep will be completed.

Workstep Owned/Unowned
As workstep instances are created, defined workstep participants can assume ownership of them. Until
the worksteps are claimed, they sit in a queue unowned. Once a specific user (or the system) assumes
ownership of the workstep instances, that user (or the system) becomes the workstep's owner. When a
user (or the system) takes ownership of the workstep instances, no other participants can perform any
of the tasks for those particular workstep instances. Ownership of workstep instances can only be
revoked by an administrator.

Worksteps Waiting/Owned Overview
If you are assigned to worksteps within a workflow definition, you can click Worksteps
Waiting/Owned to view a list of your worksteps (the Worksteps Waiting/Owned tab is unavailable if
there are no workflows defined). Each list item includes the name of the workflow, workstep, and the
number of workstep instances that are unowned, and the number that are owned. For example, if you
are assigned to the Application Approval workstep in the Loan workflow, and there are nine unowned,
and five owned workstep instances, the list will display Loan:Application Approval (9/5). When you
select a workstep, the Workstep Instances list opens in the PaperVision Viewer. To complete your
workstep tasks, you must select the workstep, take ownership of the workstep instance, and then
complete the tasks associated with that workstep instance.
If you have a large number of workstep instances assigned to you, it may be helpful to group them. In
the Workstep Instances list, you can group workstep instances by column headings. You can also
filter and sort the Workstep Instances list.

To group workstep instances
1. After you have logged in to PaperVision Enterprise, select the Worksteps Waiting/Owned
pane.
2. Click the workstep for which you want to group workstep instances.
3. On the Workstep Instances list, select the column heading to use to group the workstep
instances, and then drag it to the row above the grid.
The workstep instances are now grouped by each entry in that column heading. For example, to
group all the owned workstep instances, drag the Status column heading to the row above the
grid. The grid will then contain a group of all the owned workstep instances and a group of all the
unowned workstep instances.
4. (Optional) You can drag additional column headings to the row above the grid to divide workstep
instances into groups and subgroups.
For example, if you grouped the workstep instances into owned and unowned groups, you could
drag an index field (Last Name) to the row above the grid. The result would be two groups:
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owned, and unowned. Each of those groups would have subgroups based on the Last Name
index field.

To filter workstep instances
1. After you have logged in to PaperVision Enterprise, select the Worksteps Waiting/Owned
pane.
2. Click the workstep for which you want to filter workstep instances.
3. On the Workstep Instances list, select the column heading you want to use to filter the workstep instances, and then click the filter button to open the filter dialog box.
4. Do any of the following:
To filter the list based on specific index values, select the values you want to include in the
filtered list.
To filter the list based on a condition, type the value you want to use in the box, click the
down arrow, and then select the appropriate operator.
For example, to filter all rows where the value in the selected column is greater than 15, type
15 in the box, and then select Is greater than from the list. Optionally, if you want the filter to
be case sensitive, click Match case.
To filter by more than one condition, type the value you want to use for the first condition in
the first box, click the down arrow, and then select the appropriate operator. In the second
box, type the value you want to use for the second condition, click the down arrow, and then
select the appropriate operator.

To sort workstep instances
1. After you have logged in to PaperVision Enterprise, select the Worksteps Waiting/Owned
pane.
2. Click the workstep for which you want to sort workstep instances.
3. On the Workstep Instances list, click a column heading to sort the results in ascending order.
4. (Optional) Click the column heading again to reverse the sort order.

WorkFlow Options
If your administrator has assigned you permission to do so, you can create a workflow instance, and
view the workflow status of a document. The workflow status includes information on each workflow
instance with which the document is associated, and a complete history of the document for each
instance.

To create a workflow instance
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, double-click the document for which you want to create a workflow
instance.
3. On the toolbar, in the WorkFlow group, click Create Instance to open a list of available workflows.
4. Select the appropriate workflow from the list, and then click Create.
5. Click OK.
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To view the workflow status of a document
1. Open a document list. (See "Document Lists" on page 42 if you need help.)
2. On the document list, double-click the document for which you want to view the workflow status.
3. On the toolbar, in the WorkFlow group, click View Status to open a workflow status list
4. The workflow status list displays each workflow instance of the document with the following
information: Workflow Instance ID, Workflow Name, Workflow Start Time, Workflow End Time,
Workstep Instance ID, Workstep Name, Workstep Start time, and Owner. ( See "Worksteps
Waiting/Owned Overview" on page 146 for information on grouping, sorting, and filtering the list.)
5. Select any associated workflow instance on the list to view a complete history of the document.

Take Ownership of Workstep Instances
The Workstep Instances list in the PaperVision Viewer, displays all the owned and unowned workstep
instances to which you have been assigned. You must take ownership of a workstep instance to
complete any tasks assigned to it. (See "Worksteps Waiting/Owned Overview" on page 146 for
information on grouping, sorting, and filtering the Workstep Instances list.) Once you take ownership of
a workstep instance, only an administrator can change the status to unowned.

To take ownership of a workstep instance
1. After you have logged in to PaperVision Enterprise, select the Worksteps Waiting/Owned
pane.
2. Click the workstep for which you want to take ownership.
3. In the Workstep Instances list, double-click the workstep instance for which you want to take
ownership. If a confirmation message appears, click Yes.

N O T E

To take ownership of multiple worksteps, while holding the Shift key, select the
worksteps in the Workstep Instance list, and then double-click your selection.
Alternatively, after you have made your selection, press Enter. Click Yes on the
confirmation message.
4. (Optional) If you want to take ownership of a workstep instance in another workstep, click the
down arrow next to Workstep, select the workstep from the list, and then double-click the workstep. If a confirmation message appears, click Yes.
5. (Optional) Click Refresh to update the Workstep Instances list.

Complete a Workstep Task
The Tasks tab in the PaperVision Viewer lists of all the tasks associated with the selected workstep
instance. You must take ownership of a workstep instance to complete any of the associated tasks.
After you complete a task, the WorkFlow engine evaluates all the post-conditions for that workstep
instance. After a post-condition is met, the workstep instance transitions to the next workstep.

To complete a workstep task
1. After you have logged in to PaperVision Enterprise, select the Worksteps Waiting/Owned
pane.
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2. Click the workstep for which you want to complete a task.
3. In the Workstep instances list, select the owned workstep for which you want to complete a
task. (See "Take Ownership of Workstep Instances" on the previous page for more information.)
4. Click the Tasks tab to open the list of the tasks associated with the selected workstep instance.
Any previously completed tasks display a green check mark.
5. Your administrator provides instructions for completing assigned tasks that can include the following task types:
User Operation - This task type requires you to perform a certain function such as approve
or deny a request. Click the appropriate task button.
Launch Application/Shell - This task type executes a specified command-line program configured by an administrator. Click the task button to launch the application.
Raise Event - This task type raises an event with a third-party application. Click the task button to raise the event.
Alter Index Values - This task type opens the Indexing dialog box. Click the task button,
update the appropriate indexes, and then click OK.
Send Email - This task type sends a preconfigured email message. Click the task button to
send the message.

N O T E

If you want to include annotations for document attachments included in the email
message, you must select Show Annotations in the PaperVision Viewer. See "View
and Edit Annotations" on page 84 for more information.
Force Index Value - This task type updates an index value that was configured by an administrator. Click the task button to change the index value.
Sign Document - This task type opens the Sign Document dialog box. Click the task button, type the appropriate information in the dialog box, and then click Sign. (See "Document
Signature Options" on page 72 for more information on signing documents.)
Custom Code - This task type executes custom code that was configured by an administrator. Click the task button to execute the custom code.
E-Form Validation - This task requires you to complete an E-Form and then save it before
the task is marked complete. Click the task button to place the E-Form in edit mode. You
must save the E-Form before you can perform another task.
6. Depending on your assigned WorkFlow settings, after you complete a task, a confirmation message may appear. Click Yes to confirm that you have completed the task.
7. Do one of the following:
Repeat this procedure for any remaining tasks.
If the completion of any task meets a post-condition and the workstep transitions, click OK to
proceed to the next workstep instance. Depending on your WorkFlow settings, the next available workstep instance will open, or you may have to select the next workstep instance.
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Modify WorkFlow Settings
If you are assigned the proper permissions, you can change your local WorkFlow settings. Entity
settings defined by your administrator will override any changes you make.
When you are working with a WorkFlow, you can customize the workspace using the same options that
are available for the PaperVision Viewer. See "Customize the Workspace" on page 63 for instructions.
WorkFlow settings are stored on your local computer at the following location:
C:\Users\username\AppData\Local\Digitech
Systems\PaperVision\DocumentViewer\
The WorkFlowViewerDocking.xml file contains the docking settings, and the
DocviewerSettings.xml file contains the settings described in the following procedure. You can
copy these files so you do not have to specify settings on each computer.

To modify the WorkFlow settings
1. After you have logged in to PaperVision Enterprise, select the Worksteps Waiting/Owned
pane.
2. Click any workstep to open the PaperVision Viewer.
3. In the PaperVision Viewer, click the Edit tab, and then click Settings.
4. Click the Workflow tab where you can specify the following options:
Refresh Period - Use this box to specify the amount of time, in seconds, the system must
remain idle (without the user doing anything in the PaperVision Viewer) before automatically
refreshing the Workstep Instances list. Type 0 to disable the automatic refresh feature. The
default value is 0.
Maximum Number of Instances - Use this box to specify the maximum number of workstep instances that display in the Workstep Instances list. Type 0 to display all worksteps.
The default value is 100.
Show Task Description - Select this check box to display task descriptions. This option is
selected by default.
Confirm Ownership - Select this check box to force a user to click Yes in a confirmation
message before taking ownership of a selected workstep instance. If this check box is
cleared, a user can take ownership of a workstep instance by double-clicking that workstep.
This option is selected by default.
Take Next Available Workstep After Transition - Select this check box for the system to
automatically assign ownership of the next available workstep instance to you after you complete the tasks in the current workstep instance and it transitions to the next workstep.
Take Next Available Workstep If Selected is Unavailable - Select this check box for the
system to automatically assign ownership of the next available workstep to you if the one
you selected is unavailable. This can occur when you are a member of a group of workflow
participants and attempt to take ownership of a workstep instance owned by another participant. Because only one workflow participant can own a workstep instance at a time, the
system will deny you access to that workstep instance. If this check box is cleared, the system displays an alert that the workstep is already owned, but it does not automatically assign
the next available workstep to you.
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Reset Layout for Workstep Instances List - Select this option, and then click Yes, to clear
all the sort, filter, and group selections you made in the Workstep Instances list when you
close the PaperVision Viewer.
5. Click Save.
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Global Search Tasks
Global searches are comprised of customized filters that are applied to the projects you choose. Global
searches let you search for documents across multiple projects. If you consistently search using
specific criteria, for example, social security number, account number, or company ID, you can add a
global search to streamline the search process. All users can define an unlimited number of global
searches. Searches are not case-sensitive.
Global searches that are run against certain databases are often added to the database log files which
grow over time and might slow down database performance. Because of this possibility, select only the
relevant index fields to perform the global search. For example, if you search only for social security
numbers across projects, ensure that only the social security index field is selected, and that all
unnecessary index fields are cleared for the global search.
N O T E

When searching for full-text data, you must search at the project level. See "Full-Text
Searches" on page 37 for more information.
You can also perform quick searches across projects. This type of search uses a predefined filter that is
not saved. You have the option of including full-text, and specifying the projects you want to search.

To view global searches
After you have logged in to PaperVision Enterprise, on the title bar, click the down arrow next to
your user name, and then click Global Search to open the Global Search window.
The defined global searches appear on the left pane.

To add a global search
1. After you have logged in to PaperVision Enterprise, on the title bar, click the down arrow next to
your user name, and then click Global Search to open the Global Search window.
2. On the toolbar, click New.
3. In the New Global Search Name box, type a name for the global search.
4. On the Selected Projects pane, do any of the following:
Double-click the projects you want to include in the search to move them to the Selected Projects list.
Select the project(s) you want to include in the filter, and then click Transfer to to move them
to the Selected Projects list.
(Optional) To move all the projects to the Selected Projects list, click Transfer all to.
(Optional) To remove a project from the Selected Projects list, double-click the project, or
select the project and then click Transfer from.
(Optional) To move all projects back to the Available Projects list, click Transfer all from.
5. On the Filter Configuration pane, each project is displayed in a pane containing all index fields
for that project. For each project, do the following:
Select the indexes and system fields that you want included in the filter.
(Optional) Click Select All to include all index fields.
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Click the down arrow under Full Text, and select one of the following:
None - Select this option to only include index fields in the search.
Fields and Full-Text - Select this option if you want a document returned when the
search criteria is found in both an index field and full-text.
Fields or Full-Text - Select this option if you want a document returned when the search
criteria is found in either an index field, or full-text.
6. To display system fields in the search results, on the Displayed System Fields pane, select the
system fields you want included in the search results.
7. When you have finished configuring your global search, click Save.

To perform a global search
1. After you have logged in to PaperVision Enterprise, on the title bar, click the down arrow next to
the search type box, and then click Global Search.
2. Click the down arrow to the left of the search type box, and then select the search you want to
run. If no searches are defined, you can add one. (See "To add a global search" on the previous
page for instructions.)
3. In the Global Search box, type the criteria for which you want to search.
The value entered is applied to all indexes selected for the global search.
4. Click Search. The search results are organized by project. Click any project to display the
search results. (See "Document Lists" on page 42 for information about the tasks you can perform from the search results.)

To edit a global search
1. After you have logged in to PaperVision Enterprise, do one of the following to open the Global
Search window.
On the title bar, click the down arrow next to your user name, and then click Global Search.
2. On the left pane, select the filter you want to edit.
3. On the right pane, do any of the following:
Modify the search parameters for each project on the Filter Configuration pane, by selecting the check boxes for the indexes to include, and clearing the check boxes for the indexes
to exclude.
To add or delete projects from the filter, see "To add a global search" on the previous page for
instructions.
To delete the filter, on the toolbar, click Delete, and then click Yes.
4. After you complete your changes, click Save .

To delete a global search
1. After you have logged in to PaperVision Enterprise, do one of the following to open the Global
Search window.
On the title bar, click the down arrow next to your user name, and then click Global Search.
2. On the left pane, select the search you want to delete.
3. On the toolbar, click Delete, and then click Yes.
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To perform a quick search
1. After you have logged in to PaperVision Enterprise, on the title bar, click the down arrow next to
the search type, and select one of the following:
To perform a quick search on index fields, select Quick Search - Index Fields.
To perform a quick search on full-text, click Quick Search - Full-Text.
2. Click the down arrow to the left of the search type box, and select the projects you want to
search.
3. In the search box, type the criteria for which you want to search.
The value entered is applied to all indexes or full-text for the projects you selected.
4. Click Search. The search results are organized by project. Click any project to display the
search results. (See "Document Lists" on page 42 for information about the tasks you can perform from the search results.)
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Add E-Form Content
With the E-Forms feature, you can enter information that would usually be entered on a paper form
directly into the system. This reduces the time spent transcribing information from paper and increases
data accuracy. When you open an E-Form, its version number appears on the lower-right corner of the
screen. An E-Form can have many versions, but only the latest published version to which you have
access appears under E-Forms on the System tab. The E-Forms tab is unavailable if there are no EForms defined.
When working with E-Forms, keep in mind the following:
Your access to E-Forms and their content is determined by the security access set by your
administrator.
Keyboard shortcuts are not available when you are working in an E-Form.
If custom code is configured, it automatically executes when appropriate.

To add content to an E-Form
1. After you have logged in to PaperVision Enterprise, if necessary, click the E-Forms pane, to
access the E-Forms to which you have access.
2. Double-click the E-Form you want to open, and then type the required information in the available
fields.
3. If you skip a required field, a red validation prompt appears.
4. (Optional) To close all of the validation prompts, on the bottom of the pane, click Close Validation Prompts.
5. (Optional) If the E-Form is configured to require a security code, type the displayed security code
in the Type Security Code box.
6. After you complete the form, on the bottom of the pane, click Save.
The completed E-Form is saved as a document in the project, and the E-Form definition is reset
with blank fields.

158 PaperVision Enterprise User Guide

CHAPTER 10
User Settings

User Settings Overview
User Options
Notifications
Downloads

160
160
163
164

CHAPTER 10 User Settings

User Settings Overview
The following options are available for your use and configuration. Any settings that the administrator
defines for the entity will override any modifications made in the listed items.
User Options - Contains settings that define: parameters for search results, the method used to
view documents, display settings, interface settings, and options for electronic signatures. (See
"User Options" below for information about specifying these settings.)
Destruction Lists - Contains destruction lists and options for working with them. ( See "Destruction List Tasks" on page 168 for more information).
E-Forms - Select this option to maximize and display only the E-Forms pane in the main window.
Global Search - Contains global search filters and options for working with them. ( See "Global
Search Tasks" on page 154 for more information.)
Migration Jobs - Contains migration jobs and options for working with them. (See "Migration
Job Tasks" on page 172 for more information.)
Notifications - Contains system messages and options for working with them. (See "Notifications" on page 163 for more information.)
Projects - Select this option to maximize and display only the Projects pane in the main window.
Recycle Bin - Contains all recycled documents and options for working with them. (See
"Recycle Bin Tasks" on page 178 for more information.)
Worksteps - Select this option to maximize and display only the Worksteps pane in the main window.
Administration - Launches the PaperVision Enterprise Administration console. You must have
the proper permissions to open the console. You can return to the PaperVision Enterprise User
Console by clicking Home on the breadcrumb trail.
Downloads - Select this option to open the Downloads window. (See "Downloads" on page 164
for more information.)

User Options
The User Options pane contains the following options.
Search - Specify how search results are displayed, including how many results appear per
query, whether you want to show the first document and full-text options within your search results, and how documents are grouped.
Document Viewing - Specify what method you want to use to view documents and how windows are opened.
Display Settings - Specify whether the entity ID is displayed.
Interface Settings - Specify whether to enable the touch interface.
Signatures - Specify authorization codes and fonts for electronic signatures.
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The following procedures describe the options available in each area.
N O T E

The functionality available to you depends on your security access. You may not have
access to all of the described tabs. If you require additional access, contact your
administrator. In addition, the administrator can define entity settings that will override
any modifications made on the User Options pane.

To specify search options
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click User Options.
2. If necessary, on the left pane, click General.
3. In the Search area, you can specify the following options.
Max. Results Per Query - Use this box to specify the maximum number of search results to
appear on a search results page. This value cannot exceed the value defined by your administrator.
Show First Document - Select Yes to display the first document that meets the entered
search criteria.
Show Full Text Options - Select Yes to display the complete list of full-text search options.
Document Grouping - Document grouping enables the viewing of multiple documents with
the same index values (as if they were a single document). You can select one of the following options:
None - Select this option to apply no document grouping.
Oldest First - Select this option to position the oldest documents at the beginning of the
grouped document.
Most Recent First - Select this option to position the newest documents at the beginning
of the grouped document.

N O T E

When Document Grouping is enabled, the Scale options on the viewer tool bar
(Width, Height, and Window) are not functional for image-based file types (See
"Document Types" on page 59 for more information). For example, if your grouped
document contains a Word document, and PNG files, the Scale options function only
for the Word document.

To specify document viewing options
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click User Options.
2. If necessary, on the left pane, click General.
3. In the Document Viewing area, you can specify the following options.
Document Display Method - You can select the method used for displaying documents.
You can select one of the following options:
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N O T E

If you are unsure about which viewer to use, see "Select a Document Viewer" on
page 23 for more information about each document viewer. Some operations that are
available in the PaperVision Viewer are not available in the Browser-Based Viewer.
Use Browser-Based Viewer - Select this option if you are restricted from installing software, as you will not be able to install the PaperVision Assistant that is required for use
with the PaperVision Viewer. This option does not use ActiveX components, and in addition to Internet Explorer, supports Google Chrome, Mozilla Firefox, and Safari (on iPad
devices and Macs) and android devices.
Use PaperVision Viewer - If you select this option, you must install the PaperVision
Assistant, and you must select this option to perform administrative tasks, WorkFlow
functions, and define E-Forms. (See "Install the PaperVision Assistant" on page 182 if you
need installation instructions.)
Open Window Method - Select one of the following methods to open the Browser-Based
Viewer.
Auto - Select this option for PaperVision Enterprise to automatically handle how to open
the Browser-Based Viewer.
New Window - Select this option to open the Browser-based Viewer in a new window.
Current Window - Select this option to open the Browser-based Viewer in the current window.

To specify display options
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click User Options.
2. If necessary, on the left pane, click General.
3. In the Display Settings area, you can specify the following options.
Entity ID - You can specify whether to display the entity ID by selecting one of the following
options:
Display Entity ID - Select this option to display the Entity ID box on the login screen and
next to the user’s name on the title bar of PaperVision Enterprise.
Hide Entity ID - Select this option to remove the Entity ID box on the login screen.

To specify interface options
N O T E

The following options appear only when you are using a touch-enabled device.
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click User Options.
2. If necessary, on the left pane, click General.
3. In the Interface Settings area, you can specify the following options.
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Yes - Select this option if you are using a touch screen device.
No - Select this option if you are not using a touch screen device.
Auto - (Default setting ) - Select this option if you want PaperVision Enterprise to automatically detect the type of device you are using.

To specify signature options
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click User Options.
2. If necessary, on the left pane, click Signatures
3. In the Signature Authorization Area area, you can specify the following options.
Authorization Code Required - Select this option to require the entry of an authorization
code to electronically sign a document.
4. In the Signature Details Font areas, you can specify the font and font size to use for electronic
signatures and signature details.

Notifications
The Notifications pane contains system messages that alert users when certain events occur that may
require attention. Many of these notifications are specific to administrators, but some also display to
non-administrative users. The system automatically generates notifications for the following events and
sends them to the listed users::
Data group loaded successfully (entity administrators)
Migration job finished running (entity administrators, if your administrator has enabled migration
notifications)
Data purge failure (entity and global administrators)
An attempted user login to a "locked" account (entity administrators)
An attempted user login when all licenses were in use (entity administrators)
Workstep that remains unprocessed for a long period of time (user group of assigned workstep)

To view notifications
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Notifications.
2. On the Notifications window, you can view notifications.
The column headings on the Notifications pane indicate the following information:
Date/Time - This column shows the date and time that the system generated the notification.
Source - This column shows the activity that initiated the notification. If a user initiates the
notification, the user name displays.

To sort notifications
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Notifications.
2. On the Notifications window, click a column heading to sort the notifications in ascending or descending order.
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To delete notifications
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Notifications.
2. Select the notification you want to delete.
3. On the toolbar, click Delete Selected Notification.

To export notifications
N O T E

When you select the Export option, all listed notifications are exported. You cannot
select individual notifications to be exported.
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Notifications.
2. On the toolbar, click Export Notifications.
3. In the Save As dialog box, select the export location.
4. In the File Name box, type the name of the file.
5. Click the down arrow in the Save as type box, and then select the file type you want to use.
6. Click Save.

To print notifications
N O T E

When you select the Print option, all listed notifications are printed. You cannot select
individual notifications to be printed.
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Notifications.
2. On the toolbar, click Print.
3. In the Print dialog box, select the printer options, and then click Print.

Downloads
The Downloads tab window contains updates for PaperVision Enterprise and files that you can
download and install for other Digitech tools and software. You must have appropriate permissions
assigned by your administrator to perform the tasks that are available from the Downloads window.
Additionally, administrative rights in Windows are required to successfully install the PaperVision
Assistant.

To download an item
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Downloads. (See "Log In" on page 18 if you need help.)
2. On the Downloads window, choose the application you want to install, and then click Download.
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3. When prompted, select whether you want to run or save the application.
4. If you saved the application, after the download is complete, run the executable file.
5. On the InstallShield Wizard window, click Next.
6. Select I accept the terms in the license agreement, and then click Next.
7. Click Install to begin the installation.
8. After you are notified that the software is installed, click Finish.
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Destruction List Tasks
A destruction list is comprised of documents (including recycled documents) that met the destruction
criteria defined by your administrator but require user review before their destruction. For example, your
administrator creates a destruction policy that medical documents older than seven years should be
destroyed, but specifies that the documents must be reviewed before they are automatically destroyed.
As documents meet the time limit, they are placed in a destruction list where they can be reviewed and
their destruction is either confirmed or denied.
If your administrator has assigned you permission to do so, you can view destruction lists and their
associated documents on a per project basis (the Destruction Lists option is unavailable if there are no
destruction lists defined). You can also confirm or deny the destruction of documents on the list.
When you view a destruction list, all of the documents appear in a document list. See "Document Lists"
on page 42 for information about the standard tasks you can perform from all document lists. The
following procedures describe only those tasks that are unique to destruction lists.

To view a destruction list
1. After you have logged in to PaperVision Enterprise, do one of the following:
Click the down arrow next to your user name, and then click Destruction Lists.
On the main window, if necessary, expand Destruction Lists.
2. The Destruction Lists window lists all projects that contain destruction lists. Select a project to
view the destruction lists in that project in a document list.
3. Double-click the destruction list you want to view.
The documents in the destruction list appear in a document list. See "Document Lists" on
page 42 for information about the standard tasks you can perform from all document lists.

To confirm the destruction of documents
1. After you have logged in to PaperVision Enterprise, do one of the following:
Click the down arrow next to your user name, and then click Destruction Lists.
On the main window, if necessary, click Destruction Lists.
2. On the projects pane, double-click the project for which you want to view destruction lists.
3. On the destruction list pane, double-click the document list you want to view.
4. On the document list, select the document(s) for which you want to confirm destruction (hold
down the Ctrl key to select multiple items).
5. On the toolbar, click Review to open the Review Destruction List dialog box.
6. Click Approve.
7. In the Destruction Date/Time, type the date and time for the destruction of the document(s), or
click the box and then select the date and time.

N O T E

If the administrator already specified the destruction date and time, you can only
confirm the destruction, and the Destruction Date/Time box will not appear.
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8. (Optional) In the Comments box, you can type comments that can be viewed until the document
is destroyed.
9. Click Confirm.
10. In the confirmation message, click OK to confirm the destruction of the document(s), and then
click OK in the status message.
The documents are removed from the Destruction List and now appear with a note in their
Status column that displays the scheduled destruction date and the comments that were
entered.

To deny the destruction of documents
1. After you have logged in to PaperVision Enterprise, do one of the following:
Click the down arrow next to your user name, and then click Destruction Lists.
On the main window, if necessary, click Destruction Lists.
2. On the projects pane, select the project for which you want to view destruction lists.
3. On the left pane, double-click the destruction list you want to view.
4. On the document list, select the document(s) for which you want to deny destruction (hold down
the Ctrl key to select multiple items).
5. On the toolbar, click Deny, and then click Yes.
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Migration Job Tasks
The migration feature saves documents that were placed on a user-defined list into a new data group.
The original documents are not altered, nor are they removed from PaperVision. When migrating
information, the following basic steps are performed:
1. Documents are added to a list for migration. (See "Add Documents to a List" on page 54 for
instructions.)
2. Lists are submitted for migration, and then appear on the Migrations window.
3. An automated migration operation locates the documents on the list in their original data groups,
copies them to a separate location, where they are formatted into an XML data group. This data
group can then be saved to any supported media type by an administrator.
4. After a migration job has been processed, the system sends an email message to the entity
administrator if your system is configured to do so. (See "Notifications" on page 163 for instructions to view notifications.)
When documents are migrated, the following conditions are applied:
Users must have appropriate permissions to submit a list for migration.
Migration jobs do not export document annotations.
The original documents are not altered, nor are they removed from PaperVision.

To view migration jobs
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Migration Jobs.
2. The Migrations window lists all migration jobs. The column headings indicate the following
information:
Submitted Time - This column shows the date and time when the list was submitted for
migration.
Next Run - This column shows the date and time when the list will be migrated.
User - This column shows who submitted the list for migration.
Name - This column shows the assigned name for the migrated list.
Started - This column shows the date and time when the migration job was started.
Finished - This column shows the date and time when the migration job was finished.
Docs - This column shows the number of documents included in the migration job.
MB - This column shows the size of the migration job in megabytes.
Minutes - This column shows the amount of time in minutes that it took the migration job to
process.
Status - This column shows the status of the migration job.

To view migration job properties
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Migration Jobs.
2. Double-click the migration job for which you want to view job properties.
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To submit migration jobs
N O T E

Before you can submit a migration job, a list must exist that includes the documents for
migration. See "Add Documents to a List" on page 54 for instructions.
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Migration Jobs.
2. On the toolbar, click New to open the Submit New Migration Job dialog box.
3. In the Lists area, select the list(s) to submit for migration. (Hold down the Ctrl key to select multiple lists.)
4. Click Submit.
5. Click OK to confirm the submission.

To resubmit migration jobs
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Migration Jobs.
2. Select the migration job you want to resubmit.
3. On the toolbar, click Resubmit.
4. Click Yes to confirm the resubmission.

To cancel migration jobs
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Migration Jobs.
2. Select the migration job you want to cancel.
3. On the right pane, select the migration job(s) you want to cancel. (Hold down the Ctrl key to
select multiple migration jobs.)
4. On the toolbar, click Cancel.
5. Click Yes to confirm the cancellation.

To sort migration jobs
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Migration Jobs.
2. Click a column heading to sort the migration jobs in ascending or descending order.
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Pending Queue Tasks
You can access all pending document without having to open a viewer in a project. This is helpful if you
have pending documents in multiple projects. (See "Manage Pending Documents" on page 88 for more
information about tasks you can perform on pending documents.)

To access pending documents
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Pending Queue.
2. In the Pending Queue window, all pending documents appear, and you can do any of the following:
To open the pending document in the pending document view of the PaperVision Viewer,
double-click the pending document.
To upload a pending document, select the document(s), and then, on the toolbar, click
Upload Selected Documents.
To upload all pending documents, on the toolbar, click Upload All Documents.
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Recycle Bin Tasks
If your administrator has configured your project to do so, when any document or version of a document
is deleted, it is moved to the Recycle Bin for that project. After a document is placed in the Recycle Bin,
it displays with red text when it appears in any document list. Your administrator must assign you
permissions to view, empty, or restore the contents of the Recycle Bin. The number of documents that
appear per page in the Recycle Bin is determined by the Max. Results Per Query setting under User
Options. (See "To specify search options" on page 161 for instructions to modify this setting.)
The procedures in this section describe the functions you can perform on the Recycle Bin window. In
the Recycle Bin, you can perform the same functions and view the standard information available from
all document lists. (See "Document Lists" on page 42 for references to the common tasks you can
perform and an overview of the displayed information.)

To open the Recycle Bin
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Recycle Bin.
2. On the Recycle Bin window, the Projects pane contains a list of all projects.
3. Select a project to view the recycled documents.

To restore all items from the Recycle Bin
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Recycle Bin.
2. On the Projects pane, select the project for which you want to restore all items from the Recycle
Bin.
3. Click All to open the Restore Recycle Bin Items dialog box.
4. Do one of the following:
To restore all items in the Recycle Bin, select Restore All Recycle Bin items, and then
click OK.
To restore all items in the Recycle Bin deleted on or before a specified date, select Restore
Recycle Bin items deleted on or before the specified date and then do one of the following.
Type the date and time on or before which the items were deleted, and then click OK.
Click the button and then select the date and time on or before which the items were
deleted, and then click OK.
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To empty all items from the Recycle Bin
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Recycle Bin.
2. On the Projects pane, select the project for which you want to empty all items from the Recycle
Bin.
3. Click Empty to open the Empty Recycle Bin dialog box.
4. Do one of the following:
To empty all items in the Recycle Bin, select Empty All Recycle Bin Items, and then click
Save.
To empty all items in the Recycle Bin deleted on or before a specified date, select Empty
Recycle Bin items deleted on or before the specified date and then do one of the following.
Type the date and time on or before which the items were deleted, and then click OK.
Click the button and then select the date and time on or before which the items were
deleted, and then click OK.

To delete a document in the Recycle Bin
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Recycle Bin.
2. On the Projects pane, select the project for which you want to delete a document from the
Recycle Bin.
3. Select the document(s) you want to delete, and then on the toolbar, click Delete.
4. Click Yes in the confirmation message.
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Install the PaperVision Assistant
The PaperVision Assistant is an application that extends the features and capabilities of the
PaperVision Viewer to other browsers such as Mozilla Firefox and Google Chrome. Additionally, if you
are using version 75.1 or later of PaperVision Enterprise, the PaperVision Assistant must be installed
before you can view any documents using the PaperVision Viewer. The PaperVision Assistant is not
required to view documents using the Browser-Based Viewer. The PaperVision Assistant is an integral
component of the PaperVision Client. To install the PaperVision Assistant, you must download the
PaperVision Client.
N O T E

Administrative rights in Windows are required to successfully install the PaperVision
Assistant.

To install the PaperVision Assistant
1. After you have logged in to PaperVision Enterprise, click the down arrow next to your user name,
and then click Downloads. (See "Log In" on page 18 if you need help.)
2. On the Downloads window, select PaperVision Client, and then click Download.
3. When prompted, select whether you want to run or save the application.
4. If you saved the application, after the download is complete, run the executable file.
5. On the InstallShield Wizard window, click Next.
6. Select I accept the terms in the license agreement, and then click Next.
7. Click Install to begin the installation.
8. After you are notified that the software is installed, click Finish.
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Search Process Overview
Document searches are affected by options that administrators set and options specified by users. You
can set the following options:
Max. Results Per Query - This setting specifies the maximum number of search results to
appear on a search results page. This value cannot exceed the administrator-defined values.
(See "To specify search options" on page 161 for instructions.)
Document Grouping - This setting determines whether documents returned from searches are
grouped, and if so, in what order. This user-defined value overrides the default behavior set by
the administrator. (See "To specify search options" on page 161 for instructions.)

N O T E

When document grouping is selected, up to 100 documents with the same index
values appear as if they were a single document.
The system follows the steps below when it searches for documents.

Search Process for Documents (Excluding Full-Text
Search Criteria)
1. The index value query is run against the SQL database, the results are limited to the value specified by the Max. Results Per Query setting, and then sorted by the Document ID value.
2. Each document returned from that database query is checked to ensure that the requesting user
has document-level access to it.
3. After removing documents, if there are fewer than the number specified by the Max Results Per
Query setting, steps 1 and 2 are repeated for the next group of documents.
4. When the correct number of documents are found (or no more meet the criteria), the final set of
documents are sorted based on the user's requested sort order and field.
5. The documents are queued and returned to the client. If document grouping is enabled, document
index values are compared to determine if any document groups are created.

Search Process for Documents (Including Full-Text
Search Criteria)
1. The full-text search criteria is submitted to the full-text database engine, and it returns, at most,
the number of documents specified by the Max. Full-Text database results per query setting
configured by the administrator. The engine returns the Document ID values (and additional
information) of any documents that the full-text engine finds.
2. The submitted index value query (if any) is appended to require that the resulting documents
have Document ID values that are in the list of those found by the full-text engine.
3. The submitted index value query is run against the SQL database, and the results are limited to
the value specified by the Max. Results Per Query setting, and then the results are sorted by
the Document ID value.
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4. Each document returned from that database query is checked to ensure that the requesting user
has document-level access to it.
5. After removing documents, if there are fewer than the number specified by the Max Results Per
Query setting, steps 3 and 4 are repeated for the next group of documents.
6. When the correct number of documents are found (or no more meet the criteria), the final set of
documents are sorted based on the user's requested sort order and field.
7. The documents are queued and returned to the client. Because a full-text search was run, no document grouping is used.

Use the PVESearchURL Feature
The PVESearchURL feature is used to locate information in your database by typing a URL that you
create into the address bar on your browser. The URL requires a specific format and predefined
parameters.
See "PVESearchURL Required Parameters" on page 187 for information about the available
required parameters.
See "PVESearchURL Optional Parameters" on page 188 for information about the available
optional parameters.

To use the PVESearch URL Feature
1. Open your browser.
2. In the address bar, type http://PVEserversite:portnumber/PVESearchURL.aspx?, and then
type the first required parameter, similar to the following:
/PVESearchURL.aspx?UserName
3. After the first parameter, type an equal sign ( = ), and then type the parameter value.
/PVESearchURL.aspx?UserName=User1
4. Type an ampersand ( & ) between each parameter you add.
/PVESearchURL.aspx?UserName=User1&Password=pAssw0rd!&ProjID=12
5. Press Enter when you are ready to run the search.

Usage Examples
The IndexFields, IndexValues and IndexValuesTo parameters are all related to each other. You must
supply the values for the IndexValues and IndexValuesTo parameters in the same order as IndexFields.
For example, if you have a project with IndexField1, IndexField2 and IndexField3 and you want to
search on IndexField1 and IndexField3, your parameters would look like the following:
IndexFields=IndexField1Name|IndexField3Name&IndexValues=IndexField1Value|
IndexField3Value
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The IndexValuesTo parameter is required only when executing a range search. Again, values need to be
supplied in a consistent order. For example, to search on all of the index fields above including a range
search for IndexField3, you could do the following:
IndexFields=IndexField1Name|IndexField2Name|IndexField3Name&IndexValues=I
ndexField1Value|IndexField2Value|
IndexField3FromValue&IndexValuesTo=||IndexField3ToValue
In the previous paragraph, note how IndexValuesTo starts with two pipes, this is to tell the system that
the first two IndexFields are not executing a range search. If the pipes were not included, then the
system would attempt to run a range search on IndexField1 using IndexField3EndValue as the To value.

E X A M P L E
Here are some examples of what search URLs might look like:
/PVESearchURL.aspx?UserName=Test&EntID=4&ProjID=1&IndexFields=Date&I
ndexValues=01-05-2018&IndexValuesTo=01-06-2018&ResultsType=List
/PVESearchURL.aspx?UserName=Pub1ic&EntID=4&ProjID=1&IndexFields
=Name&IndexValues=John Doe&ResultsType=list
/PVESearchURL.aspx?UserName=User1&Password=pAsswOrd1&EntID=4&ProjID
=1&IndexFields=Name|Date|Amount&IndexValues=John Doe|01-052018|100&SortBy=Date&SearchType=And&ResultsType=Docs
/PVESearchURL.aspx?SessionID=14133234434539852398247329843294972983
792834&EntID=4&ProjID=1&IndexFields=Name&IndexValues=John Doe
&ResultsType=List
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PVESearchURL Required Parameters
When using the PVESearchURL feature, you must include the parameters in the following table in your
URL.
See "Use the PVESearchURL Feature" on page 185 for more information about using parameters.
See "PVESearchURL Optional Parameters" on the next page for information about the available
optional parameters.
After each parameter, type an equal sign ( = ) and then type the parameter value. If you use multiple
parameters, you must insert an ampersand ( & ) between them.

Parameter
UserName

Value
A valid user name

Usage Example
UserName=John Smith

A valid password
Password

The Password parameter is optional
only when the password for the
specified use is set to blank.

Password=pAs$w0rd1

EntiID

The ID of the entity to search

EntiID=2314

ProjID

The ID of the project to search

ProjID=12

IndexFields

A pipe-delimited list of the index fields to
IndexFields=Name|Date|Amount
search

ResultsType

List to display a list of search results, or ResultsType=List
Docs to display specific documents
ResultsType=Docs
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PVESearchURL Optional Parameters
When using the PVESearchURL feature, the parameters in the following table are optional to include in
your URL when the parameter value is either set to the default value or blank.
See "Use the PVESearchURL Feature" on page 185 for more information about using parameters.
See "PVESearchURL Required Parameters" on the previous page for information about the available required parameters.
After each parameter, type an equal sign ( = ) and then type the parameter value. If you use multiple
parameters, you must insert an ampersand ( & ) between them.

Parameter

Value

Usage Example

IndexValues

A pipe-delimited list of the index
values to search

IndexValuesTo

A pipe-delimited list of the “To”
index values in a date range. The
default is blank or no range
searching. If you use the default
IndexValuesTo=10-06-2016
and type a date in the
IndexFields or IndexValuesTo
parameters, the system
searches for that specific date.

SortBy

The name of the index field to
sort the results by. The default is
the first index field in ascending
SortBy=Date[-]
order. To sort in descending
order, add [ - ] to the end of the
index field name.

FTQuery

The full text string for which you
are searching.
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Parameter

Value

Usage Example

A tab delimited ( \t ) list of full-text
search options which can use the
following items:
BOOLEAN or NATURAL
specifies to use either a Boolean
or Natural Language search.
STEMMING specifies to use
stemming on all words.
PHONIC specifies to perform a
phonic search on all words.

FTOptions

FUZZY=x specifies to perform a
fuzzy logic search on all words
with a fuzziness setting of x
(where x is between 1 and 10).

FTOptions=NATURAL\tPHONIC\tFUZZY=0

SYNONYM specifies to perform
a synonym search on all words.
WNSYNONYM specifies that
any synonym searching uses the
WordNet thesaurus of
synonyms.
WNRELATED specifies that
any synonym searching uses the
WordNet related-words list.
USERSYNONYM specifies that
any synonym searching uses the
user-defined thesaurus.
SearchType

Search type values are And or
Or. (The default is Or.)

SearchType=And

SessionID

A valid session ID. You can use
this instead of a user name and
password.

SessionID=1413323443453

Locale

Used when executing on a
translated web site. The Locale
parameter must use the same
country code as the translated
strings. The default is EN-US.

Locale=EN-US
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Digitech Logging Utility Overview
For your convenience, the Digitech Logging Utility is provided so that you can easily change some
logging aspects without having to manually edit the XML configuration files. You can use the logging
utility to modify configuration files for any Digitech Systems' product. The Digitech Logging Utility lets
you specify:
which configuration file to modify,
the level of detail for the logs,
where the log information is sent and/or stored,
and the appearance of the content.
See "Configure the Digitech Logging Utility" below for instructions to configure the Digitech Logging
Utility.

Configure the Digitech Logging Utility
For all Digitech Systems software, logging settings are stored in the application’s configuration file. If
the executable file for your application were named DigitechApp.exe, then the name of the
corresponding configuration file would be DigitechApp.exe.config, and it would be located in the same
directory as the executable file. Configuration files are XML files that you can open and edit using any
text editor, including Windows Notepad.

To configure the Digitech Logging Utility
1. Click Start, and then click All Programs.
2. Click the Digitech Systems folder, and then click PaperVision Logging Utility to open the
Digitech Logging Utility dialog box.

3. Next to the Configuration File box, click the ellipsis button
dialog box.

to open the Select Config File

4. Click the Look in list to locate the directory where the configuration files are stored (typically,
Program Files\Digitech Systems\PaperVision Capture).

192 PaperVision Enterprise User Guide

APPENDIX B Digitech Logging Utility

5. Click the configuration file for which you want to specify logging properties.
6. Click the Trace Level list, and then select one of the following options:
Error - This option specifies that recoverable errors are logged.
Warning - This option specifies that non-critical problems are logged.
Information - This option specifies that informational messages are logged.
Verbose - This option specifies that debugging trace information is logged.
All - This option specifies that all possible logging information is included.

N O T E

If you select Verbose or All, you are requesting the most possible output. These
settings can generate a significant amount of output that requires extra processing
which could slow application performance.
7. Go to "Configure Listeners" below to specify where you want the log information to be sent
and/or stored.

Configure Listeners
After you complete the procedure under "To configure the Digitech Logging Utility" on the previous page,
you must specify where you want the log information to be sent and/or stored. You do this in the
Listeners area in the Digitech Logging Utility dialog box.

The following procedures describe how to configure each type of listener.

To configure the Windows Event Log Listener
When you select Windows Event Log, it specifies that you want the log output to appear in the
Windows Event Viewer. To access the Event Viewer, type eventvwr at the command prompt, and
then press Enter.
1. If you haven't already done so, complete the procedure under "To configure the Digitech Logging
Utility" on the previous page.
2. In the Listeners area, select Windows Event Log, and then click
Event Log Settings dialog box.

to open the Windows

3. In the Source Name box, type the name that you want to appear in the Source column of the
Event Viewer, and then click OK.
4. If you are done configuring listeners, click OK. Otherwise, go to the instructions for the next
listener you want to configure.
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To configure the Email Listener
When you select Email, it specifies that you want the log output to be sent to an email address.
1. If you haven't already done so, complete the procedure under "To configure the Digitech Logging
Utility" on page 192.
2. In the Listeners area, select Email, and then click

to open the Email Settings dialog box.

3. In the SMTP Server box, type the IP address or server name of the SMTP server.
4. In the SMTP Port box, type the applicable port number.
5. In the To Address box, type the email address to which the log information will be sent.
6. In the From Address box, type the email address from which the log information will be sent.
7. In the Subject Line Starter (Optional) box, type the subject you want to appear in the email notifications.
8. Click OK.
9. If you are done configuring listeners, click OK. Otherwise, go to the instructions for the next
listener you want to configure.

To configure the File Listener
When you select File, it specifies that you want the log output to go to a file. So that you can easily
locate the log file, you can specify the path and file name. The path you specify can contain any
environment variable. The variable is resolved when the log is written. (To see a list of all the
environment variables configured on your machine, go to a command prompt, type set, and then press
Enter.)
If you specify a directory with the file name, and that directory does not exist, the logging utility will
create it. For example, if you type C:\temp\logs\dsi.log for the file name, the logging utility will create
the C:\temp\logs directory if it does not already exist. When using the File option, log entries continue
to accumulate in the same file which can cause the file to become very large. If you do not want to
manually maintain this file, consider using the Rolling File option. (See "To configure the Rolling File
Listener" on page 196 for more information.)
1. If you haven't already done so, complete the procedure under "To configure the Digitech Logging
Utility" on page 192.
2. In the Listeners area, select File, and then click

to open the File Settings dialog box.

3. In the File Name box, type the path and/or file name for the log. If you do not include a path, the
file you specify will be written to the Digitech installation directory.
4. (Optional) In the Header box, type a header that you want to appear at the beginning of each log
entry in the file.
5. (Optional) In the Footer box, type a footer that you want to appear at the end of each log entry in
the file.
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6. Click OK.
7. If you are done configuring listeners, click OK. Otherwise, go to the instructions for the next
listener you want to configure.

E X A M P L E
If your entries look like this,

then the log entry would appear similar to the following.
---------------------Start PaperVision Capture Client Entry---------------------Timestamp: 4/7/2014 5:22:02 PM
Message: Accepting connections...
Category: Operational
EventId: 100
Severity: Information
Machine: BOBR-NOTEBOOK
OS Version: Microsoft Windows NT 6.1.7601 Service Pack 1
Application Domain; CaptureClient.exe
Process Id: 10932
Process Name: C:\dsi\bin\CaptureClient.exe
Win32 Thread Id 5332
Thread Name
---------------------End PaperVision Capture Client Entry------------------------
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To configure the Rolling File Listener
When you select Rolling File, it specifies that you want the log output to go to a file, but to prevent the
file from becoming too large, a new file is created based on the current date and time and the time
interval that you specify. By default, the contents of a rolling file are abbreviated in comparison to the
contents of a regular file.
So that you can easily locate the log file, you can specify the path and file name. The path you specify
can contain any environment variable. The variable is resolved when the log is written. (To see a list of
all the environment variables configured on your machine, go to a command prompt, type set, and then
press Enter.) Additionally, if you specify a directory with the file name, and that directory does not exist,
the logging utility will create it. For example, if you type C:\temp\logs\dsi.log for the file name, the
logging utility will create the C:\temp\logs directory if it does not already exist.
The Rolling File option also supports the use of macros that are expanded when the file is written.
Supported macros include: {machineName}, {processID}, {timeStamp}, or {webSiteID}.
1. If you haven't already done so, complete the procedure under "To configure the Digitech Logging
Utility" on page 192.
2. In the Listeners area, select Rolling File, and then click
dialog box.

to open the Rolling File Settings

3. In the File Name box, type the path and/or file name for the log. If you do not include a path, the
file you specify is written to the Digitech installation directory. You can also include macros in
this box.

N O T E

To specify a time interval for the creation of a new file, you must include the
{timeStamp} macro in the File Name box.
4. In the Time Stamp Format box, specify the time interval for the creation of a new file. Use the
yyyyMMddHH format, where yyyy equals the year, MM equals the month, dd equals the numerical day, and HH equals the hour in a 24-hour format. You control the interval by using only the
portion of the format you want. For example, to create a new rolling log file on a daily basis, you
would type yyyyMMdd. To create a new rolling log file on an hourly basis, type yyyyMMddHH.
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5. Click OK.
6. If you are done configuring listeners, click OK. Otherwise, go to the instructions for the next
listener you want to configure.

E X A M P L E
If your entries looked like this,

The output file would be CaptureClientApplication_BOBR-NOTEBOOK_20140407.log.
The contents of a rolling file are abbreviated similar to the following sample
2014-04-07 17:31:23 Accepting connections...
2014-04-07 17:31:23 New incoming connection: 127.0.0.1
2014-04-07 17:31:23 Inside TryCheckSystemVersion_7_062413_
2014-04-07 17:31:23 Login user successfully with user name U and entityId 1
2014-04-07 17:31:23 Command from 127.0.0.1 processed successfully
2014-04-07 17:31:23 Client 127.0.0.1 disconnected (gracefully)
2014-04-07 17:31:23 Enabling manual .NET garbage collection every 300 seconds
2014-04-07 17:31:23 New incoming connection: 127.0.0.1
2014-04-07 17:31:23 Command from 127.0.0.1 processed successfully
2014-04-07 17:31:23 Client 127.0.0.1 disconnected (gracefully)
2014-04-07 17:31:23 New incoming connection: 127.0.0.1
2014-04-07 17:31:23 Command from 127.0.0.1 processed successfully
2014-04-07 17:31:23 Client 127.0.0.1 disconnected (gracefully)
2014-04-07 17:31:25 New incoming connection: 127.0.0.1
2014-04-07 17:31:26 Saved User ID 2 preferences
2014-04-07 17:31:26 Command from 127.0.0.1 processed successfully
2014-04-07 17:31:26 Client 127.0.0.1 disconnected (gracefully)
2014-04-07 17:31:26 New incoming connection: 127.0.0.1
2014-04-07 17:31:26 Command from 127.0.0.1 processed successfully
2014-04-07 17:31:26 Client 127.0.0.1 disconnected (gracefully)
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